<table>
<thead>
<tr>
<th></th>
<th>Help categories</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>46.</td>
<td>Manual:Extension/BlueSpiceSaferEdit</td>
<td>150</td>
</tr>
<tr>
<td>47.</td>
<td>Manual:Extension/BlueSpiceMultiUpload</td>
<td>152</td>
</tr>
<tr>
<td>49.</td>
<td>Manual:VisualEditor/Images</td>
<td>161</td>
</tr>
<tr>
<td>50.</td>
<td>Manual:Extension/BlueSpiceInsertCategory</td>
<td>168</td>
</tr>
<tr>
<td>51.</td>
<td>Manual:BlueSpice Layout</td>
<td>172</td>
</tr>
<tr>
<td>52.</td>
<td>BlueSpice Layout</td>
<td>176</td>
</tr>
<tr>
<td>54.</td>
<td>Manual:Extension/BlueSpiceCategoryManager</td>
<td>195</td>
</tr>
<tr>
<td>56.</td>
<td>Manual:Extension/BlueSpiceSmartList</td>
<td>201</td>
</tr>
<tr>
<td>57.</td>
<td>Manual:Extension/BlueSpiceInterWikiLinks</td>
<td>205</td>
</tr>
<tr>
<td>60.</td>
<td>Manual:Extension/BlueSpiceAuthors</td>
<td>215</td>
</tr>
<tr>
<td>63.</td>
<td>Manual:Extension/BlueSpiceQrCode</td>
<td>221</td>
</tr>
<tr>
<td>64.</td>
<td>Manual:Rename and move pages</td>
<td>222</td>
</tr>
<tr>
<td>65.</td>
<td>Manual:Extension/BlueSpiceExtendedSearch</td>
<td>228</td>
</tr>
<tr>
<td>68.</td>
<td>Error messages</td>
<td>239</td>
</tr>
<tr>
<td>70.</td>
<td>Manual:Extension/BlueSpiceNamespaceCSS</td>
<td>242</td>
</tr>
<tr>
<td>71.</td>
<td>Manual:Template/Template package</td>
<td>243</td>
</tr>
<tr>
<td>72.</td>
<td>Setup:Software Catalogue</td>
<td>245</td>
</tr>
<tr>
<td>73.</td>
<td>Manual:Extension/BlueSpiceAvatars</td>
<td>267</td>
</tr>
<tr>
<td>74.</td>
<td>Manual:Extension/BlueSpiceDashboards</td>
<td>270</td>
</tr>
<tr>
<td>75.</td>
<td>Manual:Extension/BlueSpiceUserSidebar</td>
<td>271</td>
</tr>
<tr>
<td>76.</td>
<td>Manual:Preferences</td>
<td>273</td>
</tr>
<tr>
<td>77.</td>
<td>Manual:Extension/BlueSpicePrivacy</td>
<td>287</td>
</tr>
<tr>
<td>78.</td>
<td>Manual:Extension/BlueSpicePagesVisited</td>
<td>293</td>
</tr>
<tr>
<td>79.</td>
<td>Manual:Extension/BlueSpiceCategoryCheck</td>
<td>295</td>
</tr>
<tr>
<td>81.</td>
<td>Manual:Extension/BlueSpiceExpiry</td>
<td>301</td>
</tr>
<tr>
<td>82.</td>
<td>Manual:Extension/FlaggedRevs</td>
<td>304</td>
</tr>
<tr>
<td>83.</td>
<td>Manual:Extension/BlueSpicePageAssignments</td>
<td>311</td>
</tr>
<tr>
<td>84.</td>
<td>Manual:Quality management</td>
<td>314</td>
</tr>
<tr>
<td>85.</td>
<td>Manual:Extension/BlueSpiceReadConfirmation</td>
<td>321</td>
</tr>
<tr>
<td>86.</td>
<td>Manual:Redirects</td>
<td>323</td>
</tr>
<tr>
<td>87.</td>
<td>Manual:Review workflow</td>
<td>327</td>
</tr>
<tr>
<td>88.</td>
<td>Manual:Extension/BlueSpiceReminder</td>
<td>329</td>
</tr>
<tr>
<td>89.</td>
<td>Manual:Extension/BlueSpiceWikiExplorer</td>
<td>332</td>
</tr>
<tr>
<td>90.</td>
<td>Maintenance</td>
<td>335</td>
</tr>
<tr>
<td>91.</td>
<td>Manual:Extension/BlueSpiceExtendedFilelist</td>
<td>336</td>
</tr>
<tr>
<td>92.</td>
<td>Manual:Special pages</td>
<td>338</td>
</tr>
<tr>
<td>94.</td>
<td>Manual:Extension/BlueSpiceWatchList</td>
<td>341</td>
</tr>
</tbody>
</table>
Help categories

Help Topics

- Administration
- Concepts
- Content & structure
- Extensions
- Personalization
- Quality assurance
- Search
- Social wiki

If you cannot find the answer you were looking for, you can post a question in our community forum.

Administration

- BlueSpice Layout/Footer
- Config manager
- Customize the main navigation
- Extended statistics
- Extension/BlueSpiceAbout
Help categories

- Improve speed performance
- Managing translations
- Namespace manager

Permissions

- Authentication with LDAP
- Group manager
- Permission manager
- Permissions
- Rights concepts
- User manager

Setup

- Installation Guide
- Upgrade

Concepts

- Categories
- Magic words
- Namespace
- Subpage
- The pages model
- Wiki basics
- Wikitext

Content and structure

- Checklists
- Content organization
- Hide the title section
- Subpage
- Tag cloud
- Template
- Visual version comparison (VisualDiff)

Editing

- Context menu
- CountThings
- Create pages
- Delete pages
- Drawio
- Edit pages
- Embed videos
Help categories

- Emoticons
- Export tables
- Extension/WebDAV
- Filtering tables
- Insert a file
- Insert links
- Insert tags and magic words
- Page access restrictions
- Unsaved changes (autosave)
- Upload multiple files
- VisualEditor
- VisualEditor: Insert Images

Organization

- Assign categories
- BlueSpice layout
- BlueSpice layout
- Books
- Categories
- Category manager
- Content organization
- Creating page lists with DPL3
- Generate page lists (smart lists)
- Interwiki links
- Page templates
- Subpage
- Template

Page tools

- Export options
- Page info: authors
- Page info: readers
- Page information
- QR Code
- Rename and move pages

Search

- Extended search
- Interwiki search
- Search field in the page content (TagSearch)

Customization

- Error messages
Help categories

- Extension/BlueSpiceBookshelf/Customized PDF Output
- Namespace CSS manager
- Template package

Extensions

- BlueSpice Extensions

Personalization

- Avatars
- Dashboards
- Personal navigation
- Preferences
- Privacy center
- Visited pages

Quality assurance

- CategoryCheck
- Create a review
- Expiry
- Page approvals (Acceptance)
- Page assignments
- Quality management
- Read confirmation
- Redirects
- Review workflow
- Setting reminders
- WikiExplorer

Maintenance

- About maintenance
- Extended file list
- Special pages
- Special pages filter
- Watchlist

Social wiki

- About social content
- Attachments
- Blog
- Link pages to discussions
- Microblog
Manual: BlueSpice Layout/Footer

The footer contains the links to important info pages in the wiki. Since these pages provide legal information to users, they are accessible from any wiki page.

### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Creating the linked target pages</td>
<td>7</td>
</tr>
<tr>
<td>2 Changing the standard links</td>
<td>7</td>
</tr>
<tr>
<td>3 Standard configurations</td>
<td>8</td>
</tr>
<tr>
<td>4 Linking external target pages</td>
<td>9</td>
</tr>
<tr>
<td>5 Adding more links</td>
<td>9</td>
</tr>
<tr>
<td>6 Related info</td>
<td>9</td>
</tr>
</tbody>
</table>

### Creating the linked target pages

In a newly installed wiki, the content for the links in the footer must first be created. By default, all users with editing rights can click on a link in the footer to create the corresponding page. The associated page is automatically created in the Project namespace. If editing should be restricted to a certain user group, the permissions for the Project namespace can be set accordingly.

### Changing the standard links

The wiki has 3 standard links that are managed in the user interface.: Privacy policy, About (sitename) und Disclaimers.

**Example: About (sitename)**
In the following example, we change the link text \textit{About (sitename)} to \textit{Legal information}. In addition, we link to the new target page \textit{Legal:Terms}.

1. Change the link text from \textit{About (sitename)} to \textit{Legal information}:
2. Open the page \textit{MediaWiki:Aboutsite}.
   1. Add the text \textit{Legal information} to the empty page. If you later want to switch back to the standard label, you can remove the custom text at that time.
3. To link the \textit{Legal information} to a page that is different from the standard page \textit{MediaWiki:Privacypage}:
   1. Open the page \textit{Project:Impressum}.
   2. Redirect the page \textit{Project:Impressum} to your custom page, e.g. \textit{Legal:Terms}.

**Standard configurations**

The following table shows the default pages that are used to create the footer links and their associated target content.

**Example: Privacy policy**

- **Standard link text:** If the page \textit{MediaWiki:Privacy} does not exist, the link shows the standard link text "Privacy policy" and points to the standard target page \textit{Project:Privacy policy}.
- **Custom link text:** If the page \textit{MediaWiki:Privacy} does exist and has as its content the term \textit{Privacy}, the footer link displays \textit{Privacy}.
- **Removed link:** If the page MediaWiki:Privacy exists but has no content, the link is removed from the footer.

<table>
<thead>
<tr>
<th>Footer link</th>
<th>Link text defined in</th>
<th>Link target defined in</th>
<th>Standard target page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privacy policy</td>
<td>MediaWiki:Privacy</td>
<td>MediaWiki:Privacypage</td>
<td>Project:Privacy policy</td>
</tr>
<tr>
<td></td>
<td>(Standardtext: Datenschutz)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>About (sitename)</td>
<td>MediaWiki:Aboutsite</td>
<td>MediaWiki:Aboutpage</td>
<td>Project:About</td>
</tr>
<tr>
<td>)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disclaimers</td>
<td>MediaWiki:Disclaimers</td>
<td>MediaWiki:Disclaimerpage</td>
<td>Project:General disclaimer</td>
</tr>
</tbody>
</table>

**Important!** Both the page for the link text as well as the page for the link target cannot be empty. If one of them is empty, no footer link is generated. If one of the two pages doesn't exist, the respective standard behavior text for that page is used.

To suppress a footer link, you can, therefore, leave one of the two pages empty.
Linking external target pages

To link one of these footer links to an external web page, you first have to define an interwikilink for the external website.

**Example:** Linking the Privacy policy to the external page [https://bluespice.com/privacy/](https://bluespice.com/privacy/).

1. Define the interwikilink for the domain `bluespice.com` on the page `Special:InterWikiLinks` (interwiki prefix: `bls`).

![Creating an interwikilink](image)


![Creating an external footer link](image)

Adding more links

Additional links such as `Change cookie consent` or `Analysis service` are automatically created by the corresponding extensions. To add custom links, a server administrator has to change the related server settings.

Related info

- BlueSpice Layout
Config manager

Contents

1 About Config manager ................................................................. 10
2 Layout .................................................................................. 11
   2.1 Filter options ............................................................... 11
   2.2 Searching for settings .................................................. 12
3 Settings by extension .............................................................. 12
   3.1 BlueSpiceFoundation .................................................. 12
   3.2 BlueSpiceAbout ........................................................... 13
   3.3 BlueSpiceArticleInfo .................................................... 14
   3.4 BlueSpiceAuthors ........................................................ 14
   3.5 BlueSpiceAvatars .......................................................... 15
   3.6 BlueSpiceBookshelf ....................................................... 15
   3.7 BlueSpiceChecklist ........................................................ 16
   3.8 BlueSpiceExtendedSearch .......................................... 16
   3.9 BlueSpiceExtendedStatistics ........................................ 17
   3.10 BlueSpiceInsertCategory ............................................ 17
   3.11 BlueSpicensorLink .................................................... 18
   3.12 BlueSpicePageTemplates .......................................... 18
   3.13 BlueSpicePermissionManager .................................... 18
   3.14 BlueSpiceReaders ...................................................... 18
   3.15 BlueSpiceSaferEdit ..................................................... 18
   3.16 BlueSpiceUEModuleBookPDF ..................................... 19
   3.17 BlueSpiceUEModuleHTML ........................................ 19
   3.18 BlueSpiceUEModulePDF ........................................... 20
   3.19 BlueSpiceUniversalExport ......................................... 20
   3.20 BlueSpiceVisualEditorConnector ................................. 20
   3.21 BlueSpiceWhoisOnline .............................................. 21
   3.22 BlueSpiceExpiry ........................................................ 21
   3.23 BlueSpiceReview ........................................................ 21
   3.24 BlueSpiceReviewExtended ......................................... 21
   3.25 BlueSpiceFlaggedRevsConnector ................................ 22
   3.26 BlueSpiceSocialBlog .................................................. 23
   3.27 BlueSpiceSocialTopics .............................................. 24
   3.28 BlueSpiceMatomoConnector ....................................... 24
4 Related info .......................................................................... 25

About Config manager

With the Config manager, a wiki user with sysop rights can manage all BlueSpice wiki-wide settings in one place. In the navigation, it is located under Global navigations > Management > Config manager. This link loads the page Special:ConfigManager.
Config manager navigation item

## Layout

### Filter options

All settings can be accessed through the following filter options:

- **Feature**: group by type of functionality the setting belongs to (search, administration...)
- **Extension**: group by extension name
- **Package**: group by BlueSpice edition and services (BlueSpice free, BlueSpice pro, Matomo)

All settings are available in any type of grouping. Changing the grouping type does not add or remove setting options. It just groups them differently.

After settings are adjusted, they can be saved by clicking **Save**, or reset to the default settings by clicking **Reset**.
Searching for settings

A search bar is located above the list of settings. Type in a keyword such as "logo" to find the corresponding setting. The search returns settings regardless of the currently selected group.

Note: The search field has to be empty if you want to see the filter menu instead of the search.

Settings by extension

BlueSpiceFoundation

- **Logo path:** The logo image should be stored in the /images folder of your installation. If you store it in the /skins folder of your BlueSpice installation, it could be overwritten with an upgrade.

To upload the logo directly in the wiki:

1. **Upload** the logo on the page *Extended file list (Special:ExtendedFilelist)*. This is a link under the *Global actions* navigation.
2. **Search** for the logo name in the extended file list.
3. **Click** on the thumbnail image of the logo. This opens the logo on a separate page.
4. **Copy** the relative logo path from the address bar. In a typical Wiki configuration, this path starts with `/w/....`

5. **Paste** the logo path into the text field for the logo.

6. **Click** *Save*.

7. **Refresh** the page (Strg+F5).

- **Favicon path:** The favicon image should be stored in the `/images` folder of your installation. If you store it in the `/skins` folder of your BlueSpice installation, it could be overwritten with an upgrade. Favicon images have the file extension `.ico`.

- **Allowed file extensions:** For security reasons, the types of files that users can upload are restricted. Here, you can allow additional file formats. If a file format is blacklisted in the server configuration, adding this file extension here will not allow this file type to be uploaded. See mediawiki.org/wiki/Manual:Page_title for more info.

- **Allowed image extensions:** The standard web image types are listed here. In general, you want to restrict image uploads to web images. See developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types for more on browser-supported image types.

**BlueSpiceAbout**

- **Show link “About BlueSpice” in the main menu:** Shows or hides the link to the page AboutBlueSpice in the main navigation.
BlueSpiceArticleInfo

BlueSpiceArticleInfo, together with BlueSpiceAuthors, BlueSpiceReaders, and BlueSpiceExtendedSearch is part of the Page information in the quality management tools.

- **Update interval in seconds:** Sets the refresh rate for the "Last edit" value. By default, this date is updated every 10 seconds via JavaScript.

BlueSpiceAuthors

BlueSpiceAuthors, together with BlueSpiceArticleInfo and BlueSpiceReaders, is part of the Page information in the quality management tools.

- **Display authors:** Show or hide authors on the page information page.
BlueSpiceAvatars

An avatar image is automatically generated if the user does not upload a profile picture or if the user decides to create an avatar image in the preferences.

- **Generator**
  - **InstantAvatar**: Generates an avatar image based on using the initials of the Real name or the Username
  - **Identicon**: Generates an avatar image based on parts of the user's IP address.

BlueSpiceBookshelf

- **Use the display title from book source on article**: Shows the title from the book navigation as page title instead of the page name.
Note: If the page additionally contains a {{DISPLAYTITLE}} tag, the display title of the page is shown instead of the book title.

- Prepend article table of contents and headlines with book numberation
- Supress namespace prefix of book articles in output

BlueSpiceChecklist

- Mark checklist changes as minor edit: If this setting is active, changes to a checklist (for example, checking a checkbox) in view mode are logged as minor edits. If this setting is inactive, a change to the checklist is recorded as a regular version in the page history.

BlueSpiceExtendedSearch

- External file paths: External locations to scan for and index files from. These locations are entered in key/value pairs of Physical path and URL prefix.
  - Physical path: Storage path. For mounted drives, for example: X:\Documents
  - URL prefix: All files indexed from the indexed physical location are prefixed in the search results. It should be used if files are available from a web server. By default, the URL prefix is set to the same value as Physical path.
- Use simple autocomplete: forces a more compact autocomplete (1-column layout, no thumbnail preview).
Help categories

- **Automatically set language filter**: This setting applies to multi-language wikis. It returns search results for a user only in the user's language. Users can set their language in their preferences.
- **Exclude patterns**: Files at external file locations can be excluded from search based on regular expression patterns.

**BlueSpiceExtendedStatistics**

- **Exclude these users**: Some user groups, like WikiSysop can skew the statistics, for example the statistics for search queries or because they complete automated maintenance tasks. These types of user groups can be excluded from the statistical results.
- **Maximum number of interval steps**: Sets the size of the x-axis for the results. For a few days, select the interval **Day** or **Calendar Week**, for periods over one year, select **Year** or **Month**. If you do not get any results for your query, try to adjust the interval accordingly.

**BlueSpiceInsertCategory**

- **Insert category with its parents**
- **Set page categories as default in upload dialog**
BlueSpicensertLink

- **Allow unmapped links**
- **Allowed locations for external files**
  - Filesystem prefix
  - Web accessible prefix:

BlueSpicePageTemplates

- **Force target namespace:**
- **Hide default templates:** Hides the default Empty page template.

BlueSpicePermissionManager

- **Backup limit:** Sets the number of backups for the permissions manager. Each time the page Special: PermissionManager is saved, a backup is created. If the backup limit is set to 5, the last five versions of the permissions configuration are saved as backups.

BlueSpiceReaders

- **Number of readers to display:** Sets the number of readers that are displayed on the Page information in the Quality management tools.

BlueSpiceSaferEdit

- **Interval for lookup for concurrent editings:** Sets the time in seconds for checking if another person is editing the page.
- **Show name of current editor**: Shows or hides the name of the user who is currently editing the page.

**BlueSpiceUEModuleBookPDF**

- **Table of Contents**
  - **Only article titles (indent by grade)**: Only shows the article titles in the main contents table of the PDF.

  ![Table of contents](image)

  PDF table of contents without article TOCs

  ![Table of contents](image)

  Embed article TOCs

- **Embed article TOCs (No indent of article titles)**: Shows the table of contents for each article in the main contents table of the PDF.

**BlueSpiceUEModuleHTML**

- **Hide namespace prefix in PDF**: If activated, the namespace is shown in the HTML main heading.

  **Note**: If the page contains a "displaytitle" tag in the page source, the page display title is shown and this setting has no effect.
BlueSpiceUEModulePDF

- **Hide namespace prefix in PDF**: If activated, the namespace is shown in the PDF main heading for a page.

![namespace in heading](image)

**Note**: If the page contains a "displaytitle" tag in the page source, the page display title is shown and this setting has no effect.

BlueSpiceUniversalExport

- **Metadata (standard, JSON)**: Additional data to be passed to the rendering template in JSON format. This data can be used in the export template. The template itself is maintained server-side.
- **Metadata (override, JSON)**: Allows overriding standard data sent to the rendering template in JSON format. Values that are set by default can be overridden with this option.

BlueSpiceVisualEditorConnector

- **Enable VisualEditor for BlueSpice extensions**
- **Configuration variable to use a simplified save process**
- **Upload type**
  - Original (Here a confirmation of the rights of use/upload is obtained, file name and namespace of the file can be changed, a category can be assigned and a description of the file MUST be given).
  - Simple (No confirmation of required rights is obtained here, the name and namespace of the file can be changed, a description and a category can be assigned, but does not have to be specified)
  - One click (No confirmation about required rights is obtained here, the image cannot be renamed and no category can be assigned. Only the namespace can, but does not have to be adjusted before uploading)
BlueSpiceWhoIsOnline

- **Time in seconds until a user is marked as offline**: The system checks every \( x \) seconds if a user logged out and no longer displayed as online. This can be less frequent than the update interval for newly logged-in users.
- **Update interval in seconds**: The system checks every \( x \) seconds for users.

BlueSpiceExpiry

- **Show watermark for expired pages in PDF**: Shows the watermark for expired pages in PDFs.
- **Show watermark for expired pages in print version**: Shows the watermark for expired pages when a page is printed.
- **Show watermark for expired pages**: Shows a watermark on the page itself.

BlueSpiceReview

- **Only the owner of a review can change it**: If this is unchecked, any user with edit rights can update a workflow.

BlueSpiceReviewExtended

- **Workflow will be added to page history**: This enables that workflow votes are listed under the page history with the corresponding version.

```
| (cur | prev) | 15:00, 17 September 2019 | F8 Fbaeckmann (talk | contns | block) m... (802 bytes) (+5)... (Text replacement=
| "edition=BlueSpice [active] to "edition=BlueSpice free [active"
| 1. ♦ Mlink | 14:22, 9 December 2019 | Type: Flagging | "Rodrique: first reviewer ⇒ Mlink: Everything is correct."
| 2. ♦ Helpdesk | 14:47, 9 December 2019 | Type: Flagging | "Rodrique: all content ⇒ Helpdesk: Info about configuration is incorrect. Get with John from it. He should have the latest info."
| [Reviewed: 14:22, 9 December 2019 | Mlink ]
```

workflow log entries in page history
BlueSpiceFlaggedRevsConnector

Export

The export settings affect how the pages of a book are generated in the PDF export.

- **Bookshelf: List accepted revisions log:** Shows a log of stable page versions of pages in the PDF and when these pages were put into accepted status. If editors did not provide a comment when accepting the page, the *Stable comment* field for a revision is empty.

  ![accepted revisions log](image)

  accepted revisions log

- **Bookshelf: List pages without stable revision:** Displays a list of PDF pages at the beginning of the PDF that only exist as a first draft and have no released version.

  ![Not stable pages](image)

  Not stable pages

  QM:Checklists

  Pages without acceptance feature

- **Bookshelf: List pages without FlaggedRevs:** Displays a list of PDF pages that do not have a release mechanism at the beginning of the PDF.

  ![Not FlaggedRevs namespace](image)

  Not FlaggedRevs namespace

  Introduction
  Wiki pages model
  User rights
  Group manager

  Pages with no FlaggedRevs feature.

- **UEModulePDF: Show FlaggedRevs info below main heading:** Prints the latest revision dates (last acceptance and last edit date) below the heading.
Quality assurance

- **Automatically set the page to stable, when the workflow was finished successfully:** The workflow ends with setting the page status to stable.
- **Automatically delete the workflow, when a page was marked as stable:** The workflow is deleted.
- **Show unstable pages for following groups:** If the group user is removed from the BlueSpiceFlaggedRevs configuration, users in this group will not be able to see draft versions when they are added as reviewers in a review process. When the group user is removed, only sysop and reviewer users can access drafts. If you want other groups, for example editor, to see draft versions, you need to add them to the configuration. If no user groups are specified in the configuration field, not even reviewers and sysops users will see a visual status indication of a page. They will have access to drafts through the revision history for the page instead.

Searching and Navigation

- **Indexing only stable versions:** Draft versions are excluded from the search results. If a page does not have a stable version, it is not shown as a search result.

BlueSpiceSocialBlog

- **Use teaser text for blog entries in the timeline:** When you create a blog entry, you can create a teaser text for it by clicking the cogwheel symbol in the blog entry form. If this setting is active, the teaser text will be shown on the page Special:Timeline instead of the first part of the content.
BlueSpiceSocialTopics

- **Automatically create all discussion pages.** If a user creates the first discussion topic for a page using the link in the page footer of a wiki page, the needed discussion page is automatically created first.

![create discussion topic]

A message "This discussion page was created automatically" is inserted on the discussion page.

If this setting is deactivated, the user is directed to the "Create page" default page first.

BlueSpiceMatomoConnector

- **Site ID:** Matomo ID of the wiki. You can find the site ID as a url parameter in the browser address bar when you are logged into Matomo.

![matomo site ID]

- **Base url:** The url to your Matomo installation.
- **Show opt-out link in footer:** Displays a link in your wiki footer, usually named *Analysis service.*
On the Analysis service page, there is a checkbox that allows a user to opt-out from being tracked for analysis purposes.

You may choose to prevent this website from aggregating and analyzing the actions you take here. Doing so will protect your privacy, but will also prevent the owner from learning from your actions and creating a better experience for you and other users.

☑ You are not opted out. Uncheck this box to opt-out.

Matomo opt-out checkbox

Related info

- Reference:ConfigManager

Customize the main navigation

Users with administrator rights can change the menu items in the main navigation.

### Contents

1 Changing the menu items ................................................................. 25  
2 Changing the icons ........................................................................ 26  
   2.1 Available icons ....................................................................... 27  
3 Supporting language settings .......................................................... 28  
4 Navigation in multilingual wikis ....................................................... 28  
5 Related info ................................................................................... 29

Changing the menu items

The main navigation is visible to all wiki users. By default, it is on the left side of the wiki layout. You can always switch to the main navigation by clicking on the associated icon at the top of the navigation bar.
To activate the edit link, hover over the last menu item in the main navigation.

The link Edit sidebar loads the page Mediawiki:Sidebar:

The menu items are structured as a list:

* = menu header (collapsible)
** = clickable menu item

The syntax for a clickable menu item is Page name|Page label:

In the navigation example above, the page description From A to Z links to the page Special:AllPages.

Note: It is not possible to create sub-items in the navigation bar.

Changing the icons

You can assign different icons to each menu item in the main navigation. Let's assume you have a menu item called Quality assurance. The default BlueSpice icon is a page icon:
To change the icon:

1. Open the page MediaWiki:Common.css in edit mode.
2. Add the following lines to the end of the page and save the page:

```css
#n-Quality-assurance > i:nth-child(1)::before {
    content: '\e9a1';
    font-family: 'entypo';
}
```

Note that the space in the label Quality assurance has to be replaced with a hyphen (Quality-assurance).

The icon is now customized to an eye icon:

Reload the page or empty the browser cache if the changes are not immediately visible.

If the text for the menu items contains special characters, there might be issues because they are converted in the HTML code of the page. In this case, right-click on the corresponding entry and, depending on the browser used, select “Examine element” or similar. You will now see the underlying source code and should see a line item that has this form:

```html
<a id="n-MENUENTRY" class="list-group-item" ..... >
```

Use the exact id value shown in the page inspector in your stylesheet. For example, the German menu item Qualitätssicherung is shown as n-Qualitätssicherung. The selector in Common.css is #n-Qualitätssicherung.

Available icons

You can see all available icons on the page w/extensions/BlueSpiceFoundation/resources/bs.icons.php of your wiki.
A list with all icons and their character keys on this helpdesk is available here and is the same for any default installation of a BlueSpice wiki.

In the upper line you can click through different fonts, below you find the icons with the corresponding character keys. In MediaWiki:Common.css you have to adjust the entries font-family (entypo, fontawesome, icomoon, ...) and content (character key) accordingly.

Supporting language settings

If you want to make sure that your menu items are shown in the language a user has set under Preferences, you need to provide a separate message page for each menu item. These message pages need to reside in the namespace MediaWiki. Since BlueSpice supports English and German (both de and de-formal), you need three language pages for each menu item in the sidebar.

In the following example, we create a menu item called Quality assurance. A user who specified German (de) or formal German (de-formal in their preferences, should see the label Qualitätssicherung instead.

**To create the labels in EN, DE and DE-formal:**

1. Create or edit the page MediaWiki:QA and add the text for the English label (Quality assurance). Save the page.
2. Create or edit the page MediaWiki:QA/de and add the text for the German label (Qualitätssicherung). Save the page.
3. Create or edit the page MediaWiki:QA/de-formal and add the text for the German label (Qualitätssicherung). Save the page.
4. Create the link on the page MediaWiki:Sidebar: **About quality assurance|QA** This creates a link in the main navigation to the page About quality assurance and displays the label that is located in the different language message pages. To test the languages, go to Preferences > User Profile in your user profile menu. In the section Internationalisation, set the language from English to German or vice versa and save the setting. The language of the menu item now displays in the correct language.

Navigation in multilingual wikis

If you have content in multiple languages, you want that users with English language preference settings not only see the corresponding menu labels. They should also be directed to the English page when they click on a menu item. Users with German language settings should see the German content after clicking on the German menu link. In this case, you also have to create separate link targets in addition to the language labels.

**Note:** To avoid having to set up different navigation pages for formal (de-formal) and informal German (de) you can create a policy, which language setting should be used by your users.

In the previous section, we already created the labels when a user switches languages. Now we also have to create different link targets for these pages. If the main language is English and the page is called About quality assurance, the translations can be located in subpages. For example, the German version is located under About quality assurance/de.
To create the link targets to the language pages:

1. Create or edit the page MediaWiki:QA-url and add the link to the English page About quality assurance. The link is entered without brackets, in plain text. Save the page.

2. Create or edit the page MediaWiki:QA-url/de and add the text for the German page (About quality assurance/de). The link is entered without brackets, in plain text. Save the page.

3. Create or edit the page MediaWiki:QA-url/de-formal and add the text for the German page (About quality assurance/de). The link is entered without brackets, in plain text. Save the page.

In the link to the Quality assurance page, change the link from

**About_quality_assurance|QA**

to

**QA-url|QA**

This achieves the language switch for the target pages (QA-url) and for the label of the menu item.

Depending on the language settings of the user, the user is now directly directed to the correct language version.

Related info

- Translation of pages within a wiki
- Personal navigation

Extended statistics

The extension ExtendedStatistics provides an analytic view of many relevant parameters on the wiki, providing wiki administrators better insight into the functioning of the wiki.

Where to find Extended statistics

The navigation link Extended statistics in the tab Global actions loads the page Special:ExtendedStatistics.
Choosing a data source

ExtendedStatistics can show data for multiple aspects of the wiki. Available data sources are:

- **Number of users**: All the users that registered in the period chosen
- **Number of pages**: All pages created in the period chosen.
- **Number of content pages**: All articles in content namespaces created in the period chosen
- **Number of edits**: All edits carried out in the period chosen
- **Edits per user**: Number of edits per user in the period chosen
- **Search queries**: All terms users searched for in the period chosen. Only available if [BlueSpiceExtendedSearch](https://www.mediawiki.org/wiki/Extension:BlueSpiceExtendedSearch) is installed.

Choosing filters

General filters:

- **From** - Date from which to display data
- **To** - Date to which to display data

Some data sources may have additional filters available, like for data sources based on wiki pages, namespace filter is available.
Display settings

The display of the results is determined by the following settings:

- **Interval** - grain of the diagram - determines which time unit will be used to group the data.
- **Mode** - display type:
  - Absolute - shows changes in data for the given period
  - Aggregate - shows running total for the data source choosen
  - List - shows data in tabular view - only available for certain data sources

**Note:** Depending on the selected time period, the interval has to be set accordingly. For example, if you look for data between 02.06. and 03.06. for the same year, the interval setting "Year" will not return any data. Change the interval to "Week" or "Day" to return results.

Viewing the results

Once all the filters and options are set, click on the **Results** tab to show the resulting data.
Configuration

In the Config manager, you can change the following settings:

- **Exclude these users**: Some user groups, like WikiSysop can skew the statistics, for example the statistics for search queries or because they complete automated maintenance tasks. These types of user groups can be excluded from the statistical results.

- **Maximum number of interval steps**: Sets the size of the x-axis for the results. For a few days, select the interval *Day* or *Calendar Week*, for periods over one year, select *Year* or *Month*. If you do not get any results for your query, try to adjust the interval accordingly.

Related info

- Reference:BlueSpiceExtendedStatistics

Manual:Extension/BlueSpiceAbout

Each new installation of a BlueSpice wiki contains the link *About BlueSpice* in the main navigation. It links to the page *Special:AboutBlueSpice*. 
Purpose

The extension was developed for marketing reasons, so that people come via a link to an included external page. The extension inserts a link *About BlueSpice* in the main navigation. The content of the external page is embedded via an *Iframe*.

Deactivating the link

To remove the link from the main navigation:

1. **Go to** *Global actions > Config Manager*.
2. **Select** *Searching and Navigation* from the *Feature* list.
3. **Deactivate** the checkbox *Show link "About BlueSpice" in the main menu*.
BlueSpice is optimized for fast read accesses. If your BlueSpice is running slowly, it can have different reasons. Often the search engine is not set up or the corresponding Tomcat server is not available. Also, an incorrect configuration (e.g., caches) may be the cause. Or the performance of your server is too low.

In this Howto you will find the most important solutions for increasing the speed of your BlueSpice instance.

Contents

1 Apache Tomcat Server not available ................................................................. 35
2 Measures to increase performance ................................................................. 35
   2.1 Specify cache directory ........................................................................... 35
   2.2 Resize the name resolution of the database server ............................... 35
   2.3 Enable memcached ............................................................................. 35
   2.4 Enable Bytecode Cache in PHP ......................................................... 36
   2.5 Increase PHP Memory Limit .................................................................. 36
Apache Tomcat Server not available

BlueSpice uses the search engine Apache Lucene / Solr, which supports important services of the wiki. Should saving a page take a long time, this is an indication that you have a problem with the search engine. Or you can simply enter a search query: If the input and the search page does not look as described here, the search engine is not installed correctly.

- Please check the Installation manual to see if you have completed the installation.
- Restart the Apache Tomcat Server.

Measures to increase performance

Specify cache directory

When you specify a cache directory, the Wiki uses the filesystem for some internal caches instead of the database

```bash
## Set $wgCacheDirectory to a writable directory on the web server
## to make your wiki go slightly faster. The directory should not
## be publically accessible from the web.
$wgCacheDirectory = "$IP/cache";
```

Please make sure that the folder named here can be described by your web server. See also the notes in the Installation manual.


Resize the name resolution of the database server

Especially under Windows, the name resolution of "localhost" can lead to delays. Use the IP address instead of the DNS name in the database. To do this, change the server configuration accordingly in LocalSettings.php:

```bash
$wgDBserver = "127.0.0.1"; #change IP value to your DB server IP
```

Enable memcached

Use Memcached as the central cache type. Note that Memchached must be installed and active on the server!

To do this in LocalSettings.php insert this configuration at the end:
Enable Bytecode Cache in PHP

Since PHP 5.5, the bytecode cache opcache is delivered with. This must however be activated in the php.ini.

```
[php]
opcache.enable=1
```

Additional settings:

```
opcache.memory_consumption=512
opcache.max_accelerated_files=10000
opcache.validate_timestamps=1
opcache.revalidate_freq=2
```

After changing the php.ini, the web server must be restarted.


Increase PHP Memory Limit

A higher memory limit of PHP results in a faster execution. This must be specified in php.ini:

```
memory_limit = 256M
```

After changing the php.ini, the web server must be restarted.

Set up JobQueue

Some tasks from MediaWiki can be delayed. Typically, they are processed by calling pages on the wiki. This can lead to delays. To prevent this, the JobQueue must be set up. Create a cronjob or task that runs this script every 10 minutes:

```
php maintenance/runJobs.php --maxjobs 100
```
Renew the L10N cache

Only in the case of absolute emergency, you can manually update the local cache, otherwise it will be rewritten every page call. To do this in LocalSettings.php insert this configuration at the end:

```php
$wgLocalisationCacheConf['manualRecache'] = true;
```

Then execute the following command:

```bash
php /maintenance/rebuildLocalisationCache.php --force --lang="de,de-formal,en"
```

This command should also be set up as an hourly cronjob.


Related info

- Performance Optimization: MySQL (MariaDB)

Managing translations

| Contents |
|-------------------------|------------------|
| 1 Why translate? | 37 |
| 2 Approaches | 38 |
| 2.1 Maintaining separate wikis | 38 |
| 2.2 Subpages | 39 |
| 2.3 MediaWiki "Translate" extension | 39 |

Why translate?

In today's interconnected world, most wiki owners have to think about dealing with multiple language versions of their wiki. This is important for capturing the knowledge of workers with different language competencies. It also can help to improve wiki usage and acceptance of the wiki technology.
Multilingual wikis require some planning effort and should be planned and explained to stakeholders in writing. The workload for maintaining and monitoring multiple languages can grow fast as more and more content is added to the wiki.

Since these language versions, depending on the approach, are often linked manually with special tags in source code, you need to determine how this process works before deciding if and how to create different language versions.

**Some questions you should ask yourself first:**

- What are the goals of creating content in different languages?
- Which languages need to be maintained?
- How many users depend on each language (both as readers and authors)?
- Who is responsible for coordinating the translation efforts?
- How much extra time will be spent on quality assurance for each language?

**Approaches**

**Maintaining separate wikis**

Each language has its own wiki. Pages are connected manually by inserting a small code snippet at the end of each page. The user sees a language flag in the page header and can easily switch between multiple languages:

Read how to do this with the extension [BlueSpiceInterWikiLinks](#).
Subpages

Each page is translated into a subpage of the main language page. For example, mywiki.com/BlueSpice and mywiki.com/BlueSpice/de would create the German language version of the page BlueSpice as subpage BlueSpice/de. The language switch is placed at the top of each translated page:

A simple link to the main language page is added to each page that has a translation. Example: 

{{Translate|BlueSpice}}

This switch uses the template Translate.

Example: English to German language switch template

MediaWiki "Translate" extension

Another alternative is the MediaWiki Translate extension: Like the subpages solution above, translations are managed within one wiki instance. This extension has to be installed separately and is documented at mediawiki.org/wiki/Help:Extension:Translate.

Namespace manager
The Namespace manager allows a user with administrative rights to create, delete and rename namespaces and to change the settings of these namespaces. The interface for the user manager is provided by the extension BlueSpiceNamespaceManager.

### Accessing the Namespace manager

The navigation link to the Namespace manager is located under Global actions > Management. This link opens the page Special:NamespaceManager.

### Creating a namespace

**To create a namespace:**

1. **Click** the "Plus" icon at the top of the page. A dialog opens.
2. **Enter** the name for the new namespace and select the namespace options.
Creating a namespace

3. You can activate the following options:
   1. **Subpages**: namespace can contain subpages (MediaWiki functionality)
   2. **Content namespace**: needs to be checked if users will create wiki pages in this namespace (MediaWiki functionality). See also mediawiki.org/wiki/Manual:ContentHandler.
   3. The remaining options activate a number of extensions for the namespace: CategoryCheck, Secured page assignments, PageTemplates, Visual editor, Rating, Recommendations, ReadConfirmation, Semantic MediaWiki, Approval.

The corresponding talk namespace for the new namespace is automatically created. The ID of each namespace is assigned automatically based on wiki settings and existing namespace IDs.

Editing and deleting a namespace

**Editing a namespace:** A namespace can be edited by clicking on the "wrench" icon in the table row or above the table when a namespace is selected.

Names of talk namespaces or of system namespaces (File, MediaWiki) cannot be changed.

**Deleting a namespace:** Only custom (user created) namespaces can be deleted.

After clicking on the delete icon, a dialog with the delete options appears.
Deleting a namespace

- **Will be deleted**: deletes the pages in this namespace together with the namespace
- **Will be moved into "(Pages)"**: moves the pages of this namespace into the main namespace
- **Will be moved into "(Pages)" with the suffix "(from [namespace name])"**: moves and appends the pages with "from [namespace]"

Talk namespaces are deleted with their corresponding namespace and cannot be deleted separately.

Related info

- Reference: BlueSpiceNamespaceManager

Authentication with LDAP
LDAP means Lightweight Directory Access Protocol. This can be used for centralized authentication. This extension allows you to connect BlueSpice (and MediaWiki) to an LDAP server for central authentication.

**Important!** Due to a security vulnerability in Active Directory, the use of a secure connection (with SSL / TLS encryption) for user authentication is strongly recommended. A Microsoft patch for March 2020 no longer allows unsecured connections:


Any software that makes LDAP queries over unsecured connections is affected. Depending on the settings, this may also affect BlueSpice MediaWiki. If your system is configured to already use a secure connection, there is nothing you need to do.

If BlueSpice and Active Directory communicate via an unsecured connection, the system must be reconfigured to remain accessible.
Please check your configuration and contact us if you have any questions.

---

**Contents**

1 BlueSpice with LDAP ................................................................. 43
2 Configuration options ............................................................. 44
3 Please note after configuring LDAP ........................................... 44
4 Related info ........................................................................... 45

---

**BlueSpice with LDAP**

The MediaWiki extension "LDAP Authentication" is available in BlueSpice free, but is not activated by default. To link the Wiki to LDAP you need to activate the extension and configure it.
Configuration options

<table>
<thead>
<tr>
<th>LDAP</th>
<th>Connection to AD without group synchronization</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP with group synchronization</td>
<td>If you have already defined user groups for your company, they can be adopted for the wiki. The corresponding groups are automatically present in the wiki with the group name and you can assign the corresponding rights to the groups there.</td>
</tr>
<tr>
<td>Comfort Sign-on</td>
<td>such as LDAP with group synchronization as above</td>
</tr>
<tr>
<td></td>
<td>To further extend the connection to a central authentication, there is the possibility to set up a single sign-on. This means that the user is also logged on to the wiki at the same time when logging on to the PC.</td>
</tr>
</tbody>
</table>

Please note after configuring LDAP

- The wiki does not write back to the LDAP directory. That means, e.g. password changes in the wiki can lead to a conflict with the AD. In the best case, the changes will be overwritten by LDAP during the next login.
- It is not allowed to create users manually in the wiki. This leads to the conflict, even if the convention of the LdapAuthentication is case-sensitive.
- No users can be created in the LDAP directory via UserManager in the wiki.
- By default, there is no initial and / or active synchronization with the LDAP directory. Users do not appear until after the first login in the wiki.
- A group assignment is possible via the wiki.
LDAP configuration with group synchronization also applies:

- Again, the AD is the leading authority, Groups are taken over from the AD.
  Caution: The corresponding group must be created with the identical name, as it is called in the AD directory, in the group manager of the wiki in order to guarantee the group assignment.
- Groups can not be assigned to the user manually in the wiki. Please make the assignment via the LDAP directory.
- Groups that a user does not belong to in the LDAP directory are not displayed in the wiki.
- The assignment of the user to groups takes place during the login routine with the respective user, also here: no automatic comparison with the directory in the background.
- A group assignment via the wiki is not possible. Exceptions are the groups sysop, bot and bureaucrat. These can be assigned via the wiki and are not withdrawn from the user.

LDAP configuration with Comfort Sign-on also applies:

- Browser requirements: compatability with Internet Explorer, Edge und Google Chrome
- Security requirement: https, not http
- The web page must be assigned according to the local intranet (group guideline)

Related info

- Reference:LDAP_Authentication

Group manager

The interface for the Group manager is provided by the extension GroupManager. It allows adding, renaming and deleting groups.

| Contents |
|-----------------|---------------|
| 1 Functionality .......................... | 45 |
| 2 Assigning roles and users to groups .......................................................... | 47 |
| 3 Related info .................................. | 47 |

Functionality

An administrator can go to Global actions > Management > Group manager. This opens the page Special: GroupManager.
The group manager has the following features:

- **Viewing groups**: All existing groups in the wiki are listed.
- **Creating new groups**: Clicking on the "plus" button opens a dialog for adding a new group.
- **Renaming groups**: A group can be renamed by selecting it and then clicking the wrench icon. System groups and groups declared by other extensions cannot be renamed.
- **Deleting a group**: A group can be deleted by selecting it and then clicking the "x" button. System groups cannot be deleted.
Assigning roles and users to groups

To assign users to groups, use the User manager. To assign roles (permissions) to groups, use the Permission manager.

Related info

- Reference:BlueSpiceGroupManager
- Managing permissions

Permission manager
Access to the permission manager

To manage permissions, the extension **BlueSpicePermissionManager** provides the administrator interface. It is located under *Global actions > Management > Permission manager*. This links to the page *Special:PermissionManager*:

![Permission manager interface](image)

---

Role-based permissions

In BlueSpice version 3 roles were introduced as a way to manage wiki rights. The main intention of using roles is to simplify rights management.

Roles represent a collection of individual permissions that are necessary to perform certain function on the wiki. For example, for a user who is supposed to only read the wiki, many permissions in addition to the "read" permission are needed: the ability to change their own settings, to search the wiki, to view page ratings, and so on.
All permissions that make up a logical group are encapsulated in a role, in this example the role "reader". If wiki admins want to grant read-only rights to a user group, they only need to assign that group the "reader" role, instead of assigning many individual rights.

By assigning roles to a group, all users belonging to that group will receive the rights contained in these roles. Roles are not assigned directly to users, but to groups instead. Users are then assigned to one or more groups.

**Default roles**

By default, BlueSpicePermissionManager includes a number of pre-defined roles that serve most user needs on the wiki. The individual permissions contained in a role can be seen by clicking the info icon in front of the role name. It opens a dialog with a permissions list for the role:

```
- **bot** - typically assigned only to the *bot* group
- **admin** - all available rights. It should be assigned only to wiki-admin groups
- **maintenanceadmin** - very similar to the *admin* role, used for user groups that are responsible for maintaining wiki integrity
- **author** - all permissions necessary for creating content on the wiki
- **editor** - create content, edit and delete content, create reviews
```
The roles matrix

The permission manager consists of the group tree (1) and the role matrix (2):

The **group tree** (on the left) shows all existing groups:

- **Group "*"**: all non-logged-in (anonymous) users
- **Group "user"**: all logged-in users, the default group for all users
- **Subgroups of group "user"**: all groups that are defined on the wiki, either by default, by MediaWiki, or custom groups created by the wiki admins. System groups, created by MediaWiki, can be hidden by unchecking the "Show system groups" checkbox above the tree.
The columns in the **role matrix** are:

- **Role information** (info icon): Clicking the icon shows all the permissions in a role. This list is exportable.
- **Role name**
- **Wiki**: Assignment of a role to the entire wiki. By assigning the role in this column, a user group gets permissions in this role on the wiki (all namespaces).
- **Individual namespaces**: The following columns list every (applicable) namespace on the wiki.
  - Roles can be assigned to individual namespaces. For example, the group *user* can get the *editor* role only in the namespace *Public*. *Users in this group cannot edit content in any other*. By granting a role to a particular group in a particular namespace, means that all other groups will lose permissions from this role, eg. granting role “reader” in namespace “Private” to group “sysop” means that all users in any other groups won’t be able to read pages in “Private” namespace, even if they have “reader” role granted on the wiki level (“Wiki” column).
  - The same role can be granted to multiple groups for the same namespace.
  - Additional namespaces can be added in the matrix by clicking on the arrow in table header, then “Columns”. Then the namespaces can be selected.

**Role inheritance**

By default, all roles granted to the (*) group will be granted to the *user* group, and all roles granted to the *user* group are granted to its subgroups. If a group inherits the role from an upper-level group field, this is indicated in the role matrix with a green background, but the checkbox is empty.

**Technical info**

**Logging**

Every change to the roles is logged in the MediaWiki log book, found under Special:Log under Permission Manager log type. These logs are available only to wiki administrators (users in groups with the role *admin*).

**Configuration**

All changes to the role matrix are backed up. By default, the last 5 backups are kept. This limit can be changed in Config manager, under configs for the extension BlueSpicePermissionManager.

- **Backup limit**: Sets the number of backups for the permissions manager. Each time the page Special:PermissionManager is saved, a backup is created. If the backup limit is set to 5, the last five versions of the permissions configuration are saved as backups.

**Related info**

- Reference:PermissionManager
## Permissions

<table>
<thead>
<tr>
<th>Permission</th>
<th>Definition</th>
<th>Namespace specific?</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>applychangetags</td>
<td>Apply tags along with one's changes</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>autoreview</td>
<td>automatically marks those edits which a user has made themselves as reviewed</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>autoreviewrestore</td>
<td>autoreview of the rollbacks made by the user</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>bookshelfbookmanager</td>
<td>access to the page Special: BlueSpiceConfigManager</td>
<td>BlueSpice</td>
<td></td>
</tr>
<tr>
<td>bookshelfbookui</td>
<td>access to the page Special: BlueSpiceAbout</td>
<td>BlueSpice</td>
<td></td>
</tr>
<tr>
<td>bs-privacy-admin</td>
<td>execute privacy administrative action</td>
<td>BlueSpice</td>
<td></td>
</tr>
<tr>
<td>changetags</td>
<td>Add and remove arbitrary tags on individual revisions and log entries</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>checkliatmodify</td>
<td>Allow user to modify checklist</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>createclass</td>
<td>Allows access to and creating classes in Special: CreateClass</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>createpage</td>
<td>allows the user to create new pages (edit permission is needed)</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>createtalk</td>
<td>allows the user to create discussion page</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>delete</td>
<td>allows the user to delete pages</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>deletechangetags</td>
<td>Delete tags from the database</td>
<td>Mediawiki</td>
<td></td>
</tr>
<tr>
<td>deletedhistory</td>
<td>View deleted history entries, without their associated text</td>
<td>yes</td>
<td>Mediawiki</td>
</tr>
<tr>
<td>deletedtext</td>
<td>View deleted text and changes between deleted revisions</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>Permission</td>
<td>Definition</td>
<td>Namespace specific?</td>
<td>Distribution</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>---------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>dpl_param_delete_rules</td>
<td>framework of DynamicPageList</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>dpl_param_update_rules</td>
<td>allows you to define the rules that the DynamicPageList does to update the pages</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>duplicate</td>
<td>allows user to duplicate pages</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>edit</td>
<td>allows the user to edit unprotected pages</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>editcontentmodel</td>
<td>edit the content model of a page</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>editmyuserjson</td>
<td>edit your own user JSON files (note that this is not needed if the group already has the edituserjson right)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>editor</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>editprotected</td>
<td>edit protected pages as as &quot;sysop&quot;</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>editrestrictedfields</td>
<td>allows editing of restricted fields</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>editprotected</td>
<td>edit protected pages as &quot;autoconfirmed&quot;</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>editusercss</td>
<td>edit other users' CSS files</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>edituserjson</td>
<td>Edit other users' JSON files</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>editwidgets</td>
<td>edit and create widgets in the namespace &quot;Widget&quot;</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>expirearticle</td>
<td>set an expiration date for an article</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>extendedsearch-search-externalfile</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>extendedsearch-search-reprofile</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>extendedsearch-search-specialpage</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>extendedsearch-search-wikipage</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>extendedstatistics-viewspecialpage-aggregated</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>generatepages</td>
<td>enables &quot;Generate pages&quot; tab</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>geocode</td>
<td>create georeferences</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>managechangetags</td>
<td>create and (de)activate tags</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>markbotedits</td>
<td>mark rolled-back edits as bot edits</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>mergehistory</td>
<td>merge the history of pages</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>minoredit</td>
<td>marks edit as minor</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>move</td>
<td>allows the user to change the title of unprotected pages (edit permission is needed here). If the user has this permission, subpages are automatically moved with main pages.</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>move-categorypages</td>
<td>move category pages - (requires the move right)</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td></td>
<td>this moves subpages along with the main page to which they are assigned (move permission is needed here). If the user has this permission,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Permission</td>
<td>Definition</td>
<td>Namespace specific?</td>
<td>Distribution</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>move-subpages</td>
<td>subpages are automatically moved with main pages.</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>movefile</td>
<td>move files - requires the move right and $wgAllowImageMoving to be true</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>movestable</td>
<td>user can move pages with stable revisions</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>nominornewtalk</td>
<td>not have minor edits to discussion pages trigger the new messages prompt</td>
<td></td>
<td>BlueSpice</td>
</tr>
<tr>
<td>noratelimt</td>
<td>the user is not affected by rate limits</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>nuke</td>
<td>allows access to Special:Nuke to mass delete pages</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>pageassignable</td>
<td>user can get assignments</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>pageassignments</td>
<td>user can make assignments</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>passwordreset</td>
<td></td>
<td></td>
<td>BlueSpice</td>
</tr>
<tr>
<td>patrol</td>
<td>mark others edits of others as patrolled</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>patrolmarks</td>
<td>view recent changes patrol marks</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>protect</td>
<td>allows users to protect the one side, to prevent that is this edited or moved (&quot;Protect&quot;can be found under &quot;More&quot;)</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>purge</td>
<td>purge the site cache for a page without information</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>rating-archive</td>
<td>allows to delete reviews</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>rating-read</td>
<td>allows to read reviews</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>rating-viewspecialpage</td>
<td>allows to open the special page &quot;Special Ratings&quot;</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>rating-write</td>
<td>allows updating, inserting and archiving rated comments</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>read</td>
<td>lets the user view pages</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>readconfirmationremind</td>
<td>remind users that they have to confirm to have read the page</td>
<td></td>
<td>BlueSpice</td>
</tr>
<tr>
<td>remindeditall</td>
<td>edit reminders of others</td>
<td></td>
<td>BlueSpice</td>
</tr>
<tr>
<td>renameuser</td>
<td>rename users</td>
<td></td>
<td>BlueSpice</td>
</tr>
<tr>
<td>replacetext</td>
<td>make string replacements on the entire wiki</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>reupload</td>
<td>overwrite existing files</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>reupload-shared</td>
<td>overwrite files on the shared media repository locally</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>review</td>
<td>let the user review changes</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>rollback</td>
<td>quickly rollback the edits of the last user who edited a particular page</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>rssfeeder-viewspecialpage</td>
<td>access to the Special:RSSFeeder special page</td>
<td></td>
<td>BlueSpice</td>
</tr>
<tr>
<td>smw-admin</td>
<td>allows administrating semantic MediaWiki</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>social-deleteothers</td>
<td>delete entries of others</td>
<td></td>
<td>BlueSpice</td>
</tr>
<tr>
<td>social-editothers</td>
<td>edit entries of others</td>
<td></td>
<td>BlueSpice</td>
</tr>
<tr>
<td>Permission</td>
<td>Definition</td>
<td>Namespace specific?</td>
<td>Distribution</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>---------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>social-editothersprofile</td>
<td>edit user profiles of others</td>
<td></td>
<td>BlueSpice</td>
</tr>
<tr>
<td>socialprofile-viewspecialpage</td>
<td>view the special page Special:Profiles</td>
<td></td>
<td>BlueSpice</td>
</tr>
<tr>
<td>stablesettings</td>
<td>user can changes the settings of stable revisions of any page</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>undelete</td>
<td>allows the user to restore deleted pages</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>unreviewedpages</td>
<td>lets the user see the page Special: Unreviewed pages</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>unwatchedpages</td>
<td>View a list of unwatched pages - lists pages that no user has watchlisted</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>upload</td>
<td>allows the creation of new pictures and files, i.e. pictures and files can be uploaded</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>upload_by_url</td>
<td>uploaded files from a URL</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>usermerge</td>
<td>user is allowed to merge user-accounts</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>validate</td>
<td>lets the user validate changes. lets the user is not affected by rate limits or view files which have been uploaded</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>viewedittab</td>
<td>enables &quot;Edit with form&quot; tab</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>viewsuppressed</td>
<td>view revisions hidden from any user - i.e. a more narrow alternative to &quot;suppressrevisions&quot;</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>apihighlimits</td>
<td>gives a user a higher limit for API queries; this is a special permission to allow several actions to be carried out at once</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>autoconfirmed</td>
<td>not to be affected by IP-based rate limits</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>autopatrol</td>
<td>have one's own edits automatically marked as patrolled - $wgUseRCPatrol must be true</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>bigdelete</td>
<td>Allows the user to delete pages which are larger than the limit $wgDeleteRevisionsLimit. The variable DeleteRevisionsLimit can be set up in advance.</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>block</td>
<td>Allows the user to block IP addresses and registered users. There are various block options including stopping a user from editing and from registering new accounts and automatic block of other users with the same IP address. This takes place via the special page Block user.</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>blockemail</td>
<td>block a user from sending mail</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>blog-viewspecialpage</td>
<td>allows viewing Special:Blog</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>bluespicepreferences-viewspecialpage</td>
<td>allows viewing Special:BlueSpice_Preferences</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>bot</td>
<td>every edit is auto-accepted / no new version</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>browserarchive</td>
<td>search for deleted pages</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>categorymanager-viewspecialpage</td>
<td>user is allowed to view categorymanager</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>Permission</td>
<td>Definition</td>
<td>Namespace specific?</td>
<td>Distribution</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>---------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>createaccount</td>
<td>allows the user to create new accounts</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>dashboards-viewspecialpage-userdashboard</td>
<td>allows viewing Special:UserDashboard</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>editinterface</td>
<td>edit the user interface</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>editmyoptions</td>
<td>edit your own private data (e.g. email address, real Name)</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>editmyprivateinfo</td>
<td>edit your own private data (e.g. email address, real Name)</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>editmyusercss</td>
<td>edit your own user CSS files</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>editmyuserjs</td>
<td>edit your own JavaScript files</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>editmywatchlist</td>
<td>edit your own watchlist</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>edituserjs</td>
<td>edit other users' JavaScript files</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>extendedsearch-viewspecialpage</td>
<td>Allows viewing Special:ExtendedSearch</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>hideuser</td>
<td>block a username, hiding it from the public</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>import</td>
<td>allows the user to import an article from another wiki in one go</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>importupload</td>
<td>import pages from a file upload</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>interwikilinks-viewspecialpage</td>
<td>allows viewing Special:InterWikiLinks</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>ipblock-exempt</td>
<td>bypass IP blocks, auto-blocks and range blocks</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>move-rootuserpages</td>
<td>move root user pages</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>namespacemanager-viewspecialpage</td>
<td>allows viewing Special:NamespaceManager</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>override-export-depth</td>
<td>export pages including linked pages up to a depth of 5</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>pageaccess-viewspecialpage</td>
<td>allows viewing Special:PageAccess</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>pagetemplatesadmin-viewspecialpage</td>
<td>allows viewing Special:PageTemplates</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>passwordreset</td>
<td>view password rest emails emails</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>permissionmanager-viewspecialpage</td>
<td>allows viewing Special:PermissionManager</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>remindededitall</td>
<td>Let the user view and edit all reminders</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>renameuser</td>
<td>rename users</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>rssfeeder-viewspecialpage</td>
<td>allows viewing Special:RSSFeeder</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>sendemail</td>
<td>send emails to others</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>unblockself</td>
<td>unblock oneself</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>usagetracker-update</td>
<td>allows updating UsageTracker data</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
</tbody>
</table>
Permissions and Definitions:

<table>
<thead>
<tr>
<th>Permission</th>
<th>Definition</th>
<th>Namespace specific?</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>usermanager-viewspecialpage</td>
<td>allows viewing Special:UserManager</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>userrights</td>
<td>user is allowed to add user groups (permissions) to other users</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>viewmyprivateinfo</td>
<td>view your own private data (e.g. email address, real name)</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>viewmywatchlist</td>
<td>view your own watchlist</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>viewreaders</td>
<td>view a list of people who have read a page</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>wikiadmin</td>
<td>used in many BlueSpice extensions for potentially dangerous task such as user manager and global configuration</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>workflowedit</td>
<td>user is allowed to edit workflows</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>workflowlist</td>
<td>let the user view other peoples' work flows</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>workflowview</td>
<td>let the user view work flows</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>writeapi</td>
<td>controls access to the write API ($wgEnableWriteAPI must be set to true), this means commands can be given using this external interface.</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
</tbody>
</table>

Rights concepts

An introduction to rights management

More than 100 permissions are necessary to control the user access to all wiki functions and extensions.

Depending on the actions a user needs to take, many of these permissions are related and consequently need to be granted to a certain type of user. A user with read access, for example, needs to also be able to change the user profile and add pages to a watch list. For this reason, BlueSpice uses roles and groups to manage the rights of individual users.

The following entities are part of the rights management system:

- **Permission**: Allows a specific action.
- **Role**: A set of permissions (permissions can only be set by selecting roles).
- **User**: Entity in the wiki instance database. Has a unique user name and user id.
- **User group**: A collection of users. A user is assigned to one or more groups. There are system internal groups (cannot be removed or renamed) and custom groups. In many cases the group name consists of the role and a namespace name.
- **Namespace**: Permissions can be set on a namespace level. But not on a per-page-level.
Use case: Managing department information

Anna (HR Manager) and Phil (HR Specialist) are maintaining all content related to the Human Resources department on the company wiki.
Some content is visible to all employees. Other content has to be restricted and only be visible to upper management and to Lea, the company's legal advisor.

After reviewing the content and access requirements, the company decides to create HR content in two namespaces: All unrestricted content goes in the Main namespace of the wiki. Sensitive information is maintained in a custom namespace called "HR".

To reflect these specific HR requirements, the wiki administrator needs to complete the following steps:

1. Create the namespace (HR:) on the page Special:NamespaceManager:

   ![Namespace Manager](image)

   After adding the namespace, the new namespace is displayed after pressing the "f5" key.

2. Create the necessary groups on the page Special:GroupManager:

   ![Group Manager](image)

   - **HR_visitor**: Users in this group have only view permissions to the (HR:) namespace
3. Assign **roles** to each group on the page `Special:PermissionManager`. After this, each group has specific sets of permissions:

1. The group **HR_visitor**:

![Permission manager](image)

The administrator selects the group "HR_visitor" and checks the Role "reader" only in the HR namespace. Since the reader role in the HR namespace is now assigned to the group "HR_visitor", all other groups no longer have any view permissions for this namespace:
2. The group HR_editor: The administrator selects the role editor only in the namespace HR. Since the editor role does not inherit all permissions from the reader role, the administrator also has to check the reader permissions in addition:

3. The group HR_reviewer: The administrator selects the role of reviewer only for the namespace HR. Since the roles HR_visitor and HR_editor have been reserved for the groups HR_visitor and/or HR_editor before, the editor and reader permissions have to be granted as well:
4. **Add users** to the correct user groups: Since Anna needs to be able to edit and approve the documents both in the HR and in the Main namespace, she has to be added to both the “HR_reviewer” and the standard “reviewer” groups:

![Add user form]

The administrator also adds the other affected users to the correct groups. The result is the following permissions configuration:
In addition, the administrator should ensure that Anna is not the only person who can approve content. Otherwise, there would be a problem when Anna is on vacation or has no time for reviewing page edits.

### Related info

- Namespace Manager
- Permission manager
- Group manager
- User manager

### User manager

The extension **BlueSpiceUserManager** provides the visual interface for user administration.
Contents

1 About User manager ........................................................................................................................................ 64
2 Creating users ................................................................................................................................................ 64
3 Editing users .................................................................................................................................................. 65
4 Inactive users ................................................................................................................................................ 66
5 Related info ................................................................................................................................................... 66

About User manager

Administrators can access the User manager under Global actions > Management > User Manager. The User manager link opens the page Special:UserManager. It shows an editable list of all registered users.

Creating users

To create a user:

1. Click the "+"-button. This opens a dialog.
2. **Enter** the user information in the dialog:
   - **Username**: must be unique and cannot contain special characters
   - **Password and Confirm password**: the password for the new user. Users can later change their passwords.
   - **Email**: The email address of the user (optional)
   - **Real name**: can be a duplicate of an existing user’s real name (optional)
   - **Enabled**: if checked, user account is active
   - **Groups**: a user can be assigned to multiple groups. If no group is selected, the user belongs to the default group *user*.

3. Click **Done** to create the user account.

**Editing users**

The tools for editing a user are shown in the table grid when hovering over or selecting the user from the list.
Inactive users

By default, the list displays users with active user accounts (enabled).

To view inactive users:

1. Click on the table header (any column).
2. Select "Columns", then select "Enabled". This will add additional column "Enabled" to the grid.
3. Click on the header of this column and select Filter > Show all deactivated users.

Tip: User groups can be set for multiple users at the same time by selecting the users and clicking on the "groups" icon above the grid. This resets the groups for the selected users and assigns the newly chosen groups.

Related info

- Reference:BlueSpiceUserManager

Installation guide
Introduction

We are happy that you decided to install the latest version of BlueSpice, our innovative and feature-packed wiki system. Carefully follow our step-by-step instructions, and BlueSpice will be up and running in no time!

After checking your system requirements and preparing your server environment, you will install the BlueSpice application and optionally tweak your configuration to improve your system performance so that your users can enjoy working with their new wiki.

Prerequisites

Before installing BlueSpice 3, review that you meet all system requirements and that your server environment is ready. If you need to set up a server environment first, we provide detailed instructions here:

1. Check the system requirements
2. Prepare your system for the BlueSpice installation.
   To set up your server environment, follow the step-by-step instructions or read our quick reference:
   - Linux
   - Windows

Installing BlueSpice 3

Please select which installation type you need:

- Full BlueSpice 3 installation with Installer
  - Extended Functions: VisualEditor, ExtendedSearch
- BlueSpice 3 WikiFarm installation
- Docker image

Upgrade and patch updates

- BlueSpice 3 upgrade from version 2.27.x to the current version of BlueSpice
- Patch Update from version 3.1.x to a higher version 3.1.x
- Upgrade from BlueSpice free 3.1.x to BlueSpice pro 3.1.x
Quick reference: Configuration, services, and optimization

If you don't need to set up a server environment “from scratch”, you can directly refer to the setup instructions for individual system components. Just make sure that you really have everything configured as needed:

Services and system configuration

- **Linux**
  - Introduction
  - Apache und PHP
  - MariaDB
  - Jetty
  - Elasticsearch
  - Node.js
  - Parsoid
  - Python
  - Memcached
  - Texvc *(BlueSpice pro only)*
  - PhantomJS

- **Windows**
  - Introduction
  - IIS Web Server
  - Visual C++ Redistributable for Visual Studio 2015
  - PHP Manager
  - PHP 7.3
  - MariaDB
  - OpenJDK
  - Apache Tomcat
  - Elasticsearch
  - Git
  - Node.js
  - Parsoid
  - Python
  - PhantomJS *(BlueSpice pro only)*

Webservices for Apache Tomcat

- PDF-Export
- VisualDiff *(BlueSpice pro only)*
- LatexRenderer *(BlueSpice pro only)*

Additional settings and optimizations

- Caching
- Cronjobs
Upgrade to BlueSpice 3

This document describes the upgrade of BlueSpice from version 2.27.x to the current version BlueSpice 3.

Notes

- Please, read this manual completely and work through the single installation steps one after another.
- For editing the configuration files with a text editor, the files must be saved in UTF-8 coding without BOM (Byte Order Mark).
The placeholder <installpath-bluespice> stands for the path to your BlueSpice installation, e.g C: \inetpub\wwwroot\bluespice (Windows regarding the documentation "Folder structure under Windows") or /var/www/bluespice (Linux).

The placeholder <tomcat-webapps> stands for the path to the webapps directory of your Tomcat server, e.g C:\Program Files\Apache Software Foundation\Tomcat 8.5\webapps (Windows) or /var/lib/tomcat8/webapps (Linux).

## Approach

Make sure that your BlueSpice 2 version is up to date.

It is recommended to first create a complete new installation of BlueSpice 3 in parallel with BlueSpice 2 and then transfer the data to the new system.

---

**First of all, make a complete backup of your installation.**

First of all, rename your current installation directory. For example, from /var/www/bluespice to /var/www/bluespice227.

Then, copy the new program files to the original installation location. Now you should have two directories, for example /var/www/bluespice227 with the program files of BlueSpice 2.27 and /var/www/bluespice with the program files of BlueSpice 3.

Next, uploaded files and configuration files managed by BlueSpice must be transferred to the new installation. Just move the directories images/ and extensions/BlueSpiceFoundation/config from the old installation location to the new one.

Next, the main configuration file must be transferred and adapted. Copy the LocalSettings.php file from the old installation location to the new one.

## Setup LocalSettings.php

Open the file <installpath-bluespice>/LocalSettings.php. Look for the following lines:

```php
# End of automatically generated settings.
# Add more configuration options below.
```

Delete all following lines. If you have made additional configurations - apart from steps outlined in the old installation manual - below these lines, make sure to keep these additional configurations.

Insert the following line at the end of LocalSettings.php:

```php
require_once "$IP/LocalSettings.BlueSpice.php";
```
Starting with BlueSpice 2.27.1, all default settings as well as the individual modules of BlueSpice are stored. Thus BlueSpice is only integrated with this one line in MediaWiki. For technical information, visit the documentation for advanced users.

Upgrading BlueSpice

Under Windows, make sure that the environment variables are set correctly to access the php command.

Under Linux, please note that you have to adjust the file system permissions after running the update.php.

Open your command line or terminal an change to the directory <installpath-bluespice>. Run the following command there:

```
php maintenance/update.php (Linux)
php maintenance\update.php (Windows)
```

Checking the installation

Open <bluespice-url> in your browser. Your BlueSpice upgrade should now be completed. Logging in with your access data should be possible.

Categories
You can assign several categories to a page. Categories can be organized as top categories with subcategories. Therefore, it is possible to create a tree structure and thus to build a hierarchical structure.

| Contents |
|-----------------|-----------------|-----------------|-----------------|-----------------|
| 1 What are categories? | 72 |
| 2 Characteristics | 72 |
| 3 Create and assign categories | 72 |
| 3.1 In the title section of the page | 72 |
| 3.2 With Visual Editor | 73 |
| 3.3 In Source code | 73 |
| 4 Links to category pages | 73 |
| 5 Displays of categories | 73 |
| 6 Category manager | 74 |
| 7 Related info | 74 |

**What are categories?**

Categories work like keywords or tags. Adding categories to a page makes it easier to find the page in the wiki. All pages of the same category are automatically shown on the corresponding category page. For each category that has not been assigned before, the wiki will automatically create a redlink. Once the page has been created by clicking on the redlink, all pages and subcategories are automatically listed on the category page.

Categories are usually created by users. However, in special cases, MediaWiki also assigns auto-generated categories (for example, pages with broken links).

**Characteristics**

- **Tagging**: Categories tag pages.
- **Multiple categories per page**: A page can be assigned to several categories.
- **Main categories**: Categories can be organized under main categories.
- **Independent of namespaces**: Categories are not contained in namespaces, but are shared wiki-wide.

**Create and assign categories**

To create a category or assign a page to an existing category, there are multiple options:

**In the title section of the page**

The **title section** contains the category assignment field. Any user with edit rights can click on the edit link to add or remove categories from the page. To view all existing categories with subcategories, you can click on the tree icon. Once you are done, the categories are confirmed with the check mark.
Help categories

With Visual Editor

In the page options menu of VisualEditor, you can access a Categories menu item. Here you can add and remove category assignments from the page and also add a sortkey to the category.

In Source code

To add a category in source code, the namespace Category is added before the page name.

[[Category:Sales]]

Note: On category pages, umlauts are generally sorted all the way to the back, e.g., "Märchen" after "Muh". You can therefore use the variable {{DEFAULTSORT:sortkey}} to specify an alternative title to be used for sorting (e.g., {{DEFAULTSORT:Maerchen}}).

Links to category pages

Links to a category require a colon before the namespace.

Example: [[:category:new_page]]

If this colon is missing, the article will not be linked to the category page, but the article will be assigned to the corresponding category.

Displays of categories

You can view a list of all wiki categories on the page Special:Categories.

On the page Category:category_name, you will find a list of all the pages and media associated with a particular category.
If you have accessed a previously unavailable (redlinked) category page, you can add a category description to the page. That way, users understand the purpose of the category.

Category manager

The easiest way to manage categories and sub-categories is with the Category manager page (Special: Category_manager). You can navigate to the Category manager via Global actions.

Related info

- Category Manager
- https://www.mediawiki.org/wiki/Help:Categories

Magic words

1 What are magic words (or MagicWords)? ................................................................. 74
2 The 4 types of MagicWords ................................................................................. 75
  2.1 Behavior switch ....................................................................................... 75
     2.1.1 Characteristics of a behavior switch ...................................................... 75
     2.1.2 Description ....................................................................................... 75
  2.2 Variable ...................................................................................................... 75
     2.2.1 Characteristics of a variable .................................................................. 75
     2.2.2 Description ....................................................................................... 75
  2.3 Parser Function .......................................................................................... 75
     2.3.1 Characteristics of a parser function ...................................................... 75
     2.3.2 Description ....................................................................................... 76
  2.4 Tag ............................................................................................................. 76
     2.4.1 Characteristics of a tag .......................................................................... 76
     2.4.2 Description ....................................................................................... 76
3 How to add a magic word ................................................................................. 76
4 Related info ....................................................................................................... 77

What are magic words (or MagicWords)?

A "magic word", also known as MagicWord, is a symbol recognized by the MediaWiki software. It triggers the software to do something other than display that symbol or transclude a page with that name, but instead to use the symbol directly.

There are different types of MagicWords:

- **Behavior switch** (or "Double underscore"): __TOC__
The 4 types of MagicWords

Behavior switch

### Characteristics of a behavior switch

- **Purpose:** controls the layout or behavior of the page
- **Syntax:** __NOTOC__

### Description

A behavior switch includes or omits certain elements of the page. It is also known as "double underscore". Behavior switches can be put anywhere in the source code of the designated page (usually at the end of the page). The behavior switch __TOC__ produces as output the table of contents exactly where it was inserted on the page.

Variable

### Characteristics of a variable

- **Purpose:** returns information about the page, wiki, or date
- **Syntax:** {{PAGENAME}}

### Description

Variables contain (simple) dynamic data. If a template name conflicts with a variable, the variable is used. For example, you have the variable {{PAGENAME}}. In that case, you have to transclude the template with the same name as {{Template:PAGENAME}}.

Parser Function

### Characteristics of a parser function

- **Purpose:** simple "programming language" for page content (mainly in templates)
- **Syntax:** {{#if:{{field|}}} | {{field|}}} | N/A }
Description

Parser functions are similar to variables, but take one or more parameters. Example:

{{{#if:{{{type}}} | warning
| This is a warning!
}}}

They are used for simple logic only, since they are hard to read and to maintain on a larger scale. If complex logic is required, consider Lua scripts in the "Module" namespace (mediawiki.org/wiki/Extension:Scribunto) and invoke using {{{#invoke:...}}}

Parser functions can also be "tag-like", e.g. {{{#ask:...}}} from SemanticMediaWiki. For more information, refer to the MediaWiki help pages mediawiki.org/wiki/Help:Extension:ParserFunctions and mediawiki.org/wiki/Help:Magic_words#Parser_functions.

Tag

Characteristics of a tag

- **Purpose:** often used for custom development to process dynamic content
- **Syntax:** <smartlist />

Description

Tags are implemented in PHP as part of a MediaWiki extension. Tags with "bs:" prefix come from BlueSpice (see Reference:BlueSpiceTagSearch). All others come from MediaWiki or from third-party extensions, e.g. the extension SyntaxHighlight.

How to add a magic word

Magic words are inserted directly in the source code. Some frequently used magic words can also be added directly with the VisualEditor *Insert > Magic word* menu item:
What is a namespace?

A namespace defines an area in a wiki. You can recognize a namespace by the namespace prefix in the page title:
In a wiki, you will find predefined namespaces. In addition, wiki administrators can create custom namespaces as needed.

There are certain aspects of namespaces that are important to consider before creating a namespace. It is therefore important to understand the characteristics of namespaces and the reasons for using a custom namespace.

Characteristics of a namespace

- **One namespace per page**: The same page name in a different namespace creates a new page.
- **Flat structure**: no child namespaces
- **Special namespaces**:
  - Main (Pages) - No namespace prefix in page titles
  - Special pages (Special)
  - Images (File)
  - Documents (Media)
  - Discussions (Talk)

Reasons for using namespaces

- **Rights management**: To assign different user permissions to separate content. For example, a company's HR department can use its own namespace to grant only Human Resources personnel access to the pages in that namespace. Here, rights management is the main reason for creating namespaces. However, flat hierarchies are recommended for wikis.
- **Search function**: To exclude pages and files from the search.
- **Design**: To format pages in different wiki areas differently.

We often use the example of cupboards to make clear the principle of namespaces. There are shelves and everyone can look at them and work on something. There are glass cupboards with a lock that you can look into, but only some people have the key to change the contents. Then there are closed wooden cabinets with locks and only selected people can look inside and work in them. And each of these cupboards can look differently.

**Note**: While users cannot view the pages or files in a namespace for which they have no access rights, they will still see the pages and files listed on the wiki's special pages. They will also see the page names in the search results if the namespace has not been excluded from the search.

BlueSpice standard namespaces

BlueSpice uses, among others, the 15 standard and the two so-called pseudo namespaces from MediaWiki:
### Help categories

<table>
<thead>
<tr>
<th>ID</th>
<th>Namespace</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Media</td>
<td>Pseudo-namespace for uploaded images and files. Will be replaced by path of the files.</td>
</tr>
<tr>
<td></td>
<td>special</td>
<td>Pseudo-namespace for special pages.</td>
</tr>
<tr>
<td>0</td>
<td>(pages)</td>
<td>These are given without a prefix.</td>
</tr>
<tr>
<td>1</td>
<td>Talk</td>
<td>talk page. Is created in addition to each article (also in the following namespaces) to speak about its contents. Additional tab (+).</td>
</tr>
<tr>
<td>2</td>
<td>User</td>
<td>User page. Will be created for every logged in user.</td>
</tr>
<tr>
<td>3</td>
<td>User talk</td>
<td>Cf. talk</td>
</tr>
<tr>
<td>4</td>
<td>[Wiki-Name]</td>
<td>Information about the wiki or the current project. Here: BlueSpice.</td>
</tr>
<tr>
<td>5</td>
<td>[Wiki-Name]_Talk</td>
<td>Cf. talk</td>
</tr>
<tr>
<td>6</td>
<td>Image</td>
<td>Description of a picture and other files. Is automatically supplemented with version information and information about the occurrence of the file</td>
</tr>
<tr>
<td>7</td>
<td>File_Talk</td>
<td>Cf. talk</td>
</tr>
<tr>
<td>8</td>
<td>MediaWiki</td>
<td>system messages. A complete list can be found under Special: AllMessages. Can only be changed by registered users.</td>
</tr>
<tr>
<td>9</td>
<td>MediaWiki_Talk</td>
<td>Cf. talk</td>
</tr>
<tr>
<td>10</td>
<td>Template</td>
<td>Templates can be integrated into other pages.</td>
</tr>
<tr>
<td>11</td>
<td>Template_talk</td>
<td>Cf. talk</td>
</tr>
<tr>
<td>12</td>
<td>Help</td>
<td>Help pages describe how to perform actions in the wiki. No clear separation from the [wiki name] namespace.</td>
</tr>
<tr>
<td>13</td>
<td>Help_talk</td>
<td>Cf. talk</td>
</tr>
<tr>
<td>14</td>
<td>Category</td>
<td>Pages can be assigned to categories, which are then accessible in this namespace.</td>
</tr>
<tr>
<td>15</td>
<td>Category_talk</td>
<td>Cf. talk</td>
</tr>
</tbody>
</table>

**Standard namespace:** A page is assigned to the "Main" namespace, as long as no other namespace is specified.

**Pseudo namespaces:** The two pseudo namespaces (Media, Special) are used like normal namespaces, but you cannot edit them or add pages to them.

Most pages in the namespaces are created automatically:

- Special pages are generated by the system during installation.
- Media and image pages are created during file upload.
- User pages are created whenever a user acts on the wiki.
- Discussion pages are also created with the corresponding pages.

This leaves only the default namespaces (Main), [wiki name], Template, Help and Category namespaces where pages can be freely created.
Note: In the default MediaWiki, the names of these areas are "hard-coded". This means that they have been set in the source code of the MediaWiki and cannot be changed by users.

Accessing pages in a namespace

To access or create a page in a specific namespace, its name is simply placed in front of the page title and separated by a colon:

```
[[Setup:Installation|]]
```

In the example, the pipe symbol (straight line) was also added. It has the effect that the namespace won't be displayed for the link label.

If you provide a namespace that is not known to the wiki, the page is created in the standard namespace Main. The portion of the reference specified as the namespace is then added to the title of the item instead and is not recognized as a namespace label.

Creating a new namespace

You can create additional namespaces by using the Namespace manager under Global actions > Management > Namespace manager. The menu item "Category manager" loads the page Special:NamespaceManager.

Organizing content without namespaces

If you simply want to group pages in your wiki without the need for controlling access rights, you can use the syntax of the namespaces to simulate a namespace in the namespace Main. Simply prefix the pages that belong to a group with a name and a colon. If no namespace with this name exists, the prefix simply becomes part of the page name.

That way, it is possible to use pages with the same name in the main namespace and thus let different groups work on content "sets". Since these own "namespace" prefixes are part of the page name, you can now display all pages in a simulated namespace by searching for the prefix in the search field.

Since you can also organize pages with categories and subpages, you should start by planning how you would like to organize the content in your wiki.

After installing your wiki, you can visualize this with the BlueSpice draw.io Plugin directly in your wiki and discuss it with your team.

Viewing all pages of a namespace

You can view all pages in a namespace:

1. Go to the Special page "All Pages"
2. Leave the input field empty
3. Select a namespace from the Namespace drop-down menu
4. Click "Go"
What is a subpage?

To structure wiki content, you can create subpages for a page. This is useful if you have a larger topic and you want to break this topic down into manageable chunks of information. For example, if you have a page about a car, you could have subpages about major car components such as Brakes and Transmission. Subpages can have subpages of their own.

Subpages are automatically displayed in the breadcrumb navigation of the page:

![Breadcrumb navigation](image)

Characteristics of a subpage

- **Syntax-based:** A slash in the page title creates a subpage (e.g., *Installation Guide/System Preparation*).
Navigation: A subpage creates navigation points (breadcrumb).

Creating a subpage

To create a subpage, it is simply appended to the page name with a slash without spaces. Subpages can in turn have subpages:

- [[Installation Guide/System Preparation]]
- [[Installation Guide/System Preparation/Windows]]
- [[Installation Guide/System Preparation Windows/IIS]]

Note: Since MediaWiki interprets slashes as subpages, you should not use slashes in page names.

Reasons for using subpages

Typical applications for subpages are:

- **To create modular pages:** For a larger topic, you can create a main page and link it to individual detail pages. The advantage is that the detail pages can then be specifically linked from other pages.
- **To maintain archives:** If the discussions on the user discussion page become too long, file them in a subpage.
- **To translate a page:** If the content of a page should be available in other languages. You can create a subpage in German for an English page, for example.
- **To document a template:** If you have a very complex template, you can document its functionality in subpages of the template.

Creating a list of subpages

To list the subpages of the current page, add the following tag to the source text of the page:

```\{\{Special:PrefixIndex/{{FULLPAGENAME}}/\}\}``

Example:

To display the subpages of the page *VisualEditor* in the namespace Manual without showing the namespace or the main page name in the results and without including redirected pages, the syntax is:

```\{\{Special:PrefixIndex/Manual:VisualEditor/ |hideredirects=1 |stripprefix=1\}\}```

Output:
The correct display of the subpages is only visible in read-mode after saving the page. The list is displayed automatically in a multi-column layout and cannot be adjusted.

For more flexibility in the output of subpages, you can work with the extension DPL 3 which is included in BlueSpice.

Related info

- Creating page lists

The pages model

Each installed instance of a wiki is made up of different types of pages. Each page type serves a specific role in the wiki and, therefore, contains different elements which are described here.

**Contents**

1 Wiki instance ................................................................. 83
2 Wiki pages ........................................................................ 84
3 The pages model ............................................................. 84
4 Page types ...................................................................... 84
   4.1 Special page ............................................................ 84
   4.2 Content page .......................................................... 85
   4.3 Wiki page ............................................................... 85
   4.4 Category page .......................................................... 85
   4.5 File/image (description) page ..................................... 85
5 Related info .................................................................... 86

Wiki instance

A wiki instance has the following main characteristics:

- it has its own configuration
Help categories

- it has its own data storage with
  - its own database (for pages, users, user-<->groups, user settings, ...)
  - its own file repo (for uploaded files)
- it can be part of a wiki farm

Wiki pages

The pages model

![Diagram of wiki page types]

Page types

Special page

Each wiki instance contains a large number of special pages. These pages are built-in and not directly editable like other pages. All special pages are located in the pseudo-namespace "Special" and are listed on the page Special:SpecialPages:

- **Maintenance reports** (e.g., broken redirects, uncategorized pages, wanted pages)
- **Lists of pages** (e.g., all pages, categories, forms, templates, high-use pages)
- **User admin pages** (e.g., active users list, blocked users, user rights)
- **BlueSpice special pages** (e.g., category manager, namespace manager, privacy admin)
- and many others

If you want to create your own special page, you can find the necessary information at [Mediawiki.org](https://www.mediawiki.org).
Content page

Content pages are all editable wiki pages. They can be wiki pages that are created by all users with the goal to share information on the wiki. Category pages are created when a page was added to a category and a user subsequently saves the necessary category page. A file description page is created when a file is uploaded to the wiki.

All three types of content pages have these commonalities:

- they contain user-generated content
- they contain mainly Wikitext (but not exclusively)
- they are revisioned and have a version history
- they have an associated “Talk page”

Wiki page

Wiki pages are normally the reason why you would install a wiki in the first place. These are the actual “content pages” that users create when they add information to a wiki. They can be “blank” at the beginning or based on a page template that already contains some content with a predefined structure.

- free-text page
- sometimes based on templates

Category page

To display all pages that share a category tag, a category page has to be created. Otherwise, users won’t have a list of pages that are in a particular category. Its most important characteristics are:

- hybrid page (contains auto-generated content)
- contains a list of all pages that are in that particular category
- can be customized as needed
- located in the namespace “Category”

File / image (description) page

When a file (e.g. image or PDF) is uploaded to the wiki, a corresponding description page is created. This page shows all necessary file information and provides access to important file management tools. Its most important characteristics are:

- hybrid page
- contains a preview (if possible)
- contains a file version history
- contains file metadata
- located in the namespace “File”
Wiki basics

The idea

A wiki is a web-based tool that allows people to easily add, modify, or delete the content of a web page simply by using a web browser.

Wikiwiki is Hawaiian and means quick. It describes the idea of creating and sharing content easily and, obviously, very quickly.

In public wikis such as Wikipedia, visitors don't even need a user account to make changes to a page that other people have created or edited before. Have you ever updated a Wikipedia page yourself? You should definitely try!

Wikis use specialized wiki software and are often created in a very collaborative environment. The content is typically non-linear. In order to find relevant information, a powerful search function becomes very important. There are, however, many ways to organize a wiki so that users can navigate to content without relying only on the search function of their wiki.

History

The first wiki (named WikiWikiWeb) was invented by Ward Cunningham in 1995.

Cunningham became impatient with existing text processing programs and was looking for a new documentation system that was adapted to fit the needs of programmers. He wanted to develop a simple software that would allow programmers to work collaboratively on source code and to publish it immediately. Also, the new program should document all editing steps automatically to track all changes that have been made. In the end, the first wiki was put online and is still working.

Wikis are for good reasons a popular technology to this day and have become very mature and feature-rich. They are a great tool for collaborating on information of any kind.
Basic functions

**Editing:** Every wiki page has a clearly visible editing link or button. This should encourage page visitors to immediately contribute to the content if information is missing or simply wrong. Companies should be careful when limiting the edit options on a page - they will surely miss out on important knowledge transfer opportunities.

**Linking:** To make it easy for users to find related information, it is very easy to insert links anywhere in the wiki, even to a page that does not yet exist!

**History:** With the history function, it is possible to trace every change that anyone has ever made to a page. Losing versions of important content is a thing of the past.

**Recent changes:** All recent changes in the entire wiki are clearly visible. Nobody wastes any time looking for the most important and most up-to-date information.

Examples for public wikis

There are large and small wiki communities that use MediaWiki to collaborate. Some examples of public wikis:

- Wikipedia: Free online encyclopedia
- FileZilla Wiki: Help site of the popular FTP software
- Joomla! Documentation: Help documentation of the popular CMS software
- MoodleDocs: Documentation of the learning platform Moodle
- Antwiki: Where ant scientists share their information

Literature


Wikitext

Wikitext is a simplified markup language that is used to format and structure text and other data. While HTML is the most common markup language for web pages, Wikitext is used in wiki systems. Like HTML, it uses tags to mark parts of tags or other data.
How do I use Wikitext?

When you edit a page, you can switch between visual editing and source editing using the editor toolbar.

Wikitext can be entered in source editing mode. When you are in visual editing mode, VisualEditor inserts Wikitext "behind the scenes". If VisualEditor doesn't format elements on a page correctly, you can always switch to source editing to correct the issues directly in Wikitext.

Examples of Wikitext

Here are some typical examples of Wikitext:

Text formatting

- This is '''bold'''
- This is ''italic''
- This is <u>underlined</u>

Structuring

Headings

- (1st level): reserved for page title
Lists

- ordered (numbered):

  # One
  ## One-point-one
  ### One-point-one-point-one
  # Two

- unordered (bulleted): *

- definition list: ;Fire:provides energy and light

Tables

```wikipedia
{| class="wikitable" |
|header 1 |
|header 2 |
|row 1, cell 1 |
|row 1, cell 2 |
|row 2, cell 1 |
|row 2, cell 2 |
}
```

Links

**Wiki internal**

- [[Page title]]
- [[Pancake | Best pancake]]
  this creates a link to the page "Pancake" with the link description "Best pancake".
- see also the Mediawiki help page for links: mediawiki.org/wiki/Help:Links and the help section about external links to internal pages (mediawiki.org/wiki/Help:Links#External_links_to_internal_pages)
- links with parameters / links that open in a new tab: <span class="plainlinks">[[FULLPAGENAME]|action=edit}} Edit this page</span>

**Wiki external**

- [[http://www.hallowelt.com Hallo Welt!]]
- http://www.hallowelt.com
Files/Images

- **Image link:** [[Media:Someimage.png]]
- **Embed an image:** [[File:Someimage.png]]
  - This embeds the image `Someimage.png` on the page.
  - embedding only happens when a link points to the "File" namespace
  - the wiki checks if a preview/thumbnail can be created automatically (e.g. image formats like "png", "jpeg", "gif", "svg") and then embeds a preview into the page
  - otherwise a link will be created to the wikipage in the "File" namespace (aka “file description page”)
- **Embed a file:** [[Media:SomePDF.pdf]]
  - can be embedded: PDF, Tiff (needs extension)
  - cannot be embedded: Microsoft Office and Libre Office files; Shell-Scripts, ...

**Formatting example:**

```wiki
| ![Someimage.png](thumb|50px|left|alt=Screenshot of the edit menu) | The edit menu |
```

Miscellaneous

<table>
<thead>
<tr>
<th>Type of wikiText</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special character</td>
<td>ã → á</td>
</tr>
<tr>
<td></td>
<td>ç → ç</td>
</tr>
<tr>
<td></td>
<td>UTF-8 is possible</td>
</tr>
<tr>
<td>Comment</td>
<td>&lt;!-- unnoticed --&gt;</td>
</tr>
<tr>
<td>No &quot;wiki translation&quot;</td>
<td>&lt;nowiki&gt; and &lt;/pre&gt;</td>
</tr>
<tr>
<td>Table of contents</td>
<td><strong>TOC</strong> and <strong>NOTOC</strong></td>
</tr>
<tr>
<td>Signature</td>
<td>----</td>
</tr>
<tr>
<td>Redirect</td>
<td>#REDIRECT [[targetpage]]</td>
</tr>
<tr>
<td>Template</td>
<td>{{template name}}</td>
</tr>
</tbody>
</table>

Related info

- [Magic words](https://meta.wikimedia.org/wiki/Help:Wikitext_examples)
Checklists

BlueSpiceChecklist allows inserting checklists and checkboxes for to-do lists with responsibilities and status settings.

## Contents

1 Magic word "checklist" ................................................................. 91
   1.1 Creating a checkbox .......................................................... 92
   1.2 Creating a drop-down list .................................................. 93
   1.3 Defining an option list ...................................................... 93
2 Adding checklists in source editing mode ................................... 94
3 Configuration ........................................................................... 95
4 Related info ............................................................................. 95

**Magic word "checklist"**

It is easy to insert simple checklists into any wiki page. When a wiki page has a checklist, any user with checklistmodify rights can update the checklist values without switching into edit mode. These are by default users in the role *editor, author, maintenanceadmin* and *bot*.

**Note:** If a user with read permissions changes the value of a checkbox or drop-down list, the value will not be saved. Refreshing the page will show the last value that has been saved before.

To create a checklist item:

- **Click** Insert > More > Magic word in the visual editor.
- **Click checklist** in the dialog window.

![Image of checklist dialog window]

- **Click Done.** Another dialog window appears.

![Image of checklist dialog window]

Now select the tab to select your checklist type:

- **Checkbox:** creates an individual checkbox.
- **List:** creates a drop-down menu.

A page can contain multiple checkboxes and lists.

### Creating a checkbox

1. **Toggle** the switch in the dialog window on the checkbox tab to create an unselected checkbox. When this toggle is blue, the checkbox is pre-selected.
2. **Select insert.** The checkbox is now visible on the page. Write the text for a label or for an instruction next to the checkbox.

After the page has been saved, all users can activate and deactivate the checkbox.
Creating a drop-down list

1. Select an existing option list in the List tab.
2. Under Selected option, choose the default value.
3. Click Done.

After saving the page, all users can change the selected list value in read mode.

Defining an option list

Before a combobox can be created, a template for the list items needs to be available. For example, to create a list of pizzas, you need to create a page Template:Pizza with the following content:

* Choose pizza
* Margherita
* Prosciutto
* Salami
* Fungi|#00FF00
* Hawaii
* Gamberetti|#0000FF
* Diavolo
* Siziliana|#0000FF
* Quattro Formaggi|#00FF00

After saving this page, the list "Pizza" appears in the select menu Option list.
Colors can be assigned to each option using the color's HEX code. The color value #00FF00 shows green text.

* Quattro Formaggi|#00FF00

Without specifying the color, text inherits the text color of the wiki page.

Checklist examples (checkbox and select menu)

**Adding checklists in source editing mode**

Checklists can also be added to a page using wikitext. The syntax for adding the tag is:

Checkbox:

```html
<bs:checklist type="check" checked="true" />
```

The value of the parameter `checked` can be `true` or `false`, depending on whether the checkbox should initially be selected (true) or deselected (false). List:

```html
<bs:checklist type="list" list="Template:Pizza" value="Choose pizza" />
```

The parameter `list` defines the template page that contains the list, `value` defines the initial selection.

Once a checklist tag has been saved on a page, users can change its value in read mode.
Configuration

The following configuration can be changed in the Config manager:

- **Mark checklist changes as minor edit:** If this setting is active, changes to a checklist (for example, checking a checkbox) in view mode are logged as minor edits. If this setting is inactive, a change to the checklist is recorded as a regular version in the page history.

Related info

- Reference: BlueSpiceChecklist

Manual: Content organization

A guiding principle in a wiki environment is: All users can easily and immediately share their knowledge and collaborate on content. For this to happen, it is not necessarily important that users know how the wiki is organized.

Initially, a page can be created anywhere in the wiki, wherever a user has write access. It is, first of all, important that the information is shared. Where the resulting wiki page ultimately lives and how it is found does not have to be decided right away.

In practice, however, there are many relationships between the individual pages. In addition, there are often different target groups for different types of content.

Therefore, it is important for administrators to set up the wiki so that the content can be meaningfully organized. There are important areas to consider:

- User roles and permissions
- Elements for structuring content:
  - namespaces
  - categories
  - pages and subpages

The following is a simple example for content organization:
To clarify how these wiki functions can be used efficiently for a single wiki or wiki farm, a content organization and management concept should be developed. Consider the following areas:

1. **Content strategy:**
   1. What types of content do you share on the wiki?
   2. Who creates which content?
   3. Is there a need for pre-structured content formats?

2. **Information architecture**
   1. How do I organize content, navigation paths and search capabilities to provide user-friendly access to existing information?
   2. Who has what kind of access to the content?
   3. What are the target groups for the different content areas?

3. **Quality management**
   1. Which content must be checked and by whom?
   2. Do you have content with a predefined life cycle?
   3. Is all content meaningfully categorized?

If you don't have a content strategy or an information architecture and ideas about quality management in place when setting up a new wiki, don't hesitate to start using the wiki. Collect and create content as soon as the wiki is technically available. Just make sure that data protection aspects are clarified in advance and communicated accordingly when sharing company information. Through the search function and various special pages, the content can easily be searched and retrieved.

As the content grows, administrators can take inventory and structure the content based on that information and determine policies, processes and the information architecture. The most important decisions should be written down in a formal governance document. From then on, content will be created and organized according to the policies, processes and architecture decisions that are specified in this document.

### Hide the title section

In some cases, it makes sense to hide the title of a page. For example, if you want to create a portal page. The extension *HideTitle* provides this feature for the wiki.

```
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Usage</td>
</tr>
<tr>
<td>2 Related info</td>
</tr>
</tbody>
</table>
```

### Usage

In *VisualEditor*, go to *Page options > Advanced settings*. 
Set the title visibility to *Hide* and Save the setting. This adds the magic word `__HIDETITLE__` in the source code, usually at the top of the page. After saving the page, the page title is hidden in view mode.
Important information:  • Data protection  • Migration of your contents

BlueSpice pro is your enterprise wiki for building a modern knowledge base: Open source, customizable and globally proven. Test our software for 30 days. We look forward to your feedback and questions.

You’ve got questions?
Florian Müller
sales@halowell.com®
+49 (0)941 868 800

Webinars
Experience BlueSpice pro in a live demo.

Helpdesk
Application tips, orientation and help.

Reference:BlueSpiceHideTitle
Tag cloud

The extension TagCloud visualizes terms from your wiki based on importance. It can be included on any wiki page. The source for the tag cloud terms can be categories or search terms.

Contents

1 Inserting a tag cloud ................................................................. 100
2 Configuration ........................................................................... 101
  2.1 Common configuration ....................................................... 101
  2.2 Advanced configuration ..................................................... 102
3 Examples .................................................................................. 102
  3.1 Text ................................................................................ 102
  3.2 3D canvas ...................................................................... 102
  3.3 List ................................................................................. 103
4 Related info ............................................................................. 104

Inserting a tag cloud

A tag cloud can be inserted directly in source editing mode with the tag `<bs:tagcloud />`. To insert a tag cloud with VisualEditor, select Insert > Magic word > Tag cloud.
Configuration

If tag is added using VisualEditor, a configuration dialog appears. It shows configuration options in two tabs: Common and Advanced.

**Common configuration**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Display name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>renderer</td>
<td>Type</td>
<td>Mode of rendering the cloud</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- List</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Text (font size depends on frequency)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 3D: rotating, interactive view</td>
</tr>
<tr>
<td>width</td>
<td>Width</td>
<td>Part of the page width taken by the cloud in percent or pixels (e.g., 50%, 150px)</td>
</tr>
<tr>
<td>showcount</td>
<td>Show count</td>
<td>Whether to show the numeric frequency of the term in the cloud</td>
</tr>
</tbody>
</table>
Advanced configuration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Display name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>store</td>
<td>Store</td>
<td>Source of the data - category or search terms</td>
</tr>
<tr>
<td>minsize</td>
<td>Min font size</td>
<td>Smallest possible font displayed in the cloud</td>
</tr>
<tr>
<td>maxsize</td>
<td>Max font size</td>
<td>Biggest possible font displayed in the cloud</td>
</tr>
<tr>
<td>exclude</td>
<td>Exclude pages</td>
<td>List of categories to exclude from the cloud, separated by comma - &quot;category1, category2, category3&quot;</td>
</tr>
</tbody>
</table>

Examples

Text

Tag parameters:

<bs:tagcloud count="10" minsize="12" maxsize="34" exclude="Imported vocabulary, Project" />

Output:

Shows a tag cloud with the 10 (count) categories that have the most page associations. The smallest possible font-size is 12 pixels (minsize) and the largest possible font-size is 34 pixels (maxsize). The categories Imported vocabulary and Project have been excluded from the output. Since the data source category is the default for a tag cloud, it is not necessary to specify it in the tag.

```
```

3D canvas

Tag parameters:

<bs:tagcloud renderer="canvas3d" store="category" count="15" minsize="12" maxsize="40" showcount="false" />

Output:
The renderer _canvas3d_ produces an interactive tag cloud. The cloud rotates when the cursor hovers over the tag cloud. It shows the 15 (count) most tagged categories. It is important to set the count limit, since the default count is set to 40, which produces a 3D cloud where the results are hard to distinguish visually. The data source is set to category (store). This is optional, since category is the default store value. The font sizes range from 12 pixels (minsize) to 40 pixels (maxsize). How many pages and files are associated with each category is not shown (_showcount"false_).

### List

Tag parameters:

<bs:tagcloud renderer="list" store="searchstats" count="5" />

Output:

The renderer type _list_ produces a simple unordered list.

- _wiki_ (435)
- _enterprise wiki_ (354)
- _b_ (187)
- _file:_(118)
- _file_(117)

The tag cloud of type _list_ ignores the following parameters: _minsize_, _maxsize_
What is a template?

A template is a type of reusable content that can be integrated into other pages of the wiki. It can be content-based (text template) or structure-based (layout template) or a combination of both.

A simple example is a notification box that looks identical on all pages, but contains different content on each page where it is used (layout template):

Tip: Message goes here

A template can also be used as the source for a page template.

Characteristics of a template

- Allows inserting reusable content with a placeholder
- Is usually located in the namespace “Template”
- Can have parameters
- Often contains logic
- Used to maintain a “look and feel”

Creating and including a template

A new template is created like a regular page, but in the namespace Template.

Example: Simple template for a notification box
A template is then included in a page by putting the name of the template (i.e., the title of the template page without the namespace prefix "Template:" in two curly brackets: {{NotificationBox}}

**Note:** Template names are case-sensitive.

### Editing a template

Changes to a template affect all pages that include this template. Before existing templates are changed, it is recommended that you check which pages use the template. To find these pages, you can go to Page tools > Toolbox > What links here.

### Built-in variables

Each MediaWiki has a number of **built-in variables** that are not pages in the "template:" namespace, but are still used as templates.

For example, the variable {{CURRENTTIME}} returns the the current UTC time.

### Further notes

- The use of a template is basically a transclusion. It is also possible to use pages as templates that are not in the Template namespace. However, this is to be done wisely, since some functions require that the pages are in the template namespace.
- Templates can also be used to define the output of semantic query. For more information, go to Semantic MediaWiki. (This is an example where the pages must necessarily be in the template namespace.)
- The complete list of all pages of the wiki that are located in this namespace can be found on the page Special:Templates.

### Related info

- meta.wikimedia.org/wiki/Help:Template

### Visual version comparison (VisualDiff)

**BlueSpiceVisualDiff** enables users to easily compare two versions of a wiki page.
Comparing page versions

VisualDiff is integrated in the history page of every content page. Users with reading rights can access the version comparison by clicking on Page > History at the top of the content area.

Once in history view, select two versions (revisions) to compare (by marking the radio button in front of every revision) and click "Compare selected revisions".

This opens the compare view, with several modes of comparison available:

- VisualDiff - mode that this page describes.
- WikiText - shows difference in underlying wikitext.
- Classic - shows basic visual difference with old version on the left and new on the right. It highlights which lines were added or removed.
Reading the diff

A change can be “added”, “deleted”, “changed”, or be marked as “conflict” content. Due to the nature of wiki articles, “changed” and “conflict” are very rare. “Changed” will be shown, for example, if a word was linked subsequently. All other changes (although being “changed” as well) are shown as “added” or “deleted”.

Color code for text changes:

- Light blue: additions to the text.
- Orange and crossed-out: deletions from the text.
- Blue dashed lines: Changes in the structure of the article. This is usually the case when a word has been linked subsequently, or a header has been changed.

Color code for image changes:

- Light blue frame: added picture, or the current format of a changed image.
- Red frame: deleted picture, or the former format of a changed image.

Related info

- Reference:BlueSpiceVisualDiff

Context menu
**ContextMenu** replaces the default browser context menu with wiki functions - depending on the context and user permissions.

### Contents

1 Using the context menu ................................................................................................................................... 108
2 Settings ............................................................................................................................................................ 109
3 Related info .................................................................................................................................................... 109

## Using the context menu

Context menu opens when right clicking components that support ContextMenu functionality, namely, internal links and file links.

The context menu opens when you right-click on a component, such as a link or an image.

![Context menu on a file (image)](image)

On internal links, the context menu display quick links for basic page actions, like:

- Editing page
- Viewing page history
- Moving page
- Deleting page...

On file links, some additional options are shown, like:

- Opening file page
- Downloading file
Settings

Settings for the context menu are located in the user preferences (page Special:Preferences), under the "Appearance" tab. The setting is applied separate for each user.

The context menu has two modes:

- Click using the right mouse button and pressing CTRL (Normal right mouse button will show default browser menu)
- Click using the right mouse button (Pressing CTRL will show default browser context menu)

Related info

- Reference:BlueSpiceContextMenu

CountThings
**CountThings** introduces a set of tags for counting various metadata in the wiki. Available tags are: countarticles, countusers, countfiles, and countcharacters.

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Inserting tags ................................................................. 110</td>
</tr>
<tr>
<td>1.1 Configuring the countcharacters tag ...................................... 110</td>
</tr>
<tr>
<td>1.2 Inserting tags in wikitext ...................................................... 111</td>
</tr>
<tr>
<td>2 Related info ........................................................................ 111</td>
</tr>
</tbody>
</table>

**Inserting tags**

Tags are added through the "InsertMagic" dialog by clicking on "Insert" in VisualEditor toolbar and then on "Magic word". In the resulting dialog, choose one of the four previously mentioned types of tags and click "Done".

![Choosing a tag](image)

**Configuring the countcharacters tag**

While other tags have no configuration options, and just adding them to the page is sufficient, the `countcharacters` tag must be configured.

After inserting this tag or clicking on an existing tag already on the page, a dialog opens.
Enter the name of the page for which to count characters. This name should include the namespace if the page is not in the main namespace. Next, select the mode from the dropdown menu.

While selecting the mode and page, a preview of the output is displayed above the dialog box. If the page title in the table heading shows the page name in red ("redlink"), you have misspelled the page name and the page does not exist.

### Inserting tags in wikitext

If you add the tags in source code edit mode, use the following syntax.

```<bs:countarticles />  
<bs:countusers />  
<bs:countfiles />  
<bs:countcharacters mode="Words">ARTICLENAME</bs:countcharacters>`

For the "countcharacters" tag, replace ARTICLENAME with the page name for which you want to get the count values. Also, "mode" can be adjusted as needed. For details, visit the reference page:

### Related info

- Reference:BlueSpiceCountThings
Together we know more

An important aspect of the wiki principle is that information can be shared with other people quickly and without any "red tape". Every wiki user with edit rights should therefore be able to create and edit a page at least in the (Main) namespace without any prior knowledge or without special privileges to contribute to the company knowledge.

How do I create a page?

There are four ways to create a new page in BlueSpice:

- using the search box
- using the "New Page" button
- using a text link (redlink)
- using the web address ("url")

Using the search field

Maybe information about your topic already exists. Before you create a new page, you can use the search to enter terms for your topic and check existing pages. If there is no page on your topic yet, click on the red link ‘Create page [page name]’ in the search results:
Using the "New page" button

Next to the search box is a button to create a page. This button is only activate if you are logged in and have write permissions on the wiki (or in a specific namespace):

Here you can create a page or a subpage of the current page. In addition, you can also upload a file (image, PDF, Word file, etc.) to the wiki.

Using a text link (redlink)

Let's say that you want to create the "Training" page. You can directly select any text on the current page and define it as a link to a new page. This creates a so-called redlink. From them on, the link exists, but there is no wiki page for it. The example page "Training" is thus also listed on the Special page WantedPages.

With VisualEditor: Click the Link button () or press Ctrl+K to create a page. Now enter the page name. If there is no page with this name, the page name is shown in red and the page icon shows a question mark. Click "Done" to create the redlink.
In the source text:

When editing the source code, enter the new page name as a link:

```
[[Training]]
```

Since the page does not yet exist, the link is shown in red after saving:

- Consulting and technology from a single source,
- but adapts them, helps with the Ko in addition,
- Hello World offers training.

Using the web address

You can also create a page directly from the address bar of your web browser:
Simply exchange the current page name with a new one. Here, we create a page “Support” in the main namespace (Main) in the BlueSpice Helpdesk:

https://de.wiki.bluespice.com/wiki/Support

Selecting a template

When you create a page, you are always redirected to an overview page. There, select a page template:

- Empty page
  Start with an empty page.

Creating a new page in a namespace: To create a new page in a namespace, put the name of the namespace in front of it, followed by a colon. Example: Help:New_Article

Tips

- **Browser navigation:** When creating pages, try not to use the “back” button. You could lose content that you have not yet saved or that you want to edit again.
- **Redirects**: Do you have the impression that an article title is searched more often with a different synonym? Then create a new article with this name first. Then redirect the page.

- **Title choice**: In a wiki, titles are very important. In wikis with many entries, authors may make references to pages that they deem important in the context of their entry. The page title should, therefore, clearly communicate its content. Single words are very good, but even short sentences like "why wikis work" can be useful names. In addition, meaningful page titles also help readers find their way around when they search for an entry.

- **Spelling**: When linking to an already existing page you should pay attention to their exact spelling. If you e.g. typing a [[hello world]] instead of [[Hello World]] will create a new page as the links are spelled differently. Therefore, consider also capitalization and spaces. Only at the beginning of the letter does it make no difference whether you write a small or capital letter.

- **Namespaces**: If you want to create an article in a different namespace, the namespace must appear before article name. Example: [[namespace:article name]].

- **Special characters**: The following characters cannot be used in titles: { } & ? < > \ and ,. For more information, see mediawiki.org/wiki/Manual:Page_title.

- **Subpages**: The character / is used to create a subpage.

### Related info

- Rename and move pages
- Redirects - Using Synonyms
- Creating and Using Page Templates

## Delete pages

Users with edit rights can delete wiki pages. If a page is deleted, it can no longer be found using the search function. However, users have the option to restore a deleted page.
How to delete a page?

To delete the page, click *Page Tools > Manage page > Delete*.

Deleting a page

Before deleting the page, you can:

- Check the version history.
- Check which pages link to this page
- Indicate the reason for the deletion: Since deleting a page can raise questions from other users, it makes sense to leave a short explanation here. This text is shown accordingly in the deletion log.
- Watch the page: If the page is restored by another user, you can receive a notification.

Mass-deleting pages

Admin users can mass-delete recently added pages from the special page *Special:Nuke*. 

Which pages should be deleted?

You can use some pages under Special:SpecialPages to find candidates for deletion:

- **Special:ShortPages**: With short pages it can be expected that the content of the article is not relevant enough or is better dealt with as a paragraph in another article.
- **Special:LonelyPages**: Orphaned pages are characterized by a lack of transclusions or links to the page.
- **Special:NewPages**: Reviewing recently added pages is useful, for example, to detect spam in public wikis.

Where do I find information about deleted pages?

- **Special:Log/delete**: Search for and restore deleted pages.
- **Special:DeletedContributions**: Search for deleted posts of a specific user (or an IP address).

Recover deleted pages

Deleted pages can be restored using the Delete log which can be accessed from the page Special:SpecialPages. If the deleted page was linked to other wiki pages, the page can be restored directly via the redlink on that page.

Which pages shouldn't be deleted?

There are often more sensible alternatives for deleting:

- **Move**: If a page has an incorrect or incorrect title, the page can be moved.
- **Copy**: If the content does not match the page title, the content can be copied to another page
- **Redirect**: If the page content already exists on another page, the duplicate content can be deleted and a redirect can be created.
- **Obsolete**: The content is no longer current. You can mark the page as out of date and other wiki users can update the page later.

Related info

- **Nuke**: Extension for mass-deleting pages
- **Redirects**
- **Deleting user accounts**
Drawio offers extensive drawing possibilities for process flowcharts, infographics and other visualizations on a wiki page. Descriptive graphics like process chains or decision trees can be constructed directly on a wiki page.

### Contents

1. Inserting a chart ................................................................. 119
2. Editing the drawing ............................................................ 119
3. Using draw.io with image maps ........................................ 120
4. Related info ........................................................................ 120

---

**Inserting a chart**

To insert a drawing with VisualEditor:

1. **Create or choose** a page where you want to insert a drawing.
2. **Select** Insert > Magic word from the editor toolbar.
3. **Choose** drawio from the list of magic words.
4. **Click** Done. This opens a dialog box. Enter a name for your drawing.
5. **Click** Insert.

This inserts the following tag in your source code `{#drawio:Name_of_the_flowchart}`

6. **Save** the page.

---

**Editing the drawing**

1. **Click** Edit on the saved page above the drawio placeholder to open the draw.io editor. For the best editing experience, set your wiki into full-screen mode using the toggle button in the main toolbar. You can now edit your drawing.
2. **Click** *Save* in the draw.io window to save your drawing.
3. **Click** *Exit* next to the Save button in the draw.io window to close the draw.io editor.

Using draw.io with image maps

Draw.io creates a versioned png-file in the *File* namespace. This means that every change of the flowchart that was concluded by *Save* will create a new, updated version of this png-file. You can integrate this file on another page in your wiki or create an image map.

Related info

- draw.io Website
- mediawiki.org/wiki/Extension:DrawioEditor
- Reference:DrawioEditor
Edit pages

Enable edit mode

To edit an existing page, click the "edit" button.

Editing

You can now add and change content in the content area of the page.

Most users will edit page content using the VisualEditor toolbar. VisualEditor has many features that make page editing much easier.

However, special pages such as templates are edited directly in the source text. Therefore, a knowledge of the Wikitext syntax is necessary for these pages.
Preview

With the **Preview** button, you can check if you really want to save your changes. This way, you can gradually test small changes. Saving the page repeatedly after small editing steps will result in a large amount of entries in the article's version history. That does not always make sense.

The function **SaferEdit** automatically saves intermediate versions at defined time intervals while editing an article so that content is not lost if a page has not been saved for a while.

Elements of the "save" dialog

To save the page, click the "Save changes" button. The corresponding dialog window opens:

The following elements are part of the dialog window:

<table>
<thead>
<tr>
<th>Element</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>textarea</td>
<td>A brief description of the changes makes it easier to understand the changes in the version history.</td>
</tr>
<tr>
<td>This is a minor edit</td>
<td>checkbox</td>
<td>Spelling corrections or formatting changes are usually marked as such. Under Recent Changes, such changes are marked with the letter m (&quot;minor changes&quot;). This makes it easy to differentiate in which article version major changes have been made. In addition, the m affects the notification system. Wiki users can exclude notifications about minor changes.</td>
</tr>
<tr>
<td>Watch this page</td>
<td>checkbox</td>
<td>A check mark in this box causes the page to be included in the personal Watchlist.</td>
</tr>
<tr>
<td>Accept this unreviewed page</td>
<td>checkbox</td>
<td>This box will only be displayed if the revision function is activated in a namespace. A user with the corresponding rights of release can release the page design directly here.</td>
</tr>
</tbody>
</table>
### Help categories

<table>
<thead>
<tr>
<th>Element</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copyright notice</td>
<td>text</td>
<td>The slightly longer text between the article field and the page-save functions is the copyright notice.</td>
</tr>
<tr>
<td>Save changes</td>
<td></td>
<td>Clicking on this button saves the article with all changes made. The edit view will be closed.</td>
</tr>
<tr>
<td>Resume editing</td>
<td></td>
<td>This button returns directly to the page without saving the article. Editing is simply continued.</td>
</tr>
<tr>
<td>Show preview</td>
<td></td>
<td>The page opens in a preview window and can be saved from this window.</td>
</tr>
<tr>
<td>Review your changes</td>
<td></td>
<td>Shows a comparison of the article before editing and at the time of the current processing status with marking of the differences. The changes can be saved directly from this page</td>
</tr>
</tbody>
</table>

#### Editing conflicts

If you try to save a page that someone else is currently also working on, the system will report an editing conflict. Each author can compare the current changes and merge them as needed.

#### Blocked pages

Some pages can be protected and edited only by administrators. Instead of the edit option, a link to "View source code" appears. The cause is often obvious from the version history of the page. In this case, you can contact an administrator who can unlock the page.

---

### Related topics

- VisualEditor
- Insert images
- Insert tables

### Embed videos

BlueSpice integrates the MediaWiki extension *EmbedVideo* to embed video files from external video services such as YouTube or Vimeo. *EmbedVideo* supports more than 20 video services. In addition, you can also embed videos that have been uploaded to the wiki itself.
Embedding external videos

Note: These instructions are taken and adapted from the Mediawiki help page for EmbedVideo.

Syntax

Use the following parser tag to embed an external video in source editing mode:

```
{{#evt:
|service=youtube
|id=https://www.youtube.com/watch?v=MLIE2642neg
}}
```

You can add additional optional parameter (see list of attributes):
A shortened syntax is available with the #ev tag:

```markdown
{{#ev:service|id|dimensions|alignment|description|container|urlargs|autoresize|valignment}}
```

Placeholders for unused arguments between two arguments have to remain empty and cannot be removed:

```markdown
{{#ev:service|id|||description}}
```

The shortest option to embed a video is by specifying the service name and the video ID:

```markdown
{{#ev:youtube|MLIE2642neg}}
```

Example with video description (- you can include a line break with the <br /> tag):

```markdown
{{#ev:youtube|MLIE2642neg|||ISS - Life on the space station <br/> 1:04:27}}
```

### Attributes for parser tag #evt

<table>
<thead>
<tr>
<th>attribute</th>
<th>required</th>
<th>default</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>service=&quot;(see supported services below)&quot;</td>
<td>yes</td>
<td></td>
<td>The video service that is called when the player is created.</td>
</tr>
<tr>
<td>id=&quot;[id</td>
<td>url]&quot;</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>attribute</td>
<td>required</td>
<td>default</td>
<td>description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>dimensions=&quot;[width</td>
<td>widthxheight</td>
<td>xwidth]&quot;</td>
<td>no</td>
</tr>
<tr>
<td>alignment=&quot;[left</td>
<td>center</td>
<td>right</td>
<td>inline]&quot;</td>
</tr>
<tr>
<td>description=&quot;[wiki text]&quot;</td>
<td>no</td>
<td>none</td>
<td>Shows a description below the player container.</td>
</tr>
<tr>
<td>container=&quot;[frame]&quot;</td>
<td>no</td>
<td>none</td>
<td>Determines the container type for the player. frame: Places the video player in a Mediawiki preview box.</td>
</tr>
<tr>
<td>urlargs=&quot;modestbranding=1&amp;version=3&quot;</td>
<td>no</td>
<td>none</td>
<td>Allows adding additional URL-arguments to the embedded url. This is useful for settings that are only offered by an individual video service.</td>
</tr>
<tr>
<td>autoresize=&quot;false&quot;</td>
<td>no</td>
<td>true</td>
<td>Automatically adjusts the video size if the video would extend beyond the size of the container.</td>
</tr>
<tr>
<td>valignment=&quot;[top</td>
<td>middle</td>
<td>bottom</td>
<td>baseline]&quot;</td>
</tr>
</tbody>
</table>

**Video container for multiple videos**

**The <evlplayer> tag**

Using the tag <evlplayer> and the parser function #evl, you can play multiple videos with one video player.
Play multiple videos in one player

A default video can be loaded using defaultid:

<evlplayer id="player1" w="480" h="360" service="youtube" defaultid="mCtmECVnrOM" />

**Attributes for tag `<evlplayer>`**

<table>
<thead>
<tr>
<th>attribute</th>
<th>required</th>
<th>default</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>no</td>
<td>default</td>
<td>An optional unique identifier for this container.</td>
</tr>
<tr>
<td>w</td>
<td>no</td>
<td>800</td>
<td>Width to send to the embedded player when its generated.</td>
</tr>
<tr>
<td>h</td>
<td>no</td>
<td>16:9 ratio is achieved by the width setting</td>
<td>Height to send to the embedded player when its generated.</td>
</tr>
<tr>
<td>class</td>
<td>no</td>
<td></td>
<td>Additional CSS class to add to the container div style no</td>
</tr>
<tr>
<td>style</td>
<td>no</td>
<td></td>
<td>Additional in-line CSS to apply to the container div.</td>
</tr>
<tr>
<td>defaultid</td>
<td>no</td>
<td></td>
<td>Video ID of default video, if you want a default video.</td>
</tr>
<tr>
<td>service</td>
<td>no</td>
<td></td>
<td>Service of default video, if you want a default video.</td>
</tr>
</tbody>
</table>
Adding video links

Use the parser tag `{{#evl}}` to define the videos that should be passed to the player:

```
{{#evl:<video id>|<Link text>|<video to play>|service=youtube|player=<player id>}}
```

Example:

```
{{#evl:mCtmECVnrOM|Departure to Mars|player=example-player}}
```

In addition to the attributes for the tag `#evt`, there are some additional attributes available for the `#evl` tag.

### Attributes for parser tag `#evl`

<table>
<thead>
<tr>
<th>attribute</th>
<th>required</th>
<th>default</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>video id</td>
<td>yes</td>
<td>none</td>
<td>The ID of the video you would like to play.</td>
</tr>
<tr>
<td>link text</td>
<td>yes</td>
<td>none</td>
<td>The text to display inside the link.</td>
</tr>
<tr>
<td>player</td>
<td>no</td>
<td>'default'</td>
<td>Player container to load video in. Note that the ID 'default' will only exist if you've defined a player with no ID.</td>
</tr>
</tbody>
</table>

Example

```
<evlplayer w="600" id="example-player">
    default content
</evlplayer>
{{#evl:OLeWbRdW6rY|Let eet Go|1|player=example-player}}
{{#evl:mCtmECVnrOM|Departure to Mars|2|player=example-player}}
{{#evl:MLIE2642neg|ISS - Life in the space station|3|player=example-player}}
```

### Embedding local videos

Videos that have been uploaded to the Wiki can also be embedded in source editing mode. This can also be done using the extension BlueSpicePlayer. BlueSpicePlayer has no functions to embed external videos, however.

The two extensions have the following differences when embedding local video files:
<table>
<thead>
<tr>
<th>Syntax /Parameter</th>
<th>EmbedVideo</th>
<th>BlueSpicePlayer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syntax</td>
<td>corresponds to the syntax of embedding image files:</td>
<td><a href="">bs:showtime</a>samplename.mp4&lt;/bs:showtime&gt;</td>
</tr>
<tr>
<td></td>
<td>[[File:samplename.mp4]]</td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>Only the width can be defined. The video fills the entire width of the player container:</td>
<td>Width and height can be defined separately. If the width of the video is smaller than the video container, the canvas is filled in black.</td>
</tr>
<tr>
<td></td>
<td>[[File:samplename.mp4</td>
<td>600px]]</td>
</tr>
<tr>
<td>Loop</td>
<td>-</td>
<td>&lt;bs:showtime repeat=&quot;yes&quot;&gt;&lt;/code&gt;</td>
</tr>
<tr>
<td>Autostart</td>
<td>-</td>
<td>&lt;bs:showtime autostart=&quot;yes&quot;&gt;&lt;/code&gt;</td>
</tr>
<tr>
<td>Star/End</td>
<td>[[File:samplename.mp4</td>
<td>start=2</td>
</tr>
<tr>
<td></td>
<td>Time can be added as: ss, mm:ss, hh:mm:ss</td>
<td></td>
</tr>
<tr>
<td>HTML-Output</td>
<td>embedded as &lt;video&gt; tag</td>
<td>embedded through nested &lt;div&gt; tags</td>
</tr>
<tr>
<td>Adjusts to mobile display</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Player controls</td>
<td></td>
<td></td>
</tr>
<tr>
<td>play button</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>progress bar</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>volume adjustment</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>fullscreen mode</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>picture-in-picture</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
Supported video services

The following video services are supported by the extension EmbedVideo. In parentheses, you find the service names that are used with the tags #evt and #ev:

Archive.org Videos (archiveorg), Bambuser (bambuser), Bing (bing), Blip.tv (blip), C3TV (mediaccde), CollegeHumor (collegehumor), Dailymotion (dailymotion), Disclose.tv (disclose), Daum TVPot (tvpot), DivShare (divshare), Facebook (facebook), FunnyOrDie (funnyordie), Gfycat (gfycat), Hitbox (hitbox), JW Player (jwpplayer), Kickstarter (kickstarter), Metacafe (metacafe), Microsoft Stream (microsoftstream), Mixer (mixer), Nico Nico Video (nico), RuTube (rutube), SoundCloud (soundcloud), Spotify Album (spotifyalbum), Spotify Artist (spotifyartist), Spotify Song (spotifytrack), TeacherTube (teachertube), TED Talks (ted), Tubi TV (tubitv), Tudou (tudou), Twitch (twitch), Videomaten (videomaten), Vimeo (vimeo), Vine (vine), Yahoo Screen (yahoo), YouTube (youtube), YouTube Playlist (youtubeplaylist), YouTube Video List (youtubevideolist), Youku (youku)

Related info

- Mediawiki help page for the extension EmbedVideo
- Help page for the extension BlueSpicePlayer - only for video files that have been uploaded to the wiki
- Template to embed video using the Visual Editor toolbar

Emoticons

Emoticons are converted to small smiley images that are rendered in view mode. BlueSpice has a list of emoticons, or smilies, coming from chat jargon. These can enhance communication by expressing things like irony, for example. If a user adds a smiley to an article, this is transformed into an image.
Using emoticons

The following sequences of symbols are transformed into emoticons. Here is the list of BlueSpice smilies where you see the sequence of symbols, then the name of the image, then the image and a short description:

:-| neutral.png neutral, sceptical
:-@ angry.png angry, annoyed
;-( sad.png sad
:-) wink.png winking, ironic
:-D smile-big.png laughing
:-/ thinking.png thinking
:-X shut-mouth.png sealed lips
:'( crying.png crying
:-O shock.png shocked, surprised
:-S confused.png undecided, confused
:lol: laugh.png laughing
8-) glasses-cool.png cool, sunglasses
(:| yawn.png yawning
:good:good.png good, thumbs up
:bad: bad.png bad, thumbs down
:-[ embarrassed.png embarrassed, blushing
[-X shame.png ashamed

Note: Emoticons cannot be used directly at the start of a line! This could otherwise lead to conflicts with other wiki markup e.g. indents or lists which start with : or ;. Therefore, always leave a space before an emoticon.

Related info

- Reference: BlueSpiceEmoticons

Export tables

ExportTables allows exporting tables and grids on wiki pages to Excel formats.
## How to export a table

Any regular table that is insert on a page can be exported. Before table export is possible, the table must be configured to support exporting.

### In VisualEditor

While editing a page in VisualEditor, click on the table and select **Properties**. In the dialog that is opened, activate the option **Exportable**.
In Wikitext

A table can be set to be exportable in wikitext as well. Add the classes “bs-exportable” and "exportable" to the table's "class" argument.

```wikitext
{| class="wikitable bs-exportable exportable"
|+...
```

After saving the page, all users viewing the page can export the table by right-clicking on the table and selecting an export format.

Formats

Formats that are offered for exporting a page are:

- CSV - Comma separated values
- XLS - Microsoft Office Excel 2003
- XLSX - Microsoft Office Excel
Exporting data from grids

In addition to exporting the tables on pages, most of BlueSpice managers and other extensions that display tabular data also allow exporting of data. Exporting such data is done over the "Export table" menu in right top corner of the managers like the Namespace manager.

Exporting tables in management grids
Manual: Extension/WebDAV

With the BlueSpice WebDAV integration you can open, edit and save files from your wiki directly in their native applications. After saving, the files are automatically updated and versioned in the wiki.

### Contents

1 Editing options ......................................................... 135
2 Open a file via the browser ............................................................ 136
   2.1 Associating file types with their applications ........................................ 136
   2.2 OpenDocument files ......................................................... 136
3 Open a file via Windows Explorer ..................................................... 136
   3.1 Edit a wiki page .............................................................. 137
      3.1.1 Subpages ................................................................. 137
   3.2 Open a file ................................................................. 137
   3.3 Additional file actions ......................................................... 137
4 Summary .................................................................................. 138
5 Related info ............................................................................. 138

### Editing options

With WebDAV, you have two editing options for files:

1. Open the file in the wiki and edit it in the Office application
2. Open the file using your local file explorer (for example, Windows Explorer) and edit it in the Office application. This requires a connection between the WebDAV server and your local file explorer. The wiki file directories are then mapped like a network drive.

With WebDAV you can work on OpenDocument files or Microsoft Office files such as Word, Excel or PowerPoint in their associated programs. You can also exchange image formats such as jpg, gif or png and PDF files directly with the wiki via your WebDAV connection.

The supported file formats also depend on your wiki configuration.
Open a file via the browser

To open a file directly from the wiki, hold down the control key and right-click on a file link to open the context menu. If the browser context menu is displayed instead of the wiki context menu, simply click with the right mouse button without holding down the control key. You can adjust this behavior in your settings under Appearance > Context menu.

After saving the file, you can see the latest version on the file page.

Associating file types with their applications

When you open a file for the first time via the context menu, you may have to associate the necessary application and the file type in your browser. For example, Excel may not open here if you have never opened an Excel file in the browser. However, this changes after you have linked the Excel file extension with the Excel application.

If you then get an error message in Excel, go to the browser settings and change the application for the content type ms-excel to Standard (this is the procedure for Firefox as an example). The file can then be opened and edited directly in Excel.

OpenDocument files

OpenDocument files are linked to the corresponding Microsoft Office applications and are opened there by default. You can change your browser settings and associate the ms-word content type with LibreOffice. Afterwards, both OpenDocument text documents and Microsoft Word documents are opened in LibreOffice.

Open a file via Windows Explorer

With WebDAV, you can also open a file on the wiki in your Windows Explorer. You simply need to specify the wiki as a network drive. These are the necessary steps under Windows 10:

First you need your personal WebDAV path. Go to your Preferences, tab User profile. If you don't see the WebDAV path here, contact your wiki administrator.

1. Copy your personal WebDAV URL from your user preferences page.
2. Open Windows Explorer.
3. Right-click This PC> Map Network Drive.
4. Paste the URL from your clipboard into the text field and select a free drive of your choice. For example W for Wiki. Make sure that you did not paste any spaces at the beginning of the URL. Make sure to remove them.
5. Click Finish.
6. Type in your wiki username and password. This is only necessary if you use your own wiki password. If your wiki uses single sign-on or LDAP for authentication, you will not be asked for a password at this point.

You can then rename the network label if you like.
Edit a wiki page

Now you see the namespaces to which you have view permissions in the wiki. The Pages folder contains all wiki pages in the main namespace, for example the start page. The pages have the file extension `.wiki`. In theory, you can change a wiki page locally and then save it. To do this, select a simple text editor and edit the page content in wikitext format. The changes are automatically displayed live in the wiki. The version history of the page indicates that this version was edited via WebDAV.

When you open a file from the file page, you can left-click or right-click to open the file. Right-clicking opens the file via WebDAV and saves it directly to the wiki. A left-click also opens the associated application immediately. But here, the file is saved as a local file and you need to manually save the file back to the wiki. You can either save the file locally and manually upload it back into the wiki, or you can save the page directly in the wiki via WebDAV in Windows Explorer.

Subpages

If you create a subpage in the wiki, it is displayed in Windows Explorer in a subfolder that is named after the parent page.

In general, it makes more sense to edit wiki pages directly in the wiki, since they can be edited more comfortably in visual editing mode. There, you also have access to important meta information, for example whether a page is locked for editing or whether other users are currently editing the page.

Open a file

Uploaded images and documents are located in the folder `Media`. This directory lists all files that you can now edit locally using an Office application to then save them directly in the wiki. If the extension `NSFileRepo` is installed in your wiki, you see the uploaded files organized in folders. These folders correspond to the namespace associations of the files in the wiki.

The files without a specific namespace association, that is the files in the main namespace, are located in the folder `Main`.

From here you can edit and save a Powerpoint file, for example. It is versioned directly in the wiki.

As an alternative, you can open the file directly with a left-click from the file page. The file is now saved locally and you have to manually save file back to the wiki using Windows Explorer. You have to make sure that you save the file back into the correct namespace and with the original filename. In the wiki you will see the updated version entry with a WebDAV comment.

Additional file actions

- **Uploading files**: With WebDAV, you can also quickly upload multiple files to the wiki. Simply copy the files from the source location to their target folder in Windows Explorer.
- **Create a wiki page**: You can also create wiki pages. Simply create a page with the extension `.wiki` in the editor. Make sure that you are not creating a text file with the extension `.txt`, but a file with the extension `.wiki`.
- **Delete**: Pages that are deleted via WebDAV are marked accordingly in the delete log.
Copy: It is also possible to copy a document into a different namespace, because documents and wiki pages can exist in different namespaces with the same file name.

Move/rename: If you try to rename a wiki page or a file using Windows Explorer in the same folder or if you want to move it to a different namespace, you will receive an error message. In this case, moving or renaming a page must be done by moving the page directly on the wiki.

Summary

- With WebDAV, office documents in the wiki can be edited directly in their native applications so that you don't have to manually download and re-upload them.
- Files are versioned accordingly and the version is marked as a WebDAV change.
- Files can be opened from the browser or from Windows Explorer.
- Wiki pages should not be edited using a text editor. They are better suited for direct browser editing.
- Files that are deleted from Windows Explorer can be tracked in the delete log.
- Files that are added from Windows Explorer can be tracked in the upload log.

Related info

- Reference:WebDAV

Filtering tables

FilterableTables applies a filterable and sortable table layout to regular content tables in wiki articles.

Contents

<table>
<thead>
<tr>
<th>Number</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Setting the filter option</td>
<td>138</td>
</tr>
<tr>
<td>1.1</td>
<td>Using VisualEditor</td>
<td>138</td>
</tr>
<tr>
<td>1.2</td>
<td>Using Wikitext</td>
<td>139</td>
</tr>
<tr>
<td>2</td>
<td>Filtering tables</td>
<td>140</td>
</tr>
<tr>
<td>3</td>
<td>Related info</td>
<td>140</td>
</tr>
</tbody>
</table>

Setting the filter option

To create the table filter, the CSS class "filterable" is added to the table.

Using VisualEditor

In edit mode, click on the table to open the options popup and click on "Properties". In the dialog that opens, toggle on "Filterable" option.
Using Wikitext

In source-editing mode, add the class "filterable" to the table header.

```wikitext
{| class="wikitable filterable"
|+ !Heading 1
| !Heading 2
| !Heading 3
| !Heading 4
|--
|[cell] 1
|[cell] 2
|[cell] 3
|[cell] 4
|--
|[cell] 5
|[cell] 6
|[cell] 7
|[cell] 8
|--
|[cell] 9
|[cell] 10
|[cell] 11
|[cell] 12
|
```
Filtering tables

The special filter layout of a table is only applied in view mode.

To filter the values in the table, click on the header of the column to filter and select "Filter" from the dropdown menu. In the input field that opens, type in the filter text.

Note: Any table styles that are applied by the table class are ignored as long as the value "filterable" exists in the class rule. A filterable table comes with its own table styling.

Related info

- Reference:BlueSpiceFilterableTables

Insert a file
How do I upload a file?

PDF, xls, docx, ... Files in common formats can easily be uploaded to your wiki with VisualEditor and at the same time inserted into a wiki page. You can find out which file types are allowed in your wiki on the page Special:Upload in your wiki.

In VisualEditor, select the menu item "Insert > Media":

The dialog window "Media Settings" opens. Here, you can connect files with namespaces and categories:
The system detects that it is not an image file and displays a corresponding paper clip as a file icon.

Now click "Upload":

![Upload dialog](image)

The general and advanced settings are largely identical to image files. However, there are differences in the linking options, as, for example, a PDF file is not displayed as an image directly on the page.
Special features when including files

There are three ways to link a file on a page:

- **Link this file (1):** The inserted link opens the file.
- **Link file description page (2):** The link leads to the file page on the wiki. There, you can view the file details or upload a new version of the file.
- **Embed this file (3):** The link inserts a preview image. The preview image opens the file description page when clicked. This only works with PDF and .tiff files.

**General Settings:** An alternative text is required if you embed the file on the page. This is done via the corresponding "Embed this file" button. Since a preview image is created here, the alternative text should be used just like with images.

If you link to the file or the file description page, VisualEditor will in both cases inserts the same link text, even though the link will lead to different pages. However, the displayed link text can be changed directly on the page. Just click into the text and change it accordingly.

**Note:** If you place a file link directly on already selected text, VisualEditor will replace the selected text with the file information. It is therefore advisable to insert a file link via VisualEditor when the cursor is located at a blank space.
Maximum file size

The maximum allowed file size cannot be configured in the wiki itself. The maximum allowed limit is defined on the server in the php.ini file in the PHP installation. The actual (possibly smaller) limit, however, is set in the BlueSpice installation in LocalSettings.php or another configuration file in the settings.d folder. The default setting is 32 MB.

Contact your wiki administrator if you receive an error message when trying to upload a larger file.

Related info

- Manual:Extension/BlueSpiceInsertFile

Insert links

Linking pages is an important feature of browser-based knowledge documentation. The links often differ in their function. Links connect wiki pages with:

- other wiki pages
- external websites
- files (images, PDF files, Word documents,...)
- files stored on other drives

How do I create links?

Use the Insert link menu item in VisualEditor or use the shortcut Ctrl+K. In both cases, a dialog box opens.

Contents

1 How do I create links? .......................................................... 144
2 Link to a wiki page ............................................................... 145
3 Link to an external website .................................................... 145
4 Link to a file ........................................................................ 146
5 Related info .......................................................................... 147
Link to a wiki page

Internal links connect related pages or other content that provides more information. Page names can exist multiple times in different namespaces. Therefore, under **Search pages**, enter the namespace if the destination page is not in the same namespace as the current page.

If you have selected some text on the page, you will find some page suggestions already listed in the **Search pages** tab. Here, you can adjust the search term accordingly or create a link to a new page.

Then click on **Done**.

In the source text, links are created with the following structure:

- **Link to a wiki page**: `[[landing page name|caption]]`
- **Link to a wiki page in another namespace**: `[[namespace:landing page name|caption]]`
- **Link to a category page**: `[:Category:category name|caption]` To create a link to a category, the source code is preceded by a colon before the category name. In contrast, the link "Category: BlueSpice" would create a category called BlueSpice instead of linking to the category BlueSpice.
- **Interwiki link**: `[[Imdb:tt2709692]]` If your wiki links to other wikis, you can use the tab **Search pages** also to directly link to a page in a related wiki. For example, if your administrator maintains an interwiki link for the IMDB movie database, it can be typed in as in the example above. Ask your administrator which interwiki links are available in your wiki.

Link to an external website

To link to an external website, mark text on your page, e.g. the word "Wikipedia". Press Ctrl+K and switch to the tab **External link**. There you enter the web address. Then click **Insert**.
Note: To easily maintain external links on your wiki, use the page Special:LinkSearch. This page allows you to search for external links in your entire wiki. The page also contains a link to the associated Mediawiki help page.

Link to a file

To link a file (for example, a picture or a PDF file) in the current page, go to the Link to File tab. There, you can search for a file or upload a new file.

- **Search for a file in the wiki and include it as a link:** Enter the file name and select the desired file. Then click on "Paste". A link to the file has been added to the page. You can then change the displayed link text.
- **Link file to a network drive:** If you want to connect to a file on your company network, enter the path under "Link to file" in the text field and activate "Network share path (URI)". The file path is entered using the following syntax - `[[file:///Z:/myfolder/vacatio]]`. This only works if your wiki has been configured to work with network files. This function also depends on your individual browser security settings.
Related info

- Reference:BlueSpiceInsertLink
- Manual:VisualEditor

Insert tags and magic words

The extension **InsertMagic** provides a dialog for inserting Magic Words in the **visual editor**.

### Contents

1. Inserting magic words .......................................................... 147  
2. Related info ................................................................. 148  

Inserting magic words

In edit mode, click on **Insert** in the editor toolbar and select **Magic word** from the dropdown menu.
Once the magic word is selected in the list on the left, a description, including usage examples, will appear on the right.

After saving the dialog, further parameters can be set for the selected magic word or tag.

Related info

- Category tree
- Checklists
- Count things
- Drawio
- Page access
- Sign here
- Smartlist
- Tag cloud
- Tag search
- Reference:BlueSpiceInsertMagic

Page access restrictions
BlueSpicePageAccess restricts access to a page to specified user groups. It is inserted with the tag \texttt{pageaccess}. Access restriction per page is done on a group basis. "Access" here means all actions, including read and edit.

### Contents

1. How to restrict access to a page ................................................................. 149
2. Related info ............................................................................................... 150

---

## How to restrict access to a page

Users who have the necessary permissions (by default through the roles \texttt{admin}, \texttt{maintenanceadmin}, and \texttt{structuremanager}) can add the necessary instruction to a page.

**To add this tag with VisualEditor:**

1. **Position** the cursor at the beginning of your page.
2. **Select** Insert > Magic word.
3. **Select** Page access in the dialog box.
4. **Click** Done.
5. **Add** the groups to the Page access dialog box.
6. **Click** Insert.

![Inserting the magic word PageAccess](image)

The page now displays an info header that shows the groups that have access to the page.
In source view, the tag looks like this:

```xml
<bs:pageaccess groups="sysop" />
```

To add more groups, use commas to separate:

```xml
<bs:pageaccess groups="sysop,secure1,secure2" />
```

A user can only restrict access to the groups this user belongs to. This is a security feature to prevent users from locking themselves out of a page.

**Related info**

- Reference:BlueSpicePageAccess

**Unsaved changes (autosave)**

The extension **SaferEdit** automatically saves a page at predefined intervals.

**How it works**

Users can set in there preferences under the tab **Editing** if they want to see a warning message when they leave the page without saving pending changes. This setting is activated by default.
Additional functions

- **Recovery versions**: The recovery versions are saved for the user and are only available to this user. They are not, however, deleted when logging off and are available when the user logs on again.
- **Edit conflicts**: If the page is currently being edited by a user, a banner at the top of the page shows the user name of the editor.

Tips

SafeEdit is useful when you have just accidentally closed a browser tab without saving your changes. If, however, you leave the page intentionally, i.e. you have saved the page or clicked on “Cancel” and confirmed the dialog that you want to leave the page with unsaved changes, then the existing recovery versions are deleted and are no longer available.
Configuration

In the Config Manager, administrators can change the following settings:

- **Interval for lookup for concurrent editings**: Sets the time in seconds for checking if another person is editing the page.
- **Show name of current editor**: Shows or hides the name of the user who is currently editing the page.

Related info

- Reference:BlueSpiceSaferEdit

Upload multiple files

**MultiUpload** allows the simultaneous upload of multiple files to the wiki.

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Where to find BlueSpiceMultiUpload?</td>
</tr>
<tr>
<td>2 Using BlueSpiceMultiUpload</td>
</tr>
<tr>
<td>3 Standard MediaWiki upload</td>
</tr>
<tr>
<td>4 Related info</td>
</tr>
</tbody>
</table>

**Where to find BlueSpiceMultiUpload?**

If BlueSpiceMultiUpload is enabled on the wiki, it will replace the link for uploading files, which is located in the left navigation, under the **Global actions** tab.
Using BlueSpiceMultiUpload

Clicking the *Upload file* link in the left navigation opens the operating system's file manager. Multiple files can be selected.

After confirming the selection of files, a wiki upload dialog appears, in which additional data about files being uploaded can be added collectively:

- the namespace to upload to,
- the category to attach to the files,
- a description (will be the same for all files), and
- the license information
All settings are optional.

After configuring the settings, click Done to upload the file(s).

**Standard MediaWiki upload**

Even with BlueSpiceMultiUpload installed, the standard Mediawiki upload special page is still available and functional on Special:Upload.

**Related info**

- Reference:BlueSpiceMultiUpload

**Manual:VisualEditor**

BlueSpice uses the MediaWiki extension VisualEditor as editing tool. This sophisticated editor supports all common edit tasks that you can expect in a wiki environment.

### Contents

1. **Text editing** .......................................................................................................................... 155
2. **Shortcuts** .................................................................................................................................. 155
3. **Inserting other content** ........................................................................................................... 156
Text editing

Typical text formatting options such as **bold**, *italics*, or *text color* are available as a context menu. When you highlight text, a menu with common formatting elements appears. For example, you can apply a different text color.

![Applying text color](image)

Shortcuts

If you want to apply multiple formatting options at the same time, shortcuts are often the quickest way. For example, to show text in bold and italic, highlight the text and press `Ctrl+b` (for "**bold**") and `Ctrl+i` (for "*italics*"). Even a link can be quickly inserted by pressing `Ctrl+k`. Pressing `Ctrl+b` again will cancel the bold. Multiple formats can be removed after text selection with `Ctrl+m`.

All available keyboard shortcuts are marked accordingly in VisualEditor next to each menu item.
Inserting other content

Many typical page elements such as images, files and tables can be integrated into your page from the Insert menu.

If you want to learn more about inserting these elements, go to the following help pages:

- Images
- Files (PDF, xls, doc, ...)
- Tables
- Templates

Wiki-specific content

Some functions in the "Insert" menu are little known from traditional word processing, but are quite typical for working with a wiki. Therefore, they are briefly introduced here. Find more information on the help pages here in the helpdesk or at mediawiki.org:

- **Comment**: Add comments to the page. These are only visible in the source code.
- **Gallery**: A simple picture gallery can support many process flows.
- **Magic word**: Wiki features such as signature, word counter, category tree or even process diagrams with draw.io can be integrated as a "magic word".
- **Your signature**: Only works on pages that allow signatures. Pages in the Namespace "Pages" are not included.
- **Codeblock**: Programming code is displayed here in clean code blocks, optionally with line numbers.
- **References list**:
- **Chemical formula**:
- **Math formula**: An editor opens for entering a mathematical formula.

Switching between edit modes

When creating or editing a page, the page loads in visual editing mode. If you are familiar with the code language of MediaWiki ("Wikitext"), you can easily switch to source editing mode using the "Switch editor" button:
MediaWiki reference

Since VisualEditor is a standard MediaWiki extension, you can also read a documentation of functionality on MediaWiki. Here in the BlueSpice Helpdesk, we only give some hints and tips for using the editor.

Hints and tips

VisualEditor is optimized for editing web pages. That's why it has exactly the features that are often needed to create a wiki page. The consistent formatting of content supports the readability of your wiki content.

Text formatting

<table>
<thead>
<tr>
<th>Text formatting</th>
</tr>
</thead>
</table>
| **Undo function** | Left arrow: Undo last action (greyed out: there is no last action yet)  
Right arrow: Restore last action (greyed out: there's nothing to restore yet) |
| **Format Paragraph** | Here text can be defined as heading or specific paragraph type. *Note:* If you work in a **table**, the options will change accordingly (content cell and header cell): |
| **Style text** | If no text has been selected before clicking on the "A" button and on a button, the text will be formatted from the current position of the cursor.  
| **Insert hyperlink** | If no text was selected before the hyperlink dialog was opened, the link will be generated with a number:  
[1] To subsequently change the hyperlink description, just click on the link to open the edit menu. In a table, you may need to double-click the cell first and then click the hyperlink again. |
## Text formatting

<table>
<thead>
<tr>
<th>cite</th>
<th>The citation menu is used to insert references (also called itemizations or footnotes) within the text.</th>
</tr>
</thead>
</table>

## Insert special content

### Paste Special Content

<table>
<thead>
<tr>
<th>Insert menu</th>
<th>Use the &quot;insert&quot; menu to insert various media (images, videos) and text formats:</th>
</tr>
</thead>
</table>
| media       | Inserting pictures and videos

(Details on MediaWiki)

<table>
<thead>
<tr>
<th>templates</th>
<th>Include a template in the page.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>tables</th>
<th>Tables are an important tool for formatting tabular page content.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>comment</th>
<th>Comments are not visible to readers, but only in edit mode. A comment can be inserted anywhere on a page. The comment can be edited by clicking on it. And this is what a comment looks like:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Gallery</th>
<th>Galleries are a way to display multiple images on a page.</th>
</tr>
</thead>
</table>
### Paste Special Content

<table>
<thead>
<tr>
<th>Help category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Magic word</strong></td>
<td>With a &quot;magic word&quot; you can include certain variables or so-called behavioral switches in your page. For example, you can display the word count:</td>
</tr>
<tr>
<td>![Magic word icon]</td>
<td>Learn more about the function <a href="#">Magic Word</a>.</td>
</tr>
<tr>
<td>![Magic word example]</td>
<td><strong>Overview of all</strong> <a href="#">Magic Words in the visual editor</a>.</td>
</tr>
<tr>
<td><strong>Your signature</strong></td>
<td>This option can only be used in discussions. It allows to add a signature at any point of a discussion.</td>
</tr>
<tr>
<td>![Signature icon]</td>
<td></td>
</tr>
<tr>
<td><strong>Code block</strong></td>
<td>With code block various code examples can be entered, like e.g. in HTML syntax. The code is then displayed properly formatted:</td>
</tr>
<tr>
<td>![Code block icon]</td>
<td><code>&lt;span style=&quot;color: red&quot;&gt;red text&lt;/span&gt;</code></td>
</tr>
<tr>
<td><strong>References list</strong></td>
<td></td>
</tr>
<tr>
<td>![References list icon]</td>
<td></td>
</tr>
<tr>
<td><strong>Chemical formula</strong></td>
<td></td>
</tr>
<tr>
<td>![Chemical formula icon]</td>
<td></td>
</tr>
<tr>
<td><strong>Math formula</strong></td>
<td>It opens an editor for entering a mathematical formula.</td>
</tr>
<tr>
<td>![Math formula icon]</td>
<td><a href="#">info on MediaWiki</a></td>
</tr>
<tr>
<td><strong>Special Characters</strong></td>
<td></td>
</tr>
<tr>
<td>![Special characters icon]</td>
<td></td>
</tr>
</tbody>
</table>

### Page Options

<table>
<thead>
<tr>
<th>Help category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options menu</strong></td>
<td>The options menu allows editing of all page settings.</td>
</tr>
<tr>
<td>![Options menu icon]</td>
<td></td>
</tr>
<tr>
<td>Page Options</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Options</td>
<td>This button allows the page settings and page information to be updated simultaneously within a dialog box.</td>
</tr>
<tr>
<td>Categories</td>
<td>Here you assign the page to one or more categories. The page will appear accordingly on all linked category pages.</td>
</tr>
<tr>
<td>Page Settings</td>
<td>Page redirection: When the page is redirected, the content of the page is no longer displayed, but the target page is loaded directly. This setting can also be used to display or remove the table of contents at the top of the page. The table of contents is automatically generated by the headings on the page. When a page has more than three headings, the table of contents appears automatically by default.</td>
</tr>
<tr>
<td>Advanced Settings</td>
<td></td>
</tr>
<tr>
<td>Languages</td>
<td></td>
</tr>
<tr>
<td>Templates used</td>
<td></td>
</tr>
<tr>
<td>View as right-to-left</td>
<td>Support for languages that are read from right to left. Clicking this button right-side formats the page text. Click again to set the text flush left.</td>
</tr>
<tr>
<td>Find and replace</td>
<td>Words or characters can be searched and replaced directly on the page. The &quot;Undo&quot; button can be used to cancel the change.</td>
</tr>
</tbody>
</table>
Troubleshooting: Visual editing is disabled

If you only see code editing, please contact an administrator of your wiki. The following settings must be checked in this case:

- Global settings via the configuration manager
- Namespace management settings
- Parsoid service on the server

VisualEditor: Insert Images

How to insert an image on a page

In addition to text, images are probably the most important components of typical content pages. With VisualEditor, the images can be uploaded, inserted and formatted all in one step. Images are inserted via the menu item Insert > Media.

The dialog box Media Settings opens.
After uploading, you can edit the image settings: Details, General Settings, and Advanced Settings.
Here you can assign a namespace and categories to a picture.

- **Target namespace:** The picture can be assigned directly to a namespace. The access rights of the namespace are also applied to the image. This means that only users with access to the namespace can view the image on the wiki.
- **Name:** Choose a name that makes it easy to find the image later during an image search. Or simply leave the current file name.
- **Description:** The description is mainly useful for photos or infographics when the image name does not adequately describe the image content.
- **Categories:** Here, the picture can be assigned to categories.

**Error message when saving:** If the image already exists, an error message is displayed. If you want to overwrite the existing file, you can click on the file name and overwrite the file via the image page in the wiki. This is done by clicking the "Upload a new version of this file" link in the "File Versions" section. In VisualEditor itself overwriting an image does not not work.
In the general settings, the image descriptions are added.

**Caption:** The caption is shown with framed images and thumbnails. Note: If you change an image to frameless and then back to "framed", you need to re-enter the caption.
Alternate text: The alternate text should be entered for each image since it replaces the image in certain contexts. For example, this so-called "alt" text is used by users who work with screen readers. Screen readers are used by users with visual limitations, but search engines can also read this text. In some business areas, the indication of the “alt” text is also required by law. If you are not sure, ask your company accordingly.

Advanced settings

In the advanced settings, you can set the position and image size.

The following settings are possible:

- **Position:**
  - Wrap text around this item:
    - *Left*: The image is displayed on the left side of the text, starting on the first line of the current paragraph.
    - *Center*: The image is displayed centered over the current paragraph.
    - *Right*: The image is displayed to the right of the text, starting on the first line of the current paragraph.

- **Image type:** If you insert an image with VisualEditor, the image is usually linked to the Media Viewer. To suppress the link on an image, you must add an empty link attribute to the image tag in the source code:
  - frameless picture with link (standard): `[[File:adult-chair-company-380769.jpg|frameless]]`
  - frameless picture without link: `[[File:adult-chair-company-380769.jpg|frameless|link=]]`
<table>
<thead>
<tr>
<th>Image type</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thumbnail</td>
<td><img src="image_url" alt="Thumbnail Image" /> <strong>This is the caption</strong></td>
<td>The preview picture shows the image with a standard width of 300px. The width can be adjusted as required. In addition, the caption is displayed below the picture. A preview icon indicates that the image can be viewed in a larger size.</td>
</tr>
<tr>
<td>Frameless</td>
<td><img src="image_url" alt="Frameless Image" /></td>
<td>The frameless version shows the picture without a frame. The width can be adjusted as required (here we set the example to 300px). The caption does not appear below the picture. By default, the image is inserted without text wrapping. It will break up a</td>
</tr>
</tbody>
</table>

**Help categories**

- Export: 18.10.2020
- This document was created with BlueSpice
<table>
<thead>
<tr>
<th>Image type</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame</td>
<td><img src="image1.png" alt="Frame Image" /></td>
<td>The framed version is similar to the preview picture. Compared to the preview, the magnifying glass symbol is not displayed and the image is inserted on the page full-size. The size cannot be adjusted.</td>
</tr>
<tr>
<td>Basic</td>
<td><img src="image2.png" alt="Basic Image" /></td>
<td>The basic version is like the frameless version. By default, text does not wrap, but the text is separated at the point where the image was inserted. The image is inserted in full width, while the frameless image is...</td>
</tr>
</tbody>
</table>
### Image type

<table>
<thead>
<tr>
<th>Image type</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image.png" alt="Image" /></td>
<td>inserted in miniature image width (300px). The size can be adjusted.</td>
</tr>
</tbody>
</table>

- **Image size:**
  - *Standard:* sets the image width to 300px (unless the standard width has been changed in the user preferences).
  - *Custom:* allows setting a custom size.
  - *Make full size:* resets the size to the actual image size.

### Images and namespaces

You can save pictures and files in the general namespace (pages). If pictures should be accessible by all users, you can save these pictures in the main namespace if other namespaces have access restrictions. If you have created additional namespaces, you can also save images in these namespaces if you have the necessary access rights. Images are then only shown to users who have the necessary read permissions in these namespaces.

In the upload dialog, the namespace field always suggests the namespace of the current page for the image upload.

### Changing an embedded image

- **Different image:** In the editing mode of the page, it is possible to edit the image with a double-click. Use the “Change image” button to exchange the image with a different image.

- **Same image with different version:** If you want to use a new version of the same image, open the "Special:Upload file“ page in a new browser tab (so that you don't lose any changes on your wiki page). There, you can save already existing pictures with the same name again. The original image is kept as a version.

### Assign categories

*InsertCategory* enables viewing and editing category assignments for a page.
Assigning categories

Title section

Categories can be assigned to a page directly from the title section in view mode. Any user with edit rights can click on the tag-icon above the page title to edit the category assignments.

Page information flyout

The page categories can also be managed from the Page information flyout in the quality management tools.

To add or remove categories, hover over the this section and click the edit button.

Possible actions:

- Save: Saves the categories in the input field.
Help categories

- **Cancel:** Closes the category field without making any changes.
- **Remove all:** Removes all assigned categories from the page.

**File upload dialog**

Categories can be assigned to a file during the file upload. If more files are uploaded simultaneously, the same categories will be applied to all files. Select the categories using the arrow icon or the icon for the hierarchical category tree.
Category manager

To manage categories on the wiki level, use the Category manager page.

Source editing

You can also add to add categories directly in source editing mode.

Configuration

In the Config manager, you can change the following settings:

- Insert category with its parents
- Set page categories as default in upload dialog

Related info

- Reference:BlueSpiceInsertCategory
BlueSpice layout

Your wiki is divided into several unique areas that group the features of the wiki in a meaningful way. Here we give you an overview so that you can easily find the functionality that you are looking for.

Note: Some features are disabled by default in your wiki or only visible to specific user groups such as administrators.

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Custom menu</td>
<td>A wiki administrator can create custom navigation to pages inside and outside the wiki.</td>
</tr>
<tr>
<td>2-Main toolbar</td>
<td>Contains important elements such as the logo area, the search field and access to the user profile.</td>
</tr>
<tr>
<td></td>
<td>The &quot;heart&quot; of the page organization. From here, users can access all pages,</td>
</tr>
</tbody>
</table>
### Layout area | Description
--- | ---
3- Navigation | Depending on their permissions. Many navigation elements can be customized.
4- Content area | Here you create and edit all wiki content. Discussions are also located in this space.
5- Page tools | Powerful page management features. This includes important tools for the quality management of a page.

### Custom menu

| Layout area | Description |
--- | --- |
1- Custom menu | With the extension BlueSpiceCustomMenu, a wiki administrator can create individual navigation to pages inside and outside the wiki.

### Main toolbar

| Layout area | Description |
--- | --- |
1- Logo area | The BlueSpice logo can be exchanged via the Config Manager with a company logo. |
2- Search field | You will search pages and files with a full-text and title search, as well as a fuzzy search. With search filter and search in the metadata. |
3- Edit page | A button that switches a page into edit mode. Only active for users with write access. |
4- Create page | A button for creating a new page or uploading a file. Only active for users with write access. |
5- User menu | Users manage their own settings and notifications here. The avatar icon indicates when unread notifications are waiting for the user. |
6- Language selector | In multilingual wikis, you can switch between the language versions of a page. |
7- Fullscreen toggle | Hides the navigation and page tools at the same time. |
8- Custom |
### Layout area | Description
--- | ---
menu toggle | Here you can hide and show the top menu.

### Navigation

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1- Main navigation</td>
<td>This is the general navigation. It can be customized by the administrator for the whole wiki.</td>
</tr>
<tr>
<td>2- Books</td>
<td>(optional): If you use the bookshelf extension, users can go to all general and individual books to which they have access.</td>
</tr>
<tr>
<td>3- My pages</td>
<td>This is your custom navigation bar. They can be adapted to your needs.</td>
</tr>
<tr>
<td>4- Global actions</td>
<td>Direct links to many special pages and administration pages (for administrators).</td>
</tr>
<tr>
<td>5- Navigation toggle</td>
<td>Shows and hides the navigation.</td>
</tr>
</tbody>
</table>
**Content**

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1-Title section</strong></td>
<td>In the title section of a page, the most important page information and page functions are put together in a user-friendly way.</td>
</tr>
<tr>
<td><strong>2-Work area</strong></td>
<td>In the workspace, users create and edit all page content. VisualEditor simplifies the editing process.</td>
</tr>
<tr>
<td><strong>3-Footer</strong></td>
<td>The footer contains links to legal information as well as to external MediaWiki websites.</td>
</tr>
</tbody>
</table>
Page tools

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Page tools</td>
<td></td>
</tr>
<tr>
<td>(a) Menu</td>
<td>Lots of page actions and information related to this page can be found here.</td>
</tr>
<tr>
<td>(i) Menu header</td>
<td></td>
</tr>
<tr>
<td>(ii) Menu link</td>
<td></td>
</tr>
<tr>
<td>2-QM tools</td>
<td>Lists all the important tools to manage the life cycle of a page, such as reminders and page reviews.</td>
</tr>
<tr>
<td>3-Tools toggle</td>
<td>A switch to hide and show the page tools.</td>
</tr>
</tbody>
</table>

BlueSpice layout

Contents

1 BlueSpice Layout ............................................................................................................................................. 177
BlueSpice Layout

Your wiki is divided into several unique areas that group the features of the wiki in a meaningful way. Here we give you an overview so that you can easily find the functionality that you are looking for.

Please note that some features are disabled by default in your wiki or only visible to specific user groups.

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Custom menu</td>
<td>A wiki administrator can create custom navigation to pages inside and outside the wiki.</td>
</tr>
<tr>
<td>2-Main toolbar</td>
<td>Contains important elements such as the logo area, the search field and access to the user profile.</td>
</tr>
<tr>
<td>3-Navigation</td>
<td>The &quot;heart&quot; of the page organization. From here, users can access all pages, depending on their permissions. Many navigation elements can be customized.</td>
</tr>
<tr>
<td>4-Content area</td>
<td>Here you create and edit all wiki content. Discussions are also located in this space.</td>
</tr>
<tr>
<td>5-Page tools</td>
<td>Powerful page management features. This includes important tools for the quality management of a page.</td>
</tr>
</tbody>
</table>

Custom menu
## Layout area

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Custom menu</td>
<td>With the extension BlueSpiceCustomMenu, a wiki administrator can create individual navigation to pages inside and outside the wiki.</td>
</tr>
</tbody>
</table>

## Main toolbar

![Main toolbar image](image)

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Logo area</td>
<td>The BlueSpice logo can be exchanged via the Config Manager with a company logo.</td>
</tr>
<tr>
<td>2-Search field</td>
<td>You will search pages and files with a full-text and title search, as well as a fuzzy search. With search filter and search in the metadata.</td>
</tr>
<tr>
<td>3-Edit page</td>
<td>A button that switches a page into edit mode. Only active for users with write access.</td>
</tr>
<tr>
<td>4-Create page</td>
<td>A button for creating a new page or uploading a file. Only active for users with write access.</td>
</tr>
<tr>
<td>5-User menu</td>
<td>Users manage their own settings and notifications here. The avatar icon indicates when unread notifications are waiting for the user.</td>
</tr>
<tr>
<td>6-Language selector</td>
<td>In multilingual wikis, you can switch between the language versions of a page.</td>
</tr>
<tr>
<td>7-Fullscreen toggle</td>
<td>Hides the navigation and page tools at the same time.</td>
</tr>
<tr>
<td>8-Custom menu toggle</td>
<td>Here you can hide and show the top menu.</td>
</tr>
</tbody>
</table>
Navigation

1-Main navigation
This is the general navigation. It can be customized by the administrator for the whole wiki.

2-Books
(optional): If the wiki uses the bookshelf extension, users can go to all general and personal books.

3-My pages
This is your custom navigation bar. It can be adapted to your needs.

4-Global actions
Direct links to many special pages and administration pages (for administrators).

5-Navgation toggle
Shows and hides the navigation.

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Main navigation</td>
<td>This is the general navigation. It can be customized by the administrator for the whole wiki.</td>
</tr>
<tr>
<td>2-Books</td>
<td>(optional): If the wiki uses the bookshelf extension, users can go to all general and personal books.</td>
</tr>
<tr>
<td>3-My pages</td>
<td>This is your custom navigation bar. It can be adapted to your needs.</td>
</tr>
<tr>
<td>4-Global actions</td>
<td>Direct links to many special pages and administration pages (for administrators).</td>
</tr>
<tr>
<td>5-Navgation toggle</td>
<td>Shows and hides the navigation.</td>
</tr>
</tbody>
</table>
## Content

### Layout area

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Title section</td>
<td>In the title section of a page, the most important page information and page functions are put together in a user-friendly way.</td>
<td></td>
</tr>
<tr>
<td>2-Work area</td>
<td>In the workspace, users create and edit all page content. Many wikis use VisualEditor to simplify the editing process.</td>
<td></td>
</tr>
<tr>
<td>3-Footer</td>
<td>The sidebar contains links to legal information as well as to external MediaWiki websites.</td>
<td></td>
</tr>
</tbody>
</table>
Page tools

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Page tools</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(a) Menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(i) Menu header</td>
<td>Lots of page actions and information related to this page can be found here.</td>
<td></td>
</tr>
<tr>
<td>(ii) menu link</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2-QM tools</td>
<td>Lists all the important tools to manage the life cycle of a page, such as reminders and page reviews.</td>
<td></td>
</tr>
<tr>
<td>3-Tools toggle</td>
<td>A switch to hide and show the page tools.</td>
<td></td>
</tr>
</tbody>
</table>

Books
The extensions **Bookshelf** and **BookshelfUI** expand the BlueSpice distribution, combining wiki pages into a structured book with chapter navigation. These books can also be printed as a PDF file with a cover page and a clickable table of contents.

---

**Contents**

1 Characteristics of books .......................................................................................................................... 182
2 Book manager ........................................................................................................................................... 183
3 Creating a book ......................................................................................................................................... 184
   3.1 Mass-adding pages ........................................................................................................................... 185
   3.2 Creating the chapter navigation ........................................................................................................ 186
4 Editing a book .......................................................................................................................................... 188
   4.1 Inserting meta data ........................................................................................................................... 188
   4.2 Adding a cover image ........................................................................................................................ 189
5 Exporting books ....................................................................................................................................... 189
   5.1 Configuration options for the book export ...................................................................................... 189
       5.1.1 BlueSpiceFlaggedRevsConnector ............................................................................................. 190
       5.1.2 BlueSpiceUEModuleBookPDF ................................................................................................. 191
6 Deleting a book ......................................................................................................................................... 192
7 Duplicating a book .................................................................................................................................... 192
8 Configuration ............................................................................................................................................ 193
9 Permissions ............................................................................................................................................... 194
10 Tipps for working with books ............................................................................................................... 194
11 Related info ............................................................................................................................................ 195

---

**Characteristics of books**

With BlueSpice Pro, you can assemble individual wiki pages into a book. In a book, you can read through a collection of pages in a linear fashion by moving through the book navigation. This is useful if you have lots of related pages that should be read in a particular order. And it makes it easy to write documentation and to comply with your documentation standards. All the books that are available on the wiki are accessible through the left navigation menu, tab "Books" with the book icon. Books are displayed as list or grid view. Clicking on a book opens the selected book. Once the book is opened, its chapter navigation appears in the left navigation.
Book manager

The menu item *Global Actions > Book manager* loads the page Special:BookshelfBookManager. Here, you can add a new book by clicking the *plus* button.

You can take the following actions on a book:

- **Editing a book** (1): Links to the Book editor where you can edit the book contents and metadata.
- **Duplicating a book** (3): Duplicates this book, including all the pages of the book.
- **Export** (4): Exports the wiki pages in this book to PDF.
- **Assign** (5): Assigns the book to designated users.

### Creating a book

To create a book:

1. **Go to** *Global actions > Book manager.*
2. **Select** the *Create (+) button.*
3. **Enter** a *Book title* and the *Type of the book:*
   - *General books*: Visible to all users. It should have a book navigation.
   - *Own books*: Books only visible to me.
4. **Click** *Done.*
After that, the book editor opens. Here you can add pages to your book by clicking the plus button. A dialog opens, where you can select the pages you want to add to your book. You can also enter the name of a page that doesn't exist yet.

Mass-adding pages

After clicking "Mass add", a dialog is opened. It contains different criteria for page selection:

- All pages of a category
- All subpages of a certain page
- From a page collection - page collections are lists of pages located in the MediaWiki namespace. They are usually created from search results.
- By a semantic property - pages can be selected based on the value of a certain semantic property.

After adding your book pages click Save at the bottom of the page. Now you have created a page in the namespace Book. It contains the list of pages that have been added to the book.
Important! Each wiki page can only be added to one book. If a page later is added to another book with chapter navigation, the page always leads to the chapter navigation of the book that last generated or updated its chapter navigation.

Creating the chapter navigation

After saving a book page, you have created a wiki page in the namespace Book which contains a list of links to the wiki pages in the book. The chapter navigation is generated separately.

To add the chapter navigation, go back to the book page in the book manager. Clicking on the book title opens the book page in the book editor. Scroll down to the Save button and select the drop-down arrow. Click Save and add book navigation to each wiki page.
This adds a bookshelf tag in the source code of all wiki pages that are part of this book. The tag, therefore, defines which book this page belongs to: `<bookshelf src="Book:EmployeeManual" />`.

Bookshelf tag in the source code

**Note:** If you later add more pages to a book, you have to generate the chapter navigation again. Without this step, the newly added pages will not have a bookshelf tag and therefore not be shown in the chapter navigation of the book. If you only added one or two new pages, you can also add the bookshelf tag manually to the source code of these new pages.
Editing a book

After you have created the book, click on the name of the book. This opens the *Book Editor*.

Editing a book is similar to creating a new book regarding adding pages to the book. Pages can also be removed from a book by right-clicking on the page name and selecting *Delete from book* (this will not delete the wiki page itself). Chapters - and the general book structure - can be re-arranged by dragging and dropping pages in the book structure. By dragging and dropping Page A over Page B, Page A will be placed underneath Page B in the book hierarchy.

### Book Editor: Employee Manual

- **Book Manager** (1): Link to the main *Book manager* page.
- **Show source wikipage** (2): Opens the book navigation page in view mode.
- **Edit source wikipage** (3): Opens the book navigation page in edit mode.
- **Add page** (4): Button for adding a page.
- **Remove page** (6): Removes the selected pages.
- **Manage metadata** (7): Add or remove metadata.
- **Export selection** (8): Exports the selected pages to a PDF file.
- **Book contents** (9): Shows all pages in the book hierarchy. Pages can be arranged by drag-and-drop. A multi-level organization is possible.

#### Inserting meta data

While editing a book (adding or removing pages), meta-data for the book can be added. To edit metadata, select top-most node of the book (first page) and click the wrench icon. A dialog will be opened where various meta-data can be added or removed. Some of the most important meta-data include:

- **Title**
- **Subtitle**
- **Author 1 and 2**
Adding a cover image

To add a cover photo for the book, add a metadata item *Bookshelf image*. Select this option from the dropdown and click *Add*. Once the metadata is added enter the name of the image in the value field. Any image currently uploaded to the wiki can be used. Type the name without the "File:" prefix (enter the image name and file extension).

Exporting books

You can export an entire book, individual chapters or single pages as PDF:

- Open the book in the book editor.
- Select all pages or chapters you want to export by clicking the associated checkboxes. Subchapters will be automatically selected.
- Clicking on the "Export selection" dropdown menu opens a list of available formats. By clicking on one of the formats offered the book export starts.

Configuration options for the book export

Wiki administrators can configure some settings for the following extensions:
BlueSpiceFlaggedRevsConnector

Export
The export settings affect how the pages of a book are generated in the PDF export.

- **Bookshelf: List accepted revisions log**: Shows a log of stable page versions of pages in the PDF and when these pages were put into accepted status. If editors did not provide a comment when accepting the page, the *Stable comment* field for a revision is empty.

  ![accepted revisions log](image)

- **Bookshelf: List pages without stable revision**: Displays a list of PDF pages at the beginning of the PDF that only exist as a first draft and have no released version.

  ![Not stable pages](image)

- **Bookshelf: List pages without FlaggedRevs**: Displays a list of PDF pages that do not have a release mechanism at the beginning of the PDF.

  ![Not FlaggedRevs namespace](image)

- **UEModulePDF: Show FlaggedRevs info below main heading**: Prints the latest revision dates (last acceptance and last edit date) below the heading.
Quality assurance

- **Automatically set the page to stable, when the workflow was finished successfully:** The workflow ends with setting the page status to stable.
- **Automatically delete the workflow, when a page was marked as stable:** The workflow is deleted.
- **Show unstable pages for following groups:** If the group *user* is removed from the BlueSpiceFlaggedRevs configuration, users in this group will not be able to see draft versions when they are added as reviewers in a review process. When the group user is removed, only *sysop* and *reviewer* users can access drafts. If you want other groups, for example *editor*, to see draft versions, you need to add them to the configuration. If no user groups are specified in the configuration field, not even reviewers and sysops users will see a visual status indication of a page. They will have access to drafts through the revision history for the page instead.

Searching and Navigation

- **Indexing only stable versions:** Draft versions are excluded from the search results. If a page does not have a stable version, it is not shown as a search result.

BlueSpiceUEModuleBookPDF

- Table of Contents
  - *Only article titles (indent by grade):* Only shows the article titles in the main contents table of the PDF.

  ![Table of contents](image)

  PDF table of contents without article TOCs

  - *Embed article TOCs (No indent of article titles):* Shows the table of contents for each article in the main contents table of the PDF.
Deleting a book

When you delete a book, you only remove the book page in the namespace Book from the Book manager. The wiki pages in the book, however, are not deleted. Before you delete the book, you are informed in a pop-up menu that the bookshelf tag is not automatically removed from the pages:

![Delete book form](image)

The bookshelf tags have no effect on the wiki pages after deleting the book. If you want to remove them manually, you can go to the page Special:ReplaceText and do a find and replace to delete the booktag from the pages.

Duplicating a book

You can create an entire copy of the book by duplicating it:

**To duplicate a book:**

1. **Enter a target name:** The default value is the book name with the suffix (copy). Change this to create a different book title.
2. **Select a namespace**: Choose a namespace that is different from the original namespace.

If you are not careful, you might experience some unintended consequences. By creating a new book, you also create copies of all the wiki pages in the original book. Since a namespace cannot contain the same page twice, you have to copy the files to a different namespace.

### About the duplicated files:

- **Book page**: A new page in the namespace book. If you don't enter a new title, the book will be created with the same title and the suffix *(Copy)*. *E.g. Employee Manual *(Copy)**. This file includes a copy of the structure of your original book with the corresponding links to the duplicated pages in the new copy.

- **Wiki pages**: All pages contained in the original book are duplicated. The following scenarios are possible:
  - **Same namespace**: If you duplicate a book in the same namespace, no actual duplicates of the actual wiki are created. Instead, the bookshelf tag is updated to point to the copy of the book. For example, if your original book contains the page *HR:Quality assurance* (the book is in the namespace *HR*), the *Quality assurance* page now contains the bookshelf tag `<bs:bookshelf src="Book: Employee Manual *(Copy)*" />`.
  - **Different namespace**: If you create the book copy in a different namespace, the bookshelf tag in the original files remains unchanged. The new pages in the different namespace are created with a bookshelf tag for the new book copy. This is most likely the scenario you want.

### Configuration

In the **Config manager**, you can change the following additional settings:

- **Use the display title from book source on article**: Shows the title from the book navigation as page title instead of the page name.
**Note:** If the page additionally contains a `{{DISPLAYTITLE}}` tag, the display title of the page is shown instead of the book title.

- Prepend article table of contents and headlines with book numberation
- Supress namespace prefix of book articles in output

### Permissions

To create and edit books, users need *edit* rights in Book namespace. Additionally, a user can only add pages to the book that that user can read. If a user tries to export a book to PDF that contains pages for which the user does not have permissions, the user will get an error message.

### Tipps for working with books

- Use a competent team to decide on the content that should be transferred into an online book.
- Decide on how to handle existing numerations or references.
- Seize the opportunity: Get rid of unnecessary content (or don't include it in your book).
- Decide on standards for documents: When does it make sense to link documents in the wiki? When is it sensible to include the document's content into a wiki article?
- Decide on a fitting course of action: Do you want to create the articles in the wiki first, and compile them in a book structure afterwards, or do you want to create the book structure first, and create and edit the articles contained gradually?
Related info

- Reference:BlueSpiceBookshelf
- Reference:BlueSpiceBookshelfUI
- Customizing page breaks

Category manager

**CategoryManager** provides a user interface for managing categories on the wiki.

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Where to find the category manager .................................................................</td>
</tr>
<tr>
<td>2 Creating a category ............................................................................................</td>
</tr>
<tr>
<td>3 Deleting a category ............................................................................................</td>
</tr>
<tr>
<td>4 Re-ordering a category .......................................................................................</td>
</tr>
<tr>
<td>5 Related info .......................................................................................................</td>
</tr>
</tbody>
</table>

Where to find the category manager

The navigation item *Global settings > Category manager* (in the Management menu) loads the page *Special: Category manager*. 

![Category manager](image-url)
Clicking on the view icon next to a category opens the category page that lists all wiki pages in this category.

**Creating a category**

New categories can be created by clicking the "plus" button. This opens a dialog box for creating the category.

**Deleting a category**

A category can be deleted by:

- selecting a category and clicking the delete button above the category list
- selecting a category and clicking delete button inside the category line.

Deleting a category removes the category from all pages that had the category assignment. It also deletes the category page itself.

**Re-ordering a category**

The category order can be changed by dragging and dropping categories in the list. This is achieved by clicking and, while holding down the mouse button, dragging the category up or down. Dropping a category over another category (instead of in-between two categories) creates a subcategory.
Using drag & drop to order categories

**Note:** It is not possible to rename a category using the category manager. To rename a category, a wiki administrator can use the special page "Replace".

**Related info**

- Reference:BlueSpiceCategoryManager
- Reference:BlueSpiceCategoryCheck

**Creating page lists with DPL3**

The extension **DynamicPageList3** allows you to include lists of wiki pages on any content page.
Application examples

You can view a documentation of all selection criteria and formatting options at Gamepedia.

This help page contains some examples of typical applications for this extension as well as a list of common parameters and their values.

List of subpages

The following code shows the subpages of the current page in a 3-column layout:

```
{{#dpl: 
|titlematch={{PAGENAME}}/% 
|shownamespace=false 
|replaceintitle=/{{PAGENAME}}//, 
|columns=3 
|mode=none 
|rowcolformat=width=100% 
}}
```

Example: Display the subpages of the page VisualEditor in the namespace Manual in a 1-column layout:

```
{{#dpl: 
|titlematch=VisualEditor/% 
|shownamespace=false 
|namespace= Manual 
|replaceintitle=/VisualEditor//, 
|columns=1 
|mode=ubordered 
|rowcolformat=width=100% 
}}
```

Output:

- Files
- Images
- Tables
- Tables/Examples
- Version comparison
Selecting pages by namespace

```dpl
{{#dpl: 
  |namespace=Manual
  |includesubpages=true
  |shownamespace=false
  |count=5
  |ordermethod=title
}}
```

Output:
- Admin Manual Introduction
- Archive/Extension/DocumentManager
- Archive:Extension/RatedComments
- BlueSpice Layout
- BlueSpice Layout/Footer

Selecting pages by category

```dpl
{{#dpl: 
  |category=QM
  |addcategories=true
  |includesubpages=true
  |shownamespace=false
  |count=5
  |ordermethod=title
  |mode=ordered
}}
```

Output:
Extension:DynamicPageList (DPL), version 3.2.1: Warning: No results.

Selecting pages with specific naming patterns

```dpl
{{#dpl: 
  |namespace=File
  |titlematch=A%
  |count=5
}}
```

Output:
- File:A1.png
### List of common parameters

#### Criteria for page selection

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>category</td>
<td>`</td>
<td>category=QM</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>category=QM&amp;Setup&amp;...`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>category=QM</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>category=Admin`</td>
</tr>
<tr>
<td>notcategory</td>
<td>`</td>
<td>notcategory=QM`</td>
</tr>
<tr>
<td>categoriesminmax</td>
<td>`</td>
<td>category=QM</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>category=QM</td>
</tr>
<tr>
<td>namespace</td>
<td>`</td>
<td>namespace=`</td>
</tr>
<tr>
<td>namespacenot</td>
<td>`</td>
<td>namespacenot=Help`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>namespacenot={{NAMESPACE}}`</td>
</tr>
</tbody>
</table>

#### Output-Format

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mode</td>
<td>`</td>
<td>mode=ordered`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>mode=unordered`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>mode=none`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>mode=category`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>mode=inline</td>
</tr>
</tbody>
</table>

#### Sorting

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ordermethod</td>
<td>`</td>
<td>ordermethod=title`</td>
</tr>
</tbody>
</table>
**Help categories**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>`</td>
<td>ordermethod=titlewithoutnamespace`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>ordermethod=counter`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>ordermethod=size`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>ordermethod=firstedit`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>ordermethod=lastedit`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>ordermethod=user,firstedit`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>ordermethod=user,lastedit`</td>
</tr>
<tr>
<td>order</td>
<td>`</td>
<td>order=ascending`</td>
</tr>
<tr>
<td></td>
<td>`</td>
<td>order=descending`</td>
</tr>
</tbody>
</table>

**Display of meta data**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>addcategories</td>
<td>`</td>
<td>addcategories=true`</td>
</tr>
<tr>
<td>addpagecounter</td>
<td>`</td>
<td>category:QM</td>
</tr>
<tr>
<td>adduser</td>
<td>`</td>
<td>category=QM</td>
</tr>
<tr>
<td>addauthor</td>
<td>`</td>
<td>category=QM</td>
</tr>
</tbody>
</table>

**Related info**

- Reference: DynamicPageList3

**Generate page lists (smart lists)**

The extension **SmartList** allows to insert a list of pages in a wiki page using the tags `smartlist`, `newbies`, or `toplist`. The selection criteria can be set using a dialog box.
Available tags

The extension SmartList offers three different tags:

- `<bs:smartlist />` - display a list of pages based on different criteria
- `<bs:newbies />` - display a list of recently registered users
- `<bs:toplist />` - display a list of most visited pages

All of the tags listed above can be added through the menu Insert > Magic word in VisualEditor. For more information on how to insert magic words, see InsertMagic.
Smartlist

Options of the *smartlist* tag

Parameters

The SmartList can be limited or extended with the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count - <em>count</em></td>
<td>The number of articles to be shown. Default value: 5</td>
</tr>
<tr>
<td>Namespaces - <em>ns</em></td>
<td>Only articles from given namespace will be listed. The namespaces can be entered by IDs or by names. Several namespaces can be named with pipes: ns=&quot;0</td>
</tr>
<tr>
<td>Exclude NS - <em>excludens</em></td>
<td>Articles from given namespaces will not be shown. The namespaces can be entered by IDs or by names. Several namespaces can be named with pipes: ns=&quot;0</td>
</tr>
<tr>
<td>Category - <em>cat</em></td>
<td>Only articles from given category will be listed. Selecting several categories is not possible. Default: All categories.</td>
</tr>
<tr>
<td>Show minor - <em>nominor</em></td>
<td>Minor changes (changes marked with an &quot;m&quot; in the recent changes) will not be listed. Default: Minor changes are listed.</td>
</tr>
</tbody>
</table>
Period - period

<table>
<thead>
<tr>
<th>Help categories</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Period - period</strong></td>
</tr>
<tr>
<td><strong>Show only new articles - new</strong></td>
</tr>
<tr>
<td><strong>Trim - trim</strong></td>
</tr>
<tr>
<td><strong>Show text showtext</strong></td>
</tr>
<tr>
<td><strong>Trim text - trimtext</strong></td>
</tr>
</tbody>
</table>

**Example output in source code:**

```xml
<bs:smartlist mode="recentchanges" new="true" count="7" ns="104" trim="false" />
```

**Newbies**

The tag `<bs:newbies />` shows recently registered wiki users.

**Parameters**

<table>
<thead>
<tr>
<th>Help categories</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Count - count</strong></td>
</tr>
</tbody>
</table>

**Example in wikicode**

```xml
<bs:newbies count="7"/>
```

**Toplist**

This tag shows a list of the most visited pages.
Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count - count</td>
<td>The number of articles to be shown; the default value is 10.</td>
</tr>
<tr>
<td>Namespaces - ns</td>
<td>Only articles from these namespace will be shown. You can put several namespaces here, separated by commas.</td>
</tr>
<tr>
<td>Category - cat</td>
<td>Only articles from this category will be shown. You can put several categories here, separated by commas.</td>
</tr>
<tr>
<td>Period - period</td>
<td>The period that should be used (alltime or month). The default is alltime.</td>
</tr>
</tbody>
</table>

Example in wikicode

```
<bs:toplist count="7" ns="Help|QM" />
```

Related info

- Reference:BlueSpiceSmartList
- Reference:BlueSpiceInsertMagic

Interwiki links

Interwiki links are shortcodes for linking to other wikis. The extension InterWikiLinks allows creating abbreviations for various external wikis. The full URL only needs to be known when the interwiki link is defined and not every time it is used.

Contents

1 Interwiki links manager ................................................................. 206
2 Interwiki link syntax ................................................................. 206
Interwiki links manager

Interwiki links are managed from the page Special:InterwikiLinks. It can be loaded from the navigation item Global actions > Management > Interwiki links.

While all users with edit permissions can see this page, a user needs administrative rights to edit the interwiki links:

Interwiki link syntax

Admins can create and delete Interwikilinks with the Interwiki links manager. Existing links can be edited by clicking the "wrench" icon when the link is selected or deleted by clicking the "X" button.

The syntax for interwiki links is:

http://URL_OF_THE_WIKI/$1

$1 is the placeholder for the article title of the other wiki.
Using interwiki links on a page

In edit mode, links to other wikis are added just like links to local wiki pages, but with the interwiki prefix at the beginning.

For example:

The URL to the Wikipedia article “Tree house” is:

https://en.wikipedia.org/wiki/Tree_house

Wikipedia is a default entry in the Interwiki link manager:

prefix: wikipedia, url: https://en.wikipedia.org/wiki/$1

As a result, a link to any wikipedia page can be inserted by using the wikipedia prefix.

[[wikipedia:Tree_house|Wikipedia article about tree houses]]

Special use case: multilingualism

If you want to maintain multiple language versions of your wiki on separate wikis, you can use interwiki links to cross-reference related pages.

With BlueSpice, flag symbols are automatically inserted when the interwiki links with language abbreviations are set.

Linking the language versions:

1. Create interwiki links for the required languages and configure them in the Interwiki link manager (see above) of all language sites. The prefix must always be an ISO-3166 country code, e.g. de, en, fr.
2. Add the interwiki links at the bottom of the related pages to create the language switch. Example: In the English article "Tree", insert the following interwiki links:

```
[[en:{{FULLPAGENAME}}]]
[[de:Baum]]
```

The result of setting the first link is that the English flag will be shown in the language selection of the page header toolbar. This is not necessary and can also be omitted. The second link connects the page with the related german page "Baum" in the German wiki and generates the German flag as a switch in the header toolbar:

![Image showing language selection with English and German flags]

To view a list of all pages on a wiki that don't have interwiki links, an administrator can review the page

*Special:WithoutInterwiki*

---

**Related info**

- Reference:InterWikiLinks
Page templates

A page template applies a predefined content structure and layout to new pages. That way, certain page types can be applied during page creation to produce consistent sets of related pages.

| Contents |
|---------------------------------|-----|
| 1 Characteristics                | 209 |
| 2 Creating a page template      | 209 |
| 2.1 Template fields             | 210 |
| 3 Using page templates          | 211 |
| 4 Configuration                 | 212 |
| 5 Related info                  | 212 |

Characteristics

Page templates are especially useful for frequently used content formats such as logs, reference pages, product descriptions, or short manuals. When a page is created with a page template, the page becomes "detached" from the original page template. This means that subsequent changes to the template will not affect pages that have originally been created with that page template. This distinguishes page templates from regular templates.

In general, page templates:

- used for new pages only
- can be limited to certain namespaces
- can force a namespace for new pages
- are based on templates in the Template namespaces
- integrate with the extension Page Forms

Creating a page template

Administrators can create new page templates, as well as edit and remove existing ones in the Page templates manager, located under Global actions.
Note: Every page template depends on an actual page in the namespace Template. This template must exist before creating a page template.

A new page template can be created by clicking the "Plus" button above the template list.

Template fields

When creating or editing a page template, the following information needs to be provided:

- **Name** - the name of the template
- **Description** - a short description of the template
- **Namespace** - list of the namespace where the template is active
- **Template** - page from the Template namespace from which to pull the data
Using page templates

A list of available templates appears when a user creates a new page. It is shown below the "Empty page" default template. Selecting one of these page templates will create the new page that is prefilled with the content that is transcluded from the actual template page.
Configuration

In the Config manager, you can change the following settings:

- **Force target namespace:**
- **Hide default templates:** Hides the default *Empty page* template.

Related info

- Reference: BlueSpicePageTemplates

Export options

**BlueSpiceUniversalExport** allows exporting wiki pages to various formats. It incorporates various modules, each serving as exporter for a particular export type.

### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 The export menu</td>
<td>212</td>
</tr>
<tr>
<td>2 Modules</td>
<td>213</td>
</tr>
<tr>
<td>3 Configuration</td>
<td>214</td>
</tr>
<tr>
<td>4 Landscape printing</td>
<td>214</td>
</tr>
<tr>
<td>5 Printing</td>
<td>215</td>
</tr>
<tr>
<td>6 Related info</td>
<td>215</td>
</tr>
</tbody>
</table>

The export menu

Every content page on the wiki can be exported. Export functions are located in the general page tools under the menu item *Export*. The available export options depend on your wiki configuration. Clicking one of the links downloads the page content in the selected format.
# Modules

The extension *BlueSpiceUniversalExport* contains several modules:

- **BlueSpiceUEModulePDF**: module for exporting pages in PDF (.pdf) format. It downloads the current page (PDF single page), the current page including all its subpages (PDF page with subpages), or the current page and the pages that are linked from that page (PDF page with linked pages).
- **BlueSpiceUEModuleHTML**: module for exporting pages as an html zip-archive (option HTML single page).
- **BlueSpiceUEModuleBookPDF**: module for exporting books. This module is only available if BlueSpiceBookmaker is installed. It exports entire books in PDF format (available in the Book Manager).

# Configuration

Configuration of UniversalExport (and its modules) can be done in the Config manager in the Export section. Available settings include:

- **Table of contents**: only applies to exporting books. Select how the ToC should be constructed (as a ToC for the entire book or for each page individually).
- **Hide namespace prefix in HTML**: removes namespace prefixes when displaying page titles in HTML exports.
- **Hide namespace prefix in PDF**: removes namespace prefixes when displaying page titles in PDF exports.
- **Metadata (standard, JSON)**: additional data to be passed to the rendering template in JSON format. This data will be available for usage in the template (advanced users).
- **Metadata (override, JSON)**: offers overriding standard data sent to the rendering template. Values that are set by default can be overridden by using this option (JSON format) (advanced users).
Landscape printing

To print a PDF page in landscape format, the following tag can be inserted in the wiki page in source editing mode at any position:

```html
<bs:ueparams template="BlueSpice_Landscape" />
```

To make it easier for the user to add this tag with the visual editor, this tag can be added to a wikitext-template, for example, `{{LandscapeFormatExport}}`. The element can be inserted anywhere on the page.

**Note:** This tag only works for the PDF single page export.

Within a wiki page, individual areas can be marked separately (e.g. wide tables). This way, the output in the export can be landscape or extra-wide. This is possible using the following css classes:

- "bs-rotated" -> landscape format
- "bs-narrow" -> 0,33 x A4 portrait
- "bs-ultrawide" -> 2 x A4 landscape
These classes can also be combined. Example:

```html
<div class="bs-rotated bs-ultrawide">...</div>
```

The start and end div tags can also be added to templates (e.g., `{{LandscapeStart}}` and `{{LandscapeEnd}}`) to allow users to insert the tags using the visual editor.

**Note:** Display of header and footer areas could be problematic when using these tags.

These css classes also work for the book export.

**Printing**

MediaWiki, by default, provides a print view for the pages. This command is also available in the Export menu (option *Print*).

**Related info**

- Reference:BlueSpiceUniversalExport
- Reference:BlueSpiceUEModulePDF
- Reference:BlueSpiceUEModuleBookPDF
- Reference:BlueSpiceUEModuleHTML

**Page info: authors**

**BlueSpiceAuthors** displays the profile images of the users who have contributed to a wiki page.

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Page information</td>
</tr>
<tr>
<td>2 Configuration</td>
</tr>
<tr>
<td>2.1 Output</td>
</tr>
<tr>
<td>3 Related info</td>
</tr>
</tbody>
</table>
Page information

Authors of a page are listed on the *Page information* under the quality management tools.

> ![Page information](image)

Configuration

In the *Config manager* you can change if authors are shown on the Page information or not.

> ![Config manager](image)

Output

*BlueSpiceAuthors*, together with *BlueSpiceArticleInfo* and *BlueSpiceReaders*, is part of the *Page information* in the quality management tools.

- **Display authors**: Show or hide authors on the page information page.
Authors are listed in their role of original author or subsequent editor.

Related info

- Reference:BlueSpiceAuthors

Page info: readers

The extension **Readers** displays the readers of a wiki page.

**Contents**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Viewing the readers of a page</td>
<td>217</td>
</tr>
<tr>
<td>2 Configuration</td>
<td>218</td>
</tr>
<tr>
<td>3 Related info</td>
<td>219</td>
</tr>
</tbody>
</table>

Viewing the readers of a page

Users must have admin rights to see the readers of a page. The list of readers is shown on the page information, which can be accessed from the *Quality management* tab in the *page tools*. 
Admin users can also access the page `Special:Readers/Page_Name`. This special page shows the list of all readers of a page with the date of their last visit.

**Configuration**

In the Config manager, wiki admins can change the settings for this feature. Here, the number of readers to be shown in the flyout can be changed (defaults to 10).
Configuration of BlueSpiceReaders

Related info

- Reference:BlueSpiceReaders

Page information

BlueSpiceArticleInfo contains meta information about a content page.

Contents

1 Viewing the page information ............................................................................................................. 219
2 Configuration ....................................................................................................................................... 220
  2.1 Output ........................................................................................................................................... 221
3 Related info ........................................................................................................................................ 221

Viewing the page information

The lists of meta information about a page are displayed in the page information flyout of the quality management tools.
The following information is available:

- Time of the last edit
- Last editor
- Number of views
- The categories the page belongs to. These can be edited directly from here.
- Templates used on the page
- Subpages of a page (visible only when the page actually has subpages)

**Configuration**

In Config manager, you can change the update frequency for this information. Here, you choose Extension from the select menu and then BlueSpiceArticleInfo.
**Output**

BlueSpiceArticleInfo, together with BlueSpiceAuthors, BlueSpiceReaders, and BlueSpiceExtendedSearch is part of the Page information in the quality management tools.

- **Update interval in seconds**: Sets the refresh rate for the "Last edit" value. By default, this date is updated every 10 seconds via JavaScript.

**Related info**

- Reference:BlueSpiceArticleInfo

**QR Code**

The extension QrCode creates a QR code on each content page of the wiki. A QR Code (also Quick Response code) is a technology that was developed for the logistics needs of Toyota.

**Using the QR code**

Users can open a wiki page quickly on their mobile device by simply scanning the QR code on their desktop page. In addition, the QR code for a wiki page can be attached to a product or included on a printed page. Scanning the QR code on the product or the page leads directly to the wiki page.
The QR Code added by this extension is located in the page tools menu under QR Code. To open the current wiki page with a mobile phone, simply scan it directly from the screen or from a printed page or packaging:

Related info

- Reference:BlueSpiceQrCode

Manual:Rename and move pages

| Contents |
|------------------|----------|
| 1 About moving pages | 223 |
| 2 What happens when you move a page? | 223 |
| 3 How do I move a page? | 224 |
| 3.1 Move with redirect | 225 |
About moving pages

A wiki page can only be renamed by moving it.

Moving is necessary, since the web address of the page changes during renaming. Normally, there are many links to a wiki page. It is therefore important that these links still work after renaming the page.

A page can be moved with or without redirecting the original page. Let's take a closer look at the differences.

What happens when you move a page?

When you move a page:

- you rename the page name and thus the page title
- the page content is displayed on the new page
- the version history of the original page is transferred to the new page

If you move from the original page to the new page, an additional page with the old page name will be created. This page then serves as a redirect to the new page. If you do not create a redirect, the original page is simply replaced. In this case, you should check and update the links to the old page on your wiki.

The following diagram shows how to rename an "Emobile" page to a page called "Electric Vehicles" page:
How do I move a page?

Go to the page tools menu item "Manage page > Move":

1. Click "Move":

```
<table>
<thead>
<tr>
<th>Manage page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
</tr>
<tr>
<td>Move</td>
</tr>
<tr>
<td>Protect</td>
</tr>
<tr>
<td>Add to a book</td>
</tr>
<tr>
<td>Refresh</td>
</tr>
<tr>
<td>Duplicate this page</td>
</tr>
</tbody>
</table>
```
2. The "Move page" dialog box opens:

![Move page dialog box]

3. Under New Title, select the namespace for your page and overwrite the original title:

![Move page dialog box]

4. **Reason:** Optionally provide a reason why it was necessary to move the page.

5. **Leave a redirect behind:** Depending on the linking status or purpose of a page, you now have to decide whether to move the page with or without forwarding.

6. **Watch source page and target page:** Specify whether you want to put the source and landing pages on your watch list when redirecting.

7. Click "Move page".

**Move with redirect**

It makes sense to create a redirect in the following cases:

- The original page is linked to many other sites (e.g., from other websites or other internal wiki sites).
- The title of the original page is sometimes used in the search and the page should be found either way.
Move without redirect

In these cases, it makes sense to move without forwarding:

- A spelling error is corrected in the title. There are only a few links to the page and they are easy to find and replace.
- The original title should not appear in the search.
- An unnecessary redirection via a forwarding page should be avoided.

Updating references to the page

After successfully moving the page, you will see a confirmation page. If you did not create a redirect, it is important to check if existing links to the original page exist in your wiki. These must then be adapted accordingly to the new page name, so that the page is newly networked. Use the link on the confirmation page to go to the "Special:Replace Text" page:

Move succeeded

"Template:Box Left" has been moved to "Template:Box Left 1"
A redirect has been created.
To also modify links to this page in other pages, go to Special:ReplaceText.

If you have not completed the check immediately after moving the page, you can always go to the special page at any time. Use the Replace Text page to find pages and content that contain the text of the original title.

Enter the original page title under "Existing text" and the new page title under "New text":

Select all wiki sections using the "All" button to find existing references to the original page:

If you click on "Continue" the text will not be replaced yet. First, an overview page with the results found will be displayed. Check which of the results you want to replace and check the box. Click "Replace" to perform the replacement:

Replace "Box Left 1" with "Box Left" in the text of the following page:

The last page now confirms that the changes have been made:

"Box Left 1" will be replaced with "Box Left" in one page.

Return to form.
Your wiki is now correctly linked again and you have successfully moved your page.

Related info

- Redirecting pages
- Working with subpages

Extended search

*ExtendedSearch* replaces the default MediaWiki search engine. It is based on the *Elasticsearch* engine and provides many improvements over standard MediaWiki search both in terms of quality of indexed content and user interface. Pages and files are indexed immediately and available for searching in real-time.

| Contents |
|-------------------|-------------------|
| Usage | Usage |
| 228 | 229 |
| 2 Autocomplete | 2 Autocomplete |
| 2.1 Namespace and subpage "pills" | 2.1 Namespace and subpage "pills" |
| 2.2 Configuration | 2.2 Configuration |
| 2.3 Search operators | 2.3 Search operators |
| 230 | 230 |
| 3 Search Center (extended search) | 3 Search Center (extended search) |
| 3.1 Search operators | 3.1 Search operators |
| 3.2 Elements | 3.2 Elements |
| 3.2.1 Results relevance | 3.2.1 Results relevance |
| 3.2.2 Exporting search results | 3.2.2 Exporting search results |
| 231 | 233 |
| 4 Configuration | 4 Configuration |
| 234 | 234 |
| 5 SearchAdmin | 5 SearchAdmin |
| 235 | 235 |
| 6 Related info | 6 Related info |

Usage

Extended search offers two ways of searching for content:

1. Autocomplete
2. Search Center

By default, the search indexes:

- wiki pages: all content pages, except for pages in the MediaWiki namespace
- special pages: all pages in the namespace `Special`
- repo files: files uploaded to the wiki - for text files like Word documents and PDFs, this includes content and metadata
- external files: files from arbitrary locations from accessible storage paths (e.g., mounted drives)
- social entities: entities (pages) created by the `BlueSpiceSocial` extension, like blog posts and user profiles

### Autocomplete

The search box in the main toolbar offers with autocomplete functionality is available from any page on the wiki. Autocomplete matches only page and file titles, but does not provide a full-text search.

After typing in the search bar, an autocomplete popup appears:

![Autocomplete popup](image)

This popup is divided in two columns.

**Left column:**

- **Primary results**: These are the results that are direct matches for the search term. The exact matches are shown in bold letters.
- When looking for the term "quality management", it is also possible to type in "qual man" and the search starts looking for matches
- The best match is often shown with a thumbnail preview as a top search result
Right column:

- **Tools and secondary results:** Tools are displayed in the top portion of the right column and contain:
  - a button to create the page with the current search term as the title (only if user has permission to create new pages)
  - a button to execute full-text search for the current term. Selecting this option leads to the Search Center.

In the bottom portion of the right column, secondary results are displayed. Secondary results are matches that do not directly match the given term, but might be relevant for the user. These show up only in certain contexts:

- If there are significantly more matches for a similar term than the term actually searched for (in a situation of a typo for example)
- If the namespace or subpage pill is present (see next section). In this case, secondary results will show direct matches in other namespaces/pages.

**Namespace and subpage "pills"**

Autocomplete search bar supports pills for namespaces and subpages.

![](images/namespace-pill.png)

If a user types `Manual:`, a pill for the namespace "Manual" appears and the search for the following term is limited to this namespace. Subpage pills work in the same way. If the user types in `PageName/`, any term after that is matched in the context of that page. If you search for "TestPage/Te", for example, the search will match only subpages of "TestPage" that contain "Te" in the title, like "TestPage/Test" and "TestPage/TestSubpage".

**Configuration**

Previously explained is the full version of the autocomplete popup. Wiki admins can also choose to use "Simple autocomplete", which contains only one column with primary results and tools, without secondary results. This type of autocomplete is also more compact. This setting is available from `BlueSpiceConfigManager`, under *Extension > BlueSpiceExtendedSearch > Use simple autocomplete*.

**Search operators**

Since the autocomplete search only searches for titles, search operators such as AND or OR are not supported. However, they are supported using the Search Center.

**Search Center (extended search)**

As soon as you trigger the full-search with the magnifying glass symbol or the *Enter* key, the wiki switches to the Search Center. This is a special page that offers the full functionality of the search. The search in the Search Center is carried out using the same search bar that is also used for autocomplete.
Here, the search engine carries out a full text search, which also includes the metadata of documents. It does not index the wikitext of a wiki page, but rather the rendered content, that is the output by the browser.

Search operators

To use search operators in the full-text search, the following syntax can be used:

- (Sandbox) AND (Widgets) - returns pages that contain both the term sandbox and the term widgets
- (Sandbox) OR (Widgets) - returns pages that contain either the term sandbox or the term widgets.
- (Sandbox) NOT (Widgets) - returns pages that contain the term sandbox but not the term widgets.

The terms have to be included in parentheses and the search operators have to be written in uppercase letters.

Elements

- **Hit count** - shows how many matches a search has returned. It may be exact or approximate. Approximation is due to dynamic check for permissions to view each page in the results, some results may not be shown to the user with no adequate permissions event if it matches the search term.
- **Tools** - these are located in the top right as a set of buttons:
  - Create a page - represented by a "plus" button - will create a page with current search term as a title (only visible if user has permission to create pages)
  - Add filters - represented by a "funnel" icon - opens a dialog where users can select the type of filter to apply to the search.
- **Search options** - represented by a "gear" icon - opens a dialog where users can change settings for the current search. It provides options like the number of results per page, sorting field and order.

- **Export search** - represented by the "export" icon - opens a dialog to export current search results to a dedicated page (only visible to authorized users, by default admin users).

- **Filter**: Filters are displayed in form of pills below the results counter. Each filter pill represents a different attribute. Filter values can be changed by clicking on the filter pill and selecting the desired options from the popup that will open. Filter can be removed by clicking on the "x" button in each pill.
- **Results:** If current search criteria yield any results, a list of results is displayed. The information available in the results is depending on the result type:
  - Main title of the result (page title, file name...)
  - Result type
  - Size and extension (for files)
  - Thumb image (for images) or file type icon (for other file types)
  - Redirect information
  - Original name (for wikipages, if the page display title is different than the actual page title)
  - Secondary information like page categories, modification and creation date, author, etc.
  - Snippet of the matches in the content of the page (if there are matches in the page content),
  - Sections with matches in the content (for wikipages)

In case there is an exact match for a given search term, the result that matches exactly is displayed as a "featured" result. Such a result displays a preview image of the page and always displays the content snippet, regardless of whether there are matches in the content or not.

**Results relevance**

All logged-in users can mark certain results as "favorites" by clicking on the star symbol in the right corner of each result. Files marked as “favorite” will score higher in future searches - this is not visible immediately, however, but happens over time. One user's relevance settings won't affect other user's searches. Results can be unmarked as "favorite" by clicking on the “star” symbol again.

**Exporting search results**

After executing the search, administrators can export (save) the results to a specific page using the "Export" command from the "Tools" menu. The list is exported to `MediaWiki:PageCollection/LISTENNAME`.

---

Help categories

---

Editing filter

---

Results: If current search criteria yield any results, a list of results is displayed. The information available in the results is depending on the result type):

- Main title of the result (page title, file name...)
- Result type
- Size and extension (for files)
- Thumb image (for images) or file type icon (for other file types)
- Redirect information
- Original name (for wikipages, if the page display title is different than the actual page title)
- Secondary information like page categories, modification and creation date, author, etc.
- Snippet of the matches in the content of the page (if there are matches in the page content),
- Sections with matches in the content (for wikipages)

In case there is an exact match for a given search term, the result that matches exactly is displayed as a "featured" result. Such a result displays a preview image of the page and always displays the content snippet, regardless of whether there are matches in the content or not.

Results relevance

All logged-in users can mark certain results as "favorites" by clicking on the star symbol in the right corner of each result. Files marked as “favorite” will score higher in future searches - this is not visible immediately, however, but happens over time. One user's relevance settings won't affect other user's searches. Results can be unmarked as "favorite" by clicking on the “star” symbol again.

Exporting search results

After executing the search, administrators can export (save) the results to a specific page using the "Export" command from the "Tools" menu. The list is exported to `MediaWiki:PageCollection/LISTENNAME`.
Only valid wikipages are exported. The pages contained in a list can be included in a book in the book function via Mass add> Source: Page collection.

Configuration

In the BlueSpiceConfigManager, under settings for the extension BlueSpiceExtendedSearch, the following configuration options are available:

- **External file paths**: External locations to scan for and index files from. These locations are entered in key/value pairs of Physical path and URL prefix.
  - **Physical path**: Storage path. For mounted drives, for example: X:\Documents
  - **URL prefix**: All files indexed from the indexed physical location are prefixed in the search results. It should be used if files are available from a web server. By default, the URL prefix is set to the same value as Physical path.
- **Use simple autocomplete**: forces a more compact autocomplete (1-column layout, no thumbnail preview).
Automatically set language filter: This setting applies to multi-language wikis. It returns search results for a user only in the user's language. Users can set their language in their preferences.

Exclude patterns: Files at external file locations can be excluded from search based on regular expression patterns.

SearchAdmin

Special:SearchAdmin is a special page for wiki admins. This page provides stats on documents indexed in the search.

Related info

- Reference:BlueSpiceExtendedSearch
Interwiki search

InterwikiSearch allows simultaneously searching other BlueSpice wikis when performing a search on the wiki.

Usage

If BlueSpiceInterwikiSearch is enabled and configured on the wiki, every time user performs a search using the Special:SearchCenter, results from other wikis will be shown as well. Results from other wikis will be shown at the top of the page, below the filters, in form of Wiki name (number of results) buttons.

Viewing results from other wikis

Clicking on a particular wiki's button will open a dialog containing the first page of the results, in order to enable quick and easy way of visualizing the results. If the desired document is not listed on this page, user can redirect to the target wiki and perform a full search on that wiki, by clicking on "Open full search" button at the top right corner of the dialog. This will open the Special:SearchCenter on the target wiki, with current search term already inserted.
Search field in the page content (TagSearch)

TagSearch allows the integration of a configurable search field in content pages. This search field relies on BlueSpiceExtendedSearch.

Inserting the tag

The tag `<bs:tagsearch />` can be inserted and configured directly in visual editing mode.

Go to `Insert > Magic word` in the VisualEditor menu. Select tagsearch from the dialog and click done. This opens the configuration options dialog on the page.
### Inserting TagSearch on a page

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Display name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>placeholder</td>
<td>Placeholder</td>
<td>Text to be shown in the search field when nothing is typed in</td>
</tr>
</tbody>
</table>
| type          | Type         | List of types of search entities to search. By default search entities available are: `wikipage`, `specialpages`, `repofile` (internal files), `externalfile`, `socialentity`. Multiple values can be entered separated by pipe (|) - "wikipage|repofile"
| namespace     | Namespace(s) | List of namespaces in which to search. Namespaces can be entered by using their IDs or names, separated by a pipe (|). IDs and names cannot be mixed. Correct entries are: "1|6|8", "Help|QM", while invalid is "1|QM". To search in the main namespace, use an empty space as value (e.g., "" or "|Template") |
| category      | Category(-ies) | List of categories in which to search. Multiple categories must be separated by a pipe (|) - "Cat1|Cat2"
| operator      | Search operator | Applies only to categories. Operator “AND” will only find results that are in all of the given categories, while operator “OR” will show results in any of the given categories. |

Multiple tags can be added to a single page using the same or different configurations.
Using the search field

Once the page is saved, the code for the search field is inserted in the page source where it was inserted.

**Example:**

```html
<bs:tagsearch type="wikipage" operator="AND" namespace="|Template" category="Editing" />
```

The search is looking for wiki pages in the namespaces *(Main)* and *Template* that belong to the category *Editing*.

Clicking on search icon to the left or pressing *Return* loads the full-text search in the Search-Center.

![Search field on the page](image)

Related info

- Reference:BlueSpiceTagSearch

Error messages

The wiki contains a number of system error messages. These messages can be customized to your needs.

For example, if a wiki has a lot of visitors with anonymous read-access only, these visitors get a permissions error when they try to access a page that does not exist:
This creates the impression that a page with that name exists, but the visitor does not have sufficient rights to view the page. In reality, the page simply does not exist and a user with write-permissions could now log in and create the page.

Therefore, we want to distinguish between anonymous visitors and users with write-access and show a tailored error message.

**Creating a custom 404 error page**

If a page does not exist yet, you can display a custom message.

**To create the message:**
1. Create the page `MediaWiki:Noarticletext-nopermission`
2. Add your custom message in edit mode.
3. Save the page.
4. To test the message, try to access a page that does not exist. Make sure you are not logged in, because this message is displayed to anonymous users only.

**How to update an error message**

The text for the error pages on the wiki is stored in the form of system notifications. You can access these error messages from the page `Special:AllMessages`.

To find the message or the messages that are being used on a particular error page, add `?uselang=qqx` or, if the url already contains a question mark, `&uselang=qqx` to the page url:

```
```

This will expose the actual sources for the error messages on the page:
In the above example, there are two error messages on the page:

- **permissionserrortext-withaction**: displays the text “You do not have permission to edit this page, for the following reason”
- **badaccess-groups**: displays the text “The action you have requested is limited to users in one of the groups: Administrators, Editors, Reviewers.

These pages do not actually exist, and therefore the standard text message from the database is displayed. If you want to change a message, you must first create the page.

**To update a system message:**

1. Go to the special page "System messages" (Special:AllMessages)
2. Enter the full name of the system message in the "Prefix" field of the filter:

   ![Filter](image)

   - **permissionserrortext-withaction**: You do not have permission to edit this page, for the following reason
   - **badaccess-groups**: The action you have requested is limited to users in one of the groups: Administrators, Editors, Reviewers.

3. Click on the name to create a page for this system message
4. Enter your custom error message and save the page. The system message has now been customized.
5. Continue to update any other system messages on the page.
Note: Many of these messages use parameters (e.g., "$1"), which should be considered when you change the default text. If something went wrong, you can also delete the custom error pages you created - then the default text from the database will be used again.

Related info


Manual:Extension/BlueSpiceBookshelf/Customized PDF Output

How to adjust page breaks in multi-page PDFs.

Adjusting page breaks

By default, each chapter and sub-chapter in a Book-PDF is started on a new page. To avoid these page breaks and to create a continuous chapter flow, an administrator can add the following code to the page MediaWiki:Common.css:

```css
/*PDF Book - no page breaks */
.bs-page-content, .bs-page-content.booklevel-1, .bs-page-content.booklevel-2
{page-break-after: avoid; page-break-before: avoid;}
```

If you want to start the main chapters on separate pages, use this code instead:

```css
/* multi-page PDF breaks after each main chapter */
.bs-page-content { page-break-after: avoid; page-break-before: avoid; }
.bs-page-content.booklevel-1 { page-break-before: always; page-break-after: always; }
```

Note: These settings apply both to the PDF output of books and to the PDF export which includes linked pages or subpages of a wiki page.
Namespace CSS manager

The extension NamespaceCSS allows users to apply different CSS styles to different namespaces.

## Contents

1. Creating the styles for a namespace ............................................................... 243
2. Related info ..................................................................................................... 243

### Creating the styles for a namespace

The link Namespace-CSS Manager in the menu Global actions > Management opens the page Special: NamespaceCSSManager. This page lists all namespaces and the link to their associated CSS page.

To add or overwrite the styles for a namespace:

1. **Click** on the source page link for the namespace.
2. **Enter** your CSS-code directly in this page. Example: MediaWiki:User_css affects all pages in the namespace User.
3. **Save** the page and review your changes on the pages in the affected namespace.

### Related info

- Reference:BlueSpiceNamespaceCSS
- Reference:BlueSpiceNamespaceManager
- Mediawiki_namespaces
Template package

Below is a set of templates which you can import into your wiki.

Instructions

1. Download the package as zip file.
2. Unzip the archive.
3. Go to the special page Special:Import on your wiki (this page is only visible to users with admin rights).
   - Select the individual template file you want to upload or AllTemplates.xml to upload all templates.
   - Enter a Interwiki prefix. Since this field is required for the upload, you can simply enter en.
   - Select “Template” from the import to a namespace select menu.

The templates are now available in your wiki and can be added using the Insert > Template function of Visual Editor.

Subpages

- Subpage 1
- Subpage 2
- ...

**Subpages:** List all subpages of any wiki page

| Note: This is a note. |
| Tip: This is a tip. |
| Example: This is an example. |
| Warning: This is a warning. |
| Important: This is important. |

**Box Note:** Add an infobox to a page
**Transclusion:** Transclude a page into a page

**PageBanner:** Add a banner to a page

**Clear:** Clear the space around an image

---

**Software catalog**

A list of all MediaWiki and BlueSpice extensions for the current version of BlueSpice.

**BlueSpice 3.1**

- Extensions BlueSpice free
### Extensions BlueSpice free

<table>
<thead>
<tr>
<th>Extension</th>
<th>Description</th>
<th>Use Case</th>
<th>License</th>
<th>Aktivated</th>
<th>Maintainer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrays</td>
<td>Store and compute named arrays</td>
<td>Rich Articles</td>
<td>MIT</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>BlueSpiceAbout</td>
<td>Offers an information page, which is delivered with every edition of a BlueSpice MediaWiki distribution.</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceArticleInfo</td>
<td>Displays important meta information about a page like the last edit or the number of edits.</td>
<td>Data Analysis</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceAuthors</td>
<td>Displays the profile images of page authors in the page information.</td>
<td>Data Analysis</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceAvatars</td>
<td>Assigns an automatically generated individual profile picture for every user.</td>
<td>Personalization</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceCalumma</td>
<td>BlueSpice Skin</td>
<td>-</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td></td>
<td>Allows inserting checkboxes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Activated</td>
<td>Maintainer</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------</td>
<td>-----------------------</td>
<td>---------</td>
<td>-----------</td>
<td>--------------</td>
</tr>
<tr>
<td>BlueSpiceChecklist</td>
<td>and checklists for task management.</td>
<td>Rich Articles</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceConfigManager</td>
<td>Offers the possibility to admins, to configure the whole wiki from a single SpecialPage</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceContextMenu</td>
<td>Provides context menus for various links.</td>
<td>Search and Navigation</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceCountThings</td>
<td>Provides content based statistics.</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceCustomMenu</td>
<td>Provides customizable menus</td>
<td>Search and Navigation</td>
<td>GPL v3</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceDashboards</td>
<td>Provides dashboards for users and administrators.</td>
<td>Reporting</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceDistributionConnector</td>
<td>General interface between MediaWiki extensions and BlueSpice.</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceEchoConnector</td>
<td>Interface between BlueSpice and the extension Echo.</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td></td>
<td>Provides an interface</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td>Maintainer</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------</td>
<td>---------</td>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>BlueSpiceEditNotifyConnector</td>
<td>between BlueSpice and the extension EditNotify.</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceEmoticons</td>
<td>Renders emoticons in a text as images.</td>
<td>Rich Articles</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceExtJSType</td>
<td>Adds the GPL version of Sencha Inc. ExtJS Rich Internet Application Framework</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceExtendedSearch</td>
<td>Full-text search in articles and files, faceted search, fuzzy search, spellchecker and sorting as well as search-as-you-type and auto-complete functionality.</td>
<td>Search and Navigation</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceExtendedStatistics</td>
<td>Provides an analytic view of many relevant parameters on the wiki.</td>
<td>Reporting</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceFilterSpecialPages</td>
<td>Inserts a field in Special: Specialpages to provide a search function.</td>
<td>Search and Navigation</td>
<td>GPL v2</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td>Maintainer</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>---------</td>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>BlueSpiceFoundation</td>
<td>MediaWiki enterprise ready</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceGroupManager</td>
<td>Administration interface for adding, editing and deleting user groups.</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceHideTitle</td>
<td>Provides a magic word to hide the title of the page.</td>
<td>Rich Articles</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceInsertCategory</td>
<td>Provides a dialogue to see a category overview for inserting, as well as creating and deleting categories.</td>
<td>Editor</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceInsertFile</td>
<td>Introduces a dialog box directly in the BlueSpice VisualEditor, allowing files to be easily inserted.</td>
<td>Editor</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceInsertLink</td>
<td>Offers a dialogue to insert links without using the wiki code.</td>
<td>Editor</td>
<td>GPL v3</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceInsertMagic</td>
<td>Helps integrating special wiki tags, behavior switches or</td>
<td>Editor</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td>Maintainer</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>---------</td>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>BlueSpiceInterWikiLinks</td>
<td>Administration interface for adding, editing and deleting interwiki links.</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceInterwikiSearch</td>
<td>Simultaneous search in multiple wikis</td>
<td></td>
<td></td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceNamespaceCSS</td>
<td>Enables namespace-specific styling.</td>
<td>Skinning</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceNamespaceManager</td>
<td>Administration interface for adding, editing and deleting namespaces.</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpicePageAccess</td>
<td>Allows group-based access on page level.</td>
<td>Security</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpicePageAssignments</td>
<td>Assigns individual users or whole groups to pages, e.g. as responsible editors.</td>
<td>Quality Assurance</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpicePageTemplates</td>
<td>Offers the possibility to select from predefined content structures when creating a new page.</td>
<td>Content Structuring</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td></td>
<td>Provides a personalized</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Activated</td>
<td>Maintainer</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>---------</td>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>BlueSpicePagesVisited</td>
<td>list of the last visited pages.</td>
<td>Personalization</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpicePermissionManager</td>
<td>Allows an easy and convenient management of usergroup rights in a graphical interface.</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpicePrivacy</td>
<td>Management page for user privacy settings</td>
<td>Security</td>
<td>GPL v3</td>
<td>no</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceQrCode</td>
<td>Displays a QR code in the page tools of each content page</td>
<td>Mobile</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceRSSFeeder</td>
<td>Offers a special page that describes and enables RSS-Feeds for chosen areas of the MediaWiki.</td>
<td>Reporting</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceReaders</td>
<td>Displays the profile pictures and user name of page readers for admin users.</td>
<td>Data Analysis</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceSaferEdit</td>
<td>It saves the article automatically while you are editing at predetermined intervals.</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
</tbody>
</table>

Introduces a
<table>
<thead>
<tr>
<th>Extension</th>
<th>Description</th>
<th>Use Case</th>
<th>License</th>
<th>Aktivated</th>
<th>Maintainer</th>
</tr>
</thead>
<tbody>
<tr>
<td>BlueSpiceSmartList</td>
<td>tag that can be placed on any page to show a list of pages</td>
<td>Reporting</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceTagCloud</td>
<td>Visualize a category overview graphically and in 3D.</td>
<td>Rich Articles</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceUEModuleDOCX</td>
<td>export an book to DOCX format.</td>
<td>Export</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceUEModuleHTML</td>
<td>export an article to HTML format.</td>
<td>Export</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceUEModulePDF</td>
<td>Enables the output as Adobe Portable Document Format (PDF).</td>
<td>Export</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceUniversalExport</td>
<td>Enables the single page export to PDF.</td>
<td>Export</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceUsageTracker</td>
<td>Delivers statistics about the use of features.</td>
<td>Reporting</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceUserManager</td>
<td>Provides a visual interface for user administration</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceUserMergeConnector</td>
<td>Provides an interface between BlueSpice and the extension UserMerge</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td>Maintainer</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------</td>
<td>----------------</td>
<td>---------</td>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>BlueSpiceUserSidebar</td>
<td>Personal navigation menu</td>
<td>Personalization</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceVisualEditorConnector</td>
<td>Connects BlueSpice with VisualEditor</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceWatchList</td>
<td>Adds a watchlist widget and tag</td>
<td>Reporting</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>BlueSpiceWholsOnline</td>
<td>Shows which users have been logged-in in the last 10 minutes</td>
<td>Rich Articles</td>
<td>GPL v3</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>Bootstrap</td>
<td>Provides the Bootstrap framework in the wiki</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>CategoryTree</td>
<td>Enables you to displays categories and subcategories in a tree structure.</td>
<td>Content Structuring</td>
<td>GPL v3</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Cite</td>
<td>Allows a user to create footnotes by using a special tag.</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>CiteThisPage</td>
<td>Extension provides a special page which allows creating a citation for a page in variety of styles.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td>Maintainer</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>----------</td>
<td>--------------------------</td>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>CodeEditor</td>
<td>Syntax-highlighted editing for JavaScript and CSS pages using Ace editor</td>
<td>Editor</td>
<td>GPL v2+ and BSD 3 Clause</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>ConfirmEdit</td>
<td>Enables the user to place various CAPTCHA methods to protect the wiki from spambots.</td>
<td>Security</td>
<td>GPL v2</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>CookieWarning</td>
<td>Provides a notice at the top of the page about cookies</td>
<td>Security</td>
<td>MIT</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>DynamicPageList3</td>
<td>Create lists of other articles based on their category, namespace, title, references or template usage and include contents or arguments of template calls of those articles into your page.</td>
<td>Reporting</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Echo</td>
<td>Provides an in-wiki notification system that can be used by other extensions.</td>
<td>Infrastructure</td>
<td>MIT</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
</tbody>
</table>

**Help categories**

This document was created with BlueSpice
<table>
<thead>
<tr>
<th>Extension</th>
<th>Description</th>
<th>Use Case</th>
<th>License</th>
<th>Aktivated</th>
<th>Maintainer</th>
</tr>
</thead>
<tbody>
<tr>
<td>EditNotify</td>
<td>special notifications when creating / editing articles.</td>
<td>Quality Assurance</td>
<td>MIT</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>EmbedVideo</td>
<td>Adds a parser function called #ev for embedding video clips from popular video sharing services.</td>
<td>Rich Articles</td>
<td>MIT</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Gadgets</td>
<td>Provides a way for users to pick JavaScript or CSS based &quot;gadgets&quot; that other wiki users provide.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>HitCounters</td>
<td>Counts the hits of a page /article.</td>
<td>Reporting</td>
<td>GPL v3</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>ImageMap</td>
<td>Allows clickable HTML image maps.</td>
<td>Search and Navigation</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>ImageMapEdit</td>
<td>automates and simplifies a large part of the process.</td>
<td>Editor</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>InputBox</td>
<td>Allows to integrate HTML forms into wiki pages.</td>
<td>Content Structuring</td>
<td>MIT</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Interwiki</td>
<td>Provides a special page for maintaining the Interwiki table.</td>
<td>Administration</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td>Maintained</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>---------</td>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>LDAP Authentication</td>
<td>Allows authentication against a LDAP resource</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>LDAP Authorization</td>
<td>Allows group-based authorization against an LDAP resource.</td>
<td>Infrastructure</td>
<td>MIT</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>LDAPGroups</td>
<td>Allows user group synchronization with a LDAP resource.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>LDAPProvider</td>
<td>Provides a common infrastructure to connect to a LDAP resource and run queries against it</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Lingo</td>
<td>Provides hover-over tool tips on pages from words defined on the Glossar page</td>
<td>Content Structuring</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>LocalisationUpdate</td>
<td>Allows to update the localizations for MediaWiki messages at any time, without needing to upgrade the MediaWiki software.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td>Maintainer</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td>----------</td>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>MediaWiki</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Nuke</td>
<td>Extension for administrators to delete more than one page at once.</td>
<td>Administration</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>OATHAuth</td>
<td>Provides authentication support using HMAC-based one-time passwords</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>OOJSPlus</td>
<td>Provides Widgets and utility functions for OOJS</td>
<td>-</td>
<td>-</td>
<td>yes</td>
<td>BlueSpice</td>
</tr>
<tr>
<td>ParserFunctions</td>
<td>Enhance parser with logical functions</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>PdfHandler</td>
<td>Shows uploaded PDF files in a multipage preview layout.</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>PluggableAuth</td>
<td>Provides framework for pluggable authentication and authorization</td>
<td>Infrastructure</td>
<td>MIT</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Poem</td>
<td>Create paragraphs and line breaks for poem formatting</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td></td>
<td>Allows the creation of</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Activated</td>
<td>Maintainer</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------</td>
<td>-----------</td>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>Quiz</td>
<td>quizzes.</td>
<td>Content Structuring</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>RSS</td>
<td>Renders RSS feeds to display them in wiki articles.</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Renameuser</td>
<td>Provides a special page that allows user accounts to be renamed.</td>
<td>Administration</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Replace Text</td>
<td>Provides a form to let administrators do string replacements on the entire wiki, for both page contents and page titles.</td>
<td>Administration</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>SimpleSAMLphp</td>
<td>Provides authentication using SimpleSAMLphp in conjunction with PluggableAuth</td>
<td>Infrastructure</td>
<td>MIT</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>SpamBlacklist</td>
<td>Create and manage blacklists based on URL patterns to avoid spam in the wiki.</td>
<td>Security</td>
<td>GPL v2</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>SyntaxHighlight</td>
<td>Provides syntax highlighting and code rendering.</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td>Maintain</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------</td>
<td>---------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>TemplateStyles</td>
<td>Implement per-template style sheets</td>
<td>Skinning</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>TitleBlacklist</td>
<td>Manage black- and whitelist to forbid creating new articles and user accounts.</td>
<td>Security</td>
<td>GPL v2</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>TitleKey</td>
<td>Provides a title prefix search suggestion backend.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>TwoColConflict</td>
<td>Showing a side-by-side edit merge screen for edit conflict resolution</td>
<td>Editor</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>UserFunctions</td>
<td>Enhance parser with user functions</td>
<td>Administration</td>
<td>GPL v2</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>UserMerge</td>
<td>Merges several users into one account.</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>Variables</td>
<td>Parser functions allowing to work with dynamic variables in an article scoped context</td>
<td>Data Analysis</td>
<td>ISC</td>
<td>yes</td>
<td>MediaWiki</td>
</tr>
<tr>
<td>VisualEditor</td>
<td>Is an editor you can use without having to enter special markup.</td>
<td>Editor</td>
<td>MIT</td>
<td>no</td>
<td>MediaWiki</td>
</tr>
</tbody>
</table>

Provides an
### Extensions BlueSpice pro

<table>
<thead>
<tr>
<th>Extension</th>
<th>Description</th>
<th>Use Case</th>
<th>License</th>
<th>Aktivated</th>
<th>Maintainer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auth remoteuser</td>
<td>Automatically logs-in users using the REMOTE_USER environment variable</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceArticlePreviewCapture</td>
<td>Creates preview images of wikipages for dynamic file dispatcher</td>
<td>Data Analysis</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceBookshelf</td>
<td>Combines wiki pages to create books and also to export those pages as a PDF document.</td>
<td>Book</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceBookshelfUI</td>
<td>provides a graphical administration interface for creating, editing and managing books.</td>
<td>Book</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceCategoryCheck</td>
<td>Reminds a user to categorize a page.</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceCategoryManager</td>
<td>Show and edit the category structure of the wiki.</td>
<td>Content Structuring</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceDrawioConnector</td>
<td></td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceExpiry</td>
<td>pages can be marked as expired.</td>
<td>Quality Assurance</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceExportTables</td>
<td>Enables the export of wiki tables to Excel.</td>
<td>Export</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------</td>
<td>-------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceExtendedFilelist</td>
<td>Simplifies the display and search of images and files.</td>
<td>Document Management</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceFilterableTables</td>
<td>Provides filterable content tables.</td>
<td>Rich Articles</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceMultiUpload</td>
<td>Provides batch uploading of files</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceNSFileRepoConnector</td>
<td>Interface between BlueSpice and the extension NSFileRepo</td>
<td>Document Management</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpicePageFormsConnector</td>
<td>Integrates PageForms extension into BlueSpice</td>
<td>-</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpicePlayer</td>
<td>Integrates an HTML video player for uploaded videos</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceRating</td>
<td>enables users to rate an article with up to five stars or to recommend the article.</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceReadConfirmation</td>
<td>Ask for confirmation that a page was read by assigned users</td>
<td>Quality Assurance</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceReminder</td>
<td>Allows users to set notification dates with comments for a page.</td>
<td>Quality Assurance</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceReview</td>
<td>set up editing and sign-off routines using workflows.</td>
<td>Quality Assurance</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceReviewExtended</td>
<td>with this workflow tool, users can start a review process of single articles by several users.</td>
<td>Quality Assurance</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktiviert</td>
<td></td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>---------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSMWConnector</td>
<td>integrates SemanticMediaWiki into BlueSpice.</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSignHere</td>
<td>adds a tag to a wiki page, that allows to let those page being signed quickly and easily.</td>
<td>Rich Articles</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocial</td>
<td>Base extension for social extensions</td>
<td>Administration</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialArticleActions</td>
<td>Adds SocialEntities (pages) for typical page actions.</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialBlog</td>
<td>Blog entity for BlueSpiceSocial</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialComments</td>
<td>Comment functionality for BlueSpiceSocial</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialMicroBlog</td>
<td>Microblog functionality for BlueSpiceSocial</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialProfile</td>
<td>Profile entity for BlueSpiceSocial</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialRating</td>
<td>Rating functionality for BlueSpiceSocial entities</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialResolve</td>
<td>Provides a resolved /unresolved status for BlueSpiceSocial entities</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialTags</td>
<td>Adds tagging functionality to social entities</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialTimelineUpdate</td>
<td>Update functionality for BlueSpiceSocialTimeline</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Topic and discussion entities for</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>----------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialTopics</td>
<td>BlueSpiceSocial</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialWatch</td>
<td>Watch-functionality for BlueSpiceSocial-entities</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceSocialWikiPage</td>
<td>WikiPage entity and attachment functionality for BlueSpiceSocial</td>
<td>Communication</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceTagSearch</td>
<td>allows the integration of a configurable search field in articles.</td>
<td>Rich Articles</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceUEModuleBookPDF</td>
<td>export books to PDF format.</td>
<td>Book</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceUEModulePDFRecursive</td>
<td>export an article and included links to PDF format.</td>
<td>Export</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceUEModulePDFSubpages</td>
<td>export an article and subpages to PDF format.</td>
<td>Export</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceUEModuleTable2Excel</td>
<td>extension for the integration of the table export to Excel into the Universal Export.</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceUserInfo</td>
<td>Provides a popup with user information</td>
<td>Search and Navigation</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceVisualDiff</td>
<td>Enables users to easily compare two versions of a page</td>
<td>Quality Assurance</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceWebDAVCClientIntegration</td>
<td>Allows opening files from the browser directly in the client application (Requires WebDAV)</td>
<td>Document Management</td>
<td>GPL v3</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enables saving minor changes. (Needs</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------</td>
<td>-----------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceWebDAVMinorSave</td>
<td>WebDAV)</td>
<td>Document Management</td>
<td>GPL v3</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>BlueSpiceWikiExplorer</td>
<td>provides a special page with an article list, which can be filtered and sorted.</td>
<td>Quality Assurance</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>DrawioEditor</td>
<td>integration of diagrams.</td>
<td>Rich Articles</td>
<td>MIT</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Duplicator</td>
<td>Provides a page to simply create copies of articles.</td>
<td>Administration</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>External Data</td>
<td>allows for using and displaying values retrieved from various sources: external URLs, local wiki pages and local files (in CSV, GFF, JSON and XML formats), database tables, and LDAP servers.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>FlaggedRevs</td>
<td>Allows for article content management by editors and reviewers.</td>
<td>Quality Assurance</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>FlaggedRevsConnector</td>
<td>this enables to save articles in drafts and to release articles after a review process.</td>
<td>Infrastructure</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Header Tabs</td>
<td>displays top-level headers as JavaScript-based tabs.</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>InsertTemplate</td>
<td>provides a dialog interface to add and modify templates in edit mode. A preview can be shown.</td>
<td>Editor</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ermöglicht die</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------</td>
<td>---------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>LDAPUserInfo</td>
<td>Synchronisation von Benutzerinformation und Einstellungen mit einer LDAP Ressource.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>LatexRenderer</td>
<td>Renders LaTeX markup on a Windows server.</td>
<td>Rich Articles</td>
<td>GPL v3</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Maps</td>
<td>allows users to display maps and coordinate data using multiple mapping services.</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Math</td>
<td>Renders mathematical formulas between math tags</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>MultimediaViewer</td>
<td>Provides a better experience to users when they click on thumbnails</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>NSFileRepo</td>
<td>implements per-namespace group permissions for image and file rights protection.</td>
<td>Document Management</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>NativeSvgHandler</td>
<td>Display of graphics in SVG format</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>OpenLayers</td>
<td>basic library for the grafical representation/chart of semantic data.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Page Forms</td>
<td>Forms for creating and editing wiki pages</td>
<td>Content Structuring</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Page Schemas</td>
<td>defines the data structure for all pages in a category using XML.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>PagelImages</td>
<td>Collects information about images used on page</td>
<td>Infrastructure</td>
<td>WTFPL</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>-----------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>ParserHooks</td>
<td>adds a OOP and declarative parser hook interface.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Popups</td>
<td>Displays previews when the user hovers over a page link</td>
<td>Search and Navigation</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Scribunto</td>
<td>provides a framework for embedding scripting languages into articles.</td>
<td>Infrastructure</td>
<td>GPL v2+ and MIT</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Semantic Compound Queries</td>
<td>defines a parser function, #compound_query, that can make multiple Semantic MediaWiki queries at the same time.</td>
<td>Data Analysis</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Semantic Extra Special Properties</td>
<td>Adds some extra special properties to all pages</td>
<td>Data Analysis</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Semantic Internal Objects</td>
<td>defines a parser function, #set_internal, that is used to define &quot;internal objects&quot; or &quot;n-ary relations&quot; within Semantic MediaWiki.</td>
<td>Data Analysis</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Semantic MediaWiki</td>
<td>allows users to add structured data to wiki pages through simple wikitext markup that turns links to other pages and data values in a page into meaningful properties. With this information, SMW helps to search, organize, browse, evaluate, and share the wiki's content.</td>
<td>Data Analysis</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Description</td>
<td>Use Case</td>
<td>License</td>
<td>Aktivated</td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
<td>----------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>Semantic Result Formats</td>
<td>Adds further formats to render inline query results.</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Semantic Scribunto</td>
<td>A Semantic MediaWiki extension to natively support the Scribunto extension</td>
<td>Infrastructure</td>
<td>GPL v2+ and MIT</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>TemplateData</td>
<td>Implement data storage for template parameters (using JSON)</td>
<td>Content Structuring</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>TextExtracts</td>
<td>Provides plain-text or limited HTML extracts of page content</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Validator</td>
<td>provides generic parameter handling support to other extensions.</td>
<td>Infrastructure</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>WebDAV</td>
<td>Adds a WebDAV endpoint that exposes the wiki content</td>
<td>Document Management</td>
<td>GPL v3</td>
<td>no</td>
<td></td>
</tr>
<tr>
<td>Widgets</td>
<td>integration of external content from social media sites.</td>
<td>Rich Articles</td>
<td>GPL v2</td>
<td>yes</td>
<td></td>
</tr>
</tbody>
</table>

Additionally required licenses

BlueSpice is delivered free of legal defects and without hidden additional licenses. There is only one extension which charges an additional fee for the enhancement of the existing function:

- **PHPDOCX Pro**: This additional license is only needed if you want to use the export to DocX format.

Avatars
**BlueSpiceAvatars** handles profile images of wiki users. If a user does not upload a profile image, an automatically generated avatar is used instead.

### Changing the profile image

The profile image appears throughout the wiki on pages that have been edited by the user. Clicking on the image leads to the user’s profile page. The profile image is also used for the user menu in the main toolbar.

To change the profile image to an avatar:

1. **Click** *Preferences* in the user menu.
2. **Click** *Change profile picture* on the user profile tab.

   ![Change profile image]

3. **Upload** an image or **create** a random avatar image.
4. **Save** your preferences at the bottom of the page.

Alternatively, you can change the profile picture directly on the profile page. The profile page can be accessed from the user menu under *My profile*. There, you click on the "dotted" menu icon. Click *Userimage* to load the profile picture dialog window.

![Changing the profile picture from the profile page]

### Configuration

An administrator can configure which generator is used for creating avatar images.

Go to *Global Actions > Config manager* and select the Extension *BlueSpiceAvatars*. Here, you can change the default generator for the automatic creation of avatars.
An avatar image is automatically generated if the user does not upload a profile picture or if the user decides to create an avatar image in the preferences.

- **Generator**
  - **InstantAvatar**: Generates an avatar image based on using the initials of the Real name or the Username
  - **Identicon**: Generates an avatar image based on parts of the user’s IP address.

**Related info**

- [Reference:BlueSpiceAvatars](#)
Dashboards

The Dashboard page provides a number of portlets for reviewing some important wiki data on a single page.

### Contents

1. About dashboards .......................................................... 270
2. Customizing the dashboard ............................................. 271
3. Available portlets .......................................................... 271
4. Related info ........................................................................ 271

### About dashboards

There are two different types of dashboards — user and admin dashboards. Every user has their own user dashboard that can be adjusted differently for each user. Users with admin rights have an additional admin dashboard that is also configurable to their needs.

Clicking on the dashboard links in the user menu loads the pages Special:UserDashboard or Special: AdminDashboard.
Customizing the dashboard

Users can customize the dashboard to their needs by using the following functionality:

- **Removing a portlet**: clicking on the "x" icon in the portlet title bar removes the portlet from the dashboard.
- **Adding a portlet**: Clicking on the "Plus" button in the top right corner of the page shows the list of available portlets. Clicking on a portlet name adds the portlet to the page.
- **Collapsing a portlet**: Clicking on the arrow in the portlet title bar expands/collapses the portlet content.
- **Re-arranging portlets**: The portlets can be re-arranged via drag & drop functionality. Hover over a portlet title on the page and drag it on a new location by keeping the left mouse button pressed.
- **Portlet settings**: Clicking on the cogwheel in the portlet title bar allows to set the height of the portlet. Depending on the portlet content, other settings can be adjusted as well.

Available portlets

The following portlets are available for users to add to their dashboard page:

- Assignments
- Calendar
- Most active users (by edits)
- Most edited pages
- Most viewed pages
- My edits
- Number of content pages
- Number of edits
- Number of pages
- Number of users
- RSS feed
- WikiPage (custom portlets)

Related info

- Reference:BlueSpiceDashboards

Personal navigation

The extension **UserSideBar** lets users create their personal sidebar navigation.
Accessing the personal navigation

Every logged-in user has their own UserSidebar. It is located in the left navigation as the Personal navigation tab (clipboard icon).

Default content

Initially, for users who haven't customized their personal sidebar, the navigation shows the following widgets:

- Pages visited (widget PAGESVISITED)
- My edits (widget YOUREDSITS)
- Watchlist (widget WATCHLIST)

These widgets can be removed individually when a user customizes the sidebar.

Customizing the sidebar

To customize the content of this sidebar, click on Edit sidebar at the bottom of the sidebar after hovering over any menu item. This opens the page User:<username>/Sidebar.
The syntax used to define the sidebar corresponds to the main MediaWiki sidebar (MediaWiki:Sidebar). Entries starting with a single star ("*") are considered menu headings or sections while entries with two stars ("**") are considered menu items.

* My favourite pages
  ** [[Wiki_Page1|Label]]
  ** [External_Page2 Label]

The sidebar can contain multiple sections. Also, users can use widgets to display predefined lists of pages, as described above. Widgets should be inserted as sections (with one star), like:

* WATCHLIST
  * My custom section
  ** [[Page1]]
  ...

Related info

- Reference:BlueSpiceUserSidebar

Preferences

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 What are user preferences?</td>
</tr>
<tr>
<td>2 User profile</td>
</tr>
<tr>
<td>2.1 Basic Information</td>
</tr>
<tr>
<td>2.2 Internationalisation</td>
</tr>
<tr>
<td>2.3 Signature</td>
</tr>
<tr>
<td>2.4 Email options</td>
</tr>
<tr>
<td>3 Appearance</td>
</tr>
<tr>
<td>3.1 Skin</td>
</tr>
<tr>
<td>3.2 Reading preferences</td>
</tr>
<tr>
<td>3.3 Date format</td>
</tr>
<tr>
<td>3.4 Time offset</td>
</tr>
<tr>
<td>3.5 Files</td>
</tr>
<tr>
<td>3.6 Diffs</td>
</tr>
<tr>
<td>3.7 Advanced options</td>
</tr>
</tbody>
</table>
What are user preferences?

As a BlueSpice user, you can customize a lot of settings to make your wiki experience more personal and more efficient.

For example, you may want to show a real photo of yourself or maybe you prefer a randomly generated image. You can also set when and how you want to be notified about changes that are happening on your wiki. To find content tailored to your needs, you can even exclude entire namespaces from your search results if you only need information from particular areas of your wiki.

Just remember that all settings only affect your own wiki experience (except for your profile information, of course, which is visible to all users).

To access your preferences:

1. Click on the user menu.
2. Click Preferences. This opens the preferences page with multiple tabs.

Alternatively, you can access the page Special:Preferences directly.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.8 Context menu</td>
<td>280</td>
</tr>
<tr>
<td>3.9 Dashboards</td>
<td>280</td>
</tr>
<tr>
<td>3.10 Player</td>
<td>280</td>
</tr>
<tr>
<td>3.11 Timeline</td>
<td>280</td>
</tr>
<tr>
<td>3.12 BlueSpice Calumma settings</td>
<td>281</td>
</tr>
<tr>
<td>4 Editing</td>
<td>281</td>
</tr>
<tr>
<td>4.1 General options</td>
<td>281</td>
</tr>
<tr>
<td>4.2 Editor</td>
<td>281</td>
</tr>
<tr>
<td>4.3 Preview</td>
<td>283</td>
</tr>
<tr>
<td>4.4 Reminder</td>
<td>283</td>
</tr>
<tr>
<td>4.5 Timeline</td>
<td>283</td>
</tr>
<tr>
<td>5 Recent changes</td>
<td>284</td>
</tr>
<tr>
<td>5.1 Display options</td>
<td>284</td>
</tr>
<tr>
<td>5.2 Advanced options</td>
<td>284</td>
</tr>
<tr>
<td>5.3 Edit review</td>
<td>284</td>
</tr>
<tr>
<td>6 Watchlist</td>
<td>284</td>
</tr>
<tr>
<td>6.1 Edit watchlist</td>
<td>284</td>
</tr>
<tr>
<td>6.2 Display options</td>
<td>284</td>
</tr>
<tr>
<td>6.3 Advanced options</td>
<td>285</td>
</tr>
<tr>
<td>6.4 Token</td>
<td>285</td>
</tr>
<tr>
<td>7 Notifications</td>
<td>285</td>
</tr>
<tr>
<td>7.1 Email options</td>
<td>285</td>
</tr>
<tr>
<td>7.2 Notify me about these events</td>
<td>286</td>
</tr>
<tr>
<td>7.3 New message indicator</td>
<td>286</td>
</tr>
<tr>
<td>7.4 Notifications on namespace events</td>
<td>286</td>
</tr>
<tr>
<td>7.5 Notifications on categories</td>
<td>286</td>
</tr>
<tr>
<td>7.6 Review</td>
<td>286</td>
</tr>
<tr>
<td>8 Extended Search</td>
<td>286</td>
</tr>
<tr>
<td>9 Semantic MediaWiki</td>
<td>287</td>
</tr>
<tr>
<td>10 Resetting all preferences</td>
<td>287</td>
</tr>
</tbody>
</table>
User profile

Basic Information

- **Real name**: This name is shown throughout the wiki. When users hover over your real name, your profile picture and contact information is shown.

- **Change password**: If your wiki is not connected with the central authentication system of your company, you can manage your password here.

- **User image**:
  - **User image** text field: Enter the webaddress of a picture on another website and click **Save** at the bottom of the page. The profile picture points directly to the external image:
  - **Change profile picture** link: Upload an image to the wiki. Click **Browse** and then **Upload** to create a new profile image. If you click **Generate new avatar**, the system generates a graphic instead.

- **Privacy policy** acceptance checkbox: Select and save this checkbox setting to confirm that you accept the privacy policy. Administrators can review this setting for all users on the page [Special:Privacy_Admin](https://www.example.com/Special:Privacy_Admin).

Internationalisation

- **Language**: Users can change their personal language that is used in the layout and menus. BlueSpice currently supports de-formal-German (formal), de-German and en-English.
- **How do you prefer to be described?** Option for setting your gender preferences.
Signature

- **Your existing signature**: shows a preview of your current signature including your profile info when you hover over the link.
- **New signature**: Enter a new name for your signature and save the Preferences page.
- **Treat signature as wikitext**: Your signature will be shown as text-only.

Email options

If you provide an email adress, you can specify to receive email notifications in addition or in place of wiki notifications. As long as the email adress is not confirmed, the system will not send emails. This also affects the settings in the Notifications tab.

If you want to exclude minor page edits from email notifications, you need to set it under the email options here.

Appearance

Skin

If your wiki has more than one skin, you can choose the layout of your wiki here. It only affects your view of the wiki. All other users see the skin that is selected in their preferences.

Reading preferences

You can set if you want to see quick summaries of a page before you click on a link. This requires that the page has some intro text before the first heading on a page.

Date format

You can set how you would like to see the timestamp on wiki pages, for example the timestamp of a user signature on a discussion page.

| **Rodrigue (talk) 09:10, 3 December 2019 (CET)** |
| date format example |

Time offset

- **Server time**: Shows the server time so that you can compare it to your local time.
- **Local time**: Shows the time set in the time zone setting.
- **Time zone**: When you select a time zone, your local time will be shown throughout the wiki wherever there is a timestamp.
Files

- **Image size limit**: Sets the maximum size of the preview image on the file description page.

- **Thumbnail size**: Sets the size of the thumbnail image on a page if no custom size is specified in the image settings.

- **Enable Media Viewer**: If this checkbox is not selected, image links on a page will load the file description page rather than the media viewer overlay.
Diffs

- **Do not show the page content below diffs**: Turns off the VisualDiff view as well as the wikitext view of revisions. Revisions are only shown in classic view.

- **Don't show diff after performing a rollback**:

Advanced options

- **Link underlining**:
  - **Always**: Underlines all links in the content area of a page, even if the selected skin specifies no underlining. The table of contents is not affected by this setting.
- Never: Never underlines links in the content area of a page, even if the selected skin specifies underlining.
- Skin or browser default: Keeps the link settings as specified in the skin.
- Threshold for stub link formatting: Determines when the target page is considered short enough to change the link color to a page that fits the threshold criteria. If you choose 50 bytes, a link to a page with less than 50 characters (including wikitext), will be marked as a stub link and be shown in a different color. This only works if your wiki skin has a separate color value for stub links defined.
- Show hidden categories:
- Auto-number headings: Adds heading numbers to the page headings
Context menu

Page links in the content area of the wiki show a context menu that allows to perform actions on the target page without having to go to the target page first. You can set whether you want to show the context menu with right-click or with right-click + Strg.

Dashboards

By default, the logo of your wiki links to the main page. You can change this and link to your user dashboard instead.

Player

When a page contains a video, you can set it to autoplay when you load a page.

Timeline

You can set the timestamp on the timeline entries in date format or as age.

Note: It can take up to 24 hours for all timeline entries to show the new timestamp format. When you create a new entry, you should see the changed format immediately.
BlueSpice Calumma settings

- **Automatically hide main menu**: Hides the main menu every time you load a new page.
- **Automatically hide tool menu**: Hides the tool menu every time you load a new page.

### Editing

#### General options

- **Enable section editing by right clicking on section titles**: Right-clicking a section title with the mouse sets the page in edit mode. The specified section can be edited immediately.
- **Editing pages by double clicking (JavaScript)**: Double-clicking on the page sets the page in edit mode. The double-click needs to be inside the text area of the page. Clicking in the title section of a page will not set the page into edit mode.
- **Show the pending changes diff when editing pages**:

#### Editor

- **Edit area font style**: Displays source code in monospace, serif, or sans-serif font.
**Mark all edits minor by default:** This automatically sets the minor flag in the save dialog. It can be selected or deselected in the save dialog on the page itself:

![Screenshot](image)

marking a minor edit

**Note:** Note: The 'Watch this page' checkbox in the save dialog can be activated or deactivated by default under the preferences tab *Watchlist* under *Advanced options: Add pages and files I edit to my watchlist.*

**Prompt me when entering a blank edit summary:** Displays a text message when you click *Save changes* reminding you to enter a summary description. If you do not enter a description after that, the page will save without the summary the next time you click *Save changes.*

![Screenshot](image)

edit summary prompt

**Warn me when I leave an edit page with unsaved changes:** When you reload or leave a page with unsaved edits, a warning message is displayed. You can confirm to leave the page or stay on the page and save your changes.
- **Show edit toolbar:** Disables VisualEditor in visual editing mode. Disabling is not recommended, as this reverts the editor back to a previous version of MediaWiki editor.

- **Temporarily disable the visual editor while it is in beta:** You can disable visual editor while it is in Extension:VisualEditor|beta mode. We recommend you do not disable VisualEditor unless you prefer to work with a previous visual editor version.

**Preview**

These preview settings are only applied if you have temporarily disabled VisualEditor and the edit text area is on the same page as the page preview. In BlueSpice 3.1+ you can generally ignore these settings.

- **Show preview on first edit:** The preview of the article is displayed when you click on "Edit"

- **Show preview before edit box:** If this option is deactivated, the preview will be shown under the edit form

- **Show previews without loading the page:**

**Reminder**

- **Default reminder period:** Prefills the date field for reminders with current date + x days specified here.

- **Set reminder on page creation:** When you create a new page, a reminder for that page is automatically created based on the default reminder period you entered.

- **Do not create reminder for the following namespaces:** Excludes namespaces from the automatic reminder on page creation.

**Timeline**

- **Warn me when I leave an edit of an entry with unsaved changes:** If unchecked, any unsaved changes to a social entity (such as blog entry, comment, microblog or discussion topic) will be automatically lost if you navigate to a different page or reload the page before saving your changes.

- **Skip dialog on discussion creation:** Automatically creates a discussion page when a user adds a discussion directly ona page and the discussion page for the entry does not yet exist. If this checkbox is unchecked, the user has to create the discussion page first before the discussion topic can be posted.
Recent changes

Display options

- **Days to show in recent changes:** You can set how many results are displayed on the page Recent changes.
- **Number of edits to show in recent changes,**

Advanced options

- **Group canges by page in recent changes and watchlist:**
- **Hide minor edits from recent changes:** Hide minor changes from appearing on your Recent changes page. This is useful if pages are saved a lot by a single user without major differences between the edits.

Edit review

- **Basic interface**
- **When to show the stable version...':** Here you can set to 'Always show the latest version for each page. This setting is only useful if the FlaggedRevs feature is active in a namespace. It is a useful settings for users with review permissions who can accept draft versions. Without this setting, the last stable version of a page is shown by default.
- **Show the pending changes diff when viewing the latest pending version:**

Watchlist

Edit watchlist

- **Edit entries on your watchlist:**
  - **View and remove titles on your watchlist:** Links to the page Special:EditWatchlist where you can manage your watchlist entries. The watchlist is organized by namespaces.
  - **Edit raw watchlist:** Links to the page Special:EditWatchlist/raw where you can remove pages by page name from a textbox. This list is also organized by namespaces.
  - **Clear watchlist:** Links to the page Special:EditWatchlist/clear where you can empty your watchlist with the click of a button.

Display options

- **Days to show in watchlist:** Presets the value in the selection menu Period of time to display on the page Special:Watchlist.
- **Maximum number of changes to show in watchlist:** Limits the number of changes that are displayed in your watchlist.

This example shows a default setting of 8 days and 20 changes.
Advanced options

Here, you select all the criteria for automatically adding pages and files to your watchlist and for showing certain changes on your watchlist.

Token

- **Watchlist token:** The token can be used to create a public RSS feed to your watchlist. Anyone who knows this token can access the feed. The syntax for the feed URL is: https://[YourWikiDomain]/w/api.php?action=feedwatchlist&wloner=[USERNAME]&wltoken=[TOKEN].

Notifications

Here you can set how and when you would like to receive notifications in email and/or in the notifications area of your user profile (Web notifications). If you haven't received email notifications yet, make sure that your email address has been verified. This information is available in the User profile tab, under the section Email options.

To view your Web notifications, go to your User profile menu and select Notifications.

The user profile image in the main toolbar and the Notifications menu item show the number of new notifications. Notifications can set for a variety of events, such as new assignments or reminders. You can also select to be notified about changes only in certain namespaces or categories.

To configure which notifications you want to get, click on Preferences in the Settings menu (3).

Email options

You can specify how often you receive emails: never, immediately, daily, or weekly.
If you unexpectedly don't receive emails for notifications, check under the User profile tab to make sure that you have already confirmed your email account.

**Notify me about these events**

Notifications can be displayed in the Notifications page of the wiki. This functionality is provided by the MediaWiki extension *Echo*.

**New message indicator**

This setting currently has no effect in BlueSpice. It is a configuration setting for the MediaWiki extension [Extension:Echo](https://github.com/xamster) (echo-show-alert).

**Notifications on namespace events**

Select for which namespaces you want to receive notifications.

**Notifications on categories**

Select for pages in which categories you want to receive notifications.

**Review**

- **Notify me about changes if I am the owner of a review**: Select if you want to be notified in email of any workflow changes of a review workflow if you are the owner of the review.
- **Notify me about changes if I am the reviewer of a review**: Select if you want to be notified in email of any workflow changes of a review workflow if you are the owner of the review.

Under the settings for Notify me about these events, you can set if and how you want to be notified if someone assigns a review task to you.

**Extended Search**

Here you can set which namespaces you want to include in your search results. This can be useful if you work in only some areas of the wiki or if you are looking for information in a few areas of your wiki only.
Semantic MediaWiki

These user preferences are provided by Semantic MediaWiki. If you would like to change these settings, you can visit the corresponding help page.

Resetting all preferences

If you click Restore all default settings (in all sections), all your customizations on all tabs are reset to their default settings. Since this could affect lots of customized settings, a warning page appears before the reset.

You can use this page to reset your preferences to the site defaults. This cannot be undone.

Restore all default settings (in all sections)

restoring default settings

Use the browser's back button if you do not want to restore the default settings.

Privacy center

BlueSpicePrivacy is an extension that enables users to control the way their data is collected and used by the wiki. Users interact with this extension through the Privacy center page, which is accessible by clicking Privacy center in the user menu.

Contents

1 Cookie consent .......................................................... 287
2 Privacy Center ............................................................. 288
  2.1 Anonymization ......................................................... 289
  2.2 Delete your account .................................................. 289
  2.3 Transparency ........................................................ 290
  2.4 Privacy policy consent .............................................. 290
3 Requesting actions ...................................................... 291
4 Reviewing user requests .............................................. 292
5 Related info ............................................................ 293

Cookie consent

Users are presented with a prompt to accept the cookies that the wiki collects. This prompt appears when a user visits the wiki for the first time or after deleting the browser cookies.
Here, users have the option to accept all cookies or to manage each group of cookies separately. This is done by opening *Cookie consent settings* and then using the toggle-switches in the prompt. There are different types of cookies, based on the function they perform:

- **Necessary cookies**: Cookies that are needed for the user to be able to use the wiki (cookies for keeping session information, user ID data, and so on).
- **Convenience cookies**: Cookies that provide a more comfortable wiki experience (saving the state of components of the interface, some user preferences, and more)
- **Matomo** (visible only if the *necessary plugin* is installed and activated): Cookies that are used for site analytics.

By default, accepting at least the necessary cookies is mandatory before using the wiki for the first time.

Cookie settings can be changed afterwards at any point by clicking on "Change cookie consent" in the wiki footer links or on the page [Special:PrivacyCenter](https://example.com/Special:PrivacyCenter).

**Privacy Center**

The privacy center is the hub for a user's privacy settings. It is located in the profile menu (by clicking on user image in the top right corner) or by navigating directly to the page [Special:PrivacyCenter](https://example.com/Special:PrivacyCenter).
This special page consists of a number of "modules". Each module performs a privacy-related function.

Anonymization

In this section, users can anonymize their account on the wiki. This means that users can change their username on the wiki. The new username appears wherever the username is used, including comments, page histories and logs. All traces of previous user information including profile information and profile data is removed or renamed.

To anonymize their account, users pick the new username (a random anonymized username is offered by default) and click "Anonymize my account". After confirmation, the process of anonymization starts, and the user receives a notification upon completion.

**Note:** Changes made in the Privacy center, for example anonymization, can take up to 24 hours to be effective (until the cache expires).

Delete your account

Users can delete all traces of their account from the wiki by clicking the "Delete your account" button. After confirmation, the user account is deleted. In case there is an error in the process, users will be notified of the failed deletion process.

By deleting their account, users will remove all references to their user account anywhere on the wiki. All of the user's contributions are then attributed to "Deleted user", which will appear instead of the original username.
Transparency

This module allows users to view and export all data the wiki has collected about them. To only view the data, without exporting it, a user can click on the button *Show all data*. This opens a dialog containing all of the user's data. The data is grouped by:

- **Mentions in content**: Snippets of the page content where the user's name is mentioned.
- **Working data**: Data from extensions - reminders, page assignments, etc.
- **Personal data**: Profile data, personal information and the user's status on the wiki.
- **Action data**: Log data for users actions - edits, page deletions, page moves and administrative actions.

To export the data, the user selects the groups to export and the export format (HTML or CSV). After clicking *Export data*, the user can download the compiled file.

**Privacy policy consent**

In this section, users can change their consent to the wiki's privacy policy. Further options may appear based on a specific wiki configuration. Users can also change their cookies consent (as described above).
### Requesting actions

#### Privacy center

**Overview of your privacy settings**

- **Anonymization**
  You can anonymize your account, by replacing all occurrences of your username with a new username.
  - New username: anon7456
  - [Anonymize my account](#)

- **Delete your account**
  You can completely delete your account from the wiki, along with all traces of your username.
  - [Delete your account](#)

- **Transparency**
  View and export all the data wiki has collected on you.
  - [Show all data](#)

- **Export your data**
  View and change your privacy policy agreement settings.
  - Types of data:
    - Personal data (e.g. email, name, profile info etc.)
    - Working data (e.g. Reminder, Assignments etc.)
    - Log data (e.g. contribution history, administrative actions etc.)
    - Mentions in content (e.g. articles, timeline entities, comments etc.)
  - Export format:
    - HTML
    - CSV
  - [Export data](#)

- **Privacy policy consent**
  View and change your privacy policy agreement settings.
  - [I accept the privacy policy of this site](#)
  - [Change cookie consent](#)
  - [Save](#)

The wiki can be configured so that users are not allowed to directly execute certain privacy-related actions. They need to request that operation first.

**Requesting actions applies to:**

- Anonymization
- Delete your account
Requests can be enabled for the wiki by setting `$bsgPrivacyEnableRequests = true;` in `LocalSettings.php`.

Once enabled, users will be presented with a request form in the affected sections. In this form, users can click **Request anonymization** and **Request account deletion** respectively. For account deletion, users can enter an optional comment explaining the reason for the request.

All submitted requests are sent to wiki admins for review.

After submitting the request, a user sees a **request pending** notice in the Privacy center. If the request is denied, the user is notified with a comment from the wiki administrator. If the user's request is approved, the user also receives a notification.

### Reviewing user requests

Wiki admins (users with "admin" role) can access the **Privacy Admin** page located in **Global actions > Management** or by navigating to **Special:PrivacyAdmin**.

This page lists the submitted requests. Administrators can review and approve or deny them.

In addition, administrators can see the status of the **Privacy policy consent** for every user on the wiki on this page.
Related info

- Reference:BlueSpicePrivacy

Visited pages

The extension **PagesVisited** creates a list of your recently visited pages.

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Personal navigation</td>
</tr>
<tr>
<td>2 Embedding the tag on a page</td>
</tr>
<tr>
<td>3 Related info</td>
</tr>
</tbody>
</table>

Personal navigation

The functionality is integrated in the **personal navigation menu** (clipboard icon). If it has been removed, it can be re-added on the page *User:<username>/Sidebar*. This page is loaded when the *Edit sidebar* link at the bottom of the sidebar is clicked. This link is visible when you hover over any existing navigation item.

To display recently visited pages add the following item to the page:

* PAGESVISITED
Embedding the tag on a page

While in source edit mode, enter the following tag anywhere on the page.

```html
<pagesvisited count="10" />
```

The list of recently viewed pages will appear at the place in the page where the tag was inserted.
Options that can be passed to the tag are:

- `count` - number of pages to show
- `maxitleength` - maximum length of each shown page
- `namespaces` - list of namespaces from which to show pages. Multiple namespaces can be entered, separated by comma.
- `order` - sorting of the pages displayed - can be "time" or "pagename"

Inserting the `PagesVisited` tag

Related info

- Reference:BlueSpicePagesVisited

CategoryCheck

The extension **CategoryCheck** reminds users to assign a category to a page before saving it.
Using the category check

To use this feature, it must first be enabled for individual namespaces in the Namespace manager.

When saving a page in a namespace that has the category check enabled, the user is reminded to assign a category before saving. This message only appears if the page does not have at least one category assigned. The page can still be saved without assigning a category, but the user must explicitly check the "Ignore" checkbox.
Create a review

BlueSpiceReview is a workflow tool for MediaWiki. It allows assigning users to a page who then should complete their review within a certain timeframe.
The review page

All relevant info can be accessed from the Review flyout in the Quality management tools. This screen shows the review settings. If a review is running, users see a form to cast their votes. They can also expand the collapsed workflow settings to see the details for this review.

Starting a review

All users with sufficient permissions can start (or edit) a review on a page.
Possible settings:

- Start date of the review
- End date - date on which review expires and that page is considered reviewed even if no action from reviewers occurred. It has no effect on the review itself.
- Type - review type determines what will happen to the page once the review has been successfully completed. The default type is Approval so that it can be used in conjunction with the Approval feature if this feature is activated in a namespace. Currently, BlueSpice only ships with this one type out-of-box.
- Reviewers grid - a list of all reviewers assigned to review a particular page. Reviewers can be added by clicking on the "Plus" button above the grid and typing in the name of the user in the dialog that pops up. Existing reviewers can be removed by selecting a reviewer and clicking on the "x" button.
- Additional options - depending on the wiki configuration, additional options may appear. See BlueSpiceReviewExtended for more information.

A review can only be started if at least one review has been added. Once all settings are set, click save to start the review. At this point, all assigned reviewers receive a notification (depending on their notification settings) that there is a review pending, and that they need to review it. During the review process, editing of the page is disabled unless the setting to allow editing has been activated.

 Casting votes

When assigned reviewers visit that page, they are prompted to cast their vote.

The voting form consists of:

- Comment box - here reviewers can explain the reason for their vote
Agree button - by clicking this button, users cast a "yes" vote and agree to the proposed version of the page.

Disagree button - by clicking this button, users cast a "no" vote and reject the proposed version.

Delegate button - users can delegate their assignment to another user. This button opens a dialog for delegating the vote.

All votes along with comments are displayed under "Recent workflow steps" in the same flyout as the vote form and in the page history.

Review overview

The page Special:Review provides an overview of all ongoing reviews. It can be accessed from the main navigation under "Global actions", item "Review". Clicking on an individual review opens a list of all reviewers assigned to review this page along with their votes (indicated by the eye icon before the username). A grey eye icon means the reviewer has not yet reviewed the page, green means a "yes" vote, while red means a "no" vote.

Configuration

In the Config manager, you can change the following settings:

- **Only the owner of a review can change it:** If this is unchecked, any user with edit rights can update a workflow.
Expiry

Expiry marks a wiki page as "obsolete". The page can be updated by editing or by confirming that the page is still up-to-date. Expiry is the ideal basis for an archiving system. Outdated articles can be moved to an archive after being queried. Expiry can be set on any content page of the wiki.

## Contents

1 Expiring a page ................................................................. 301
2 Overview of expired wiki pages ................................................................. 302
3 Configuration ................................................................. 303
4 Related info ................................................................. 304

### Expiring a page

![Screenshot of Expiry feature in BlueSpice]

**TestPage**

**Attachments**

**Discussions**

No discussion page has been created yet.

Create new discussion
Expire a page can be set from the Quality management tab in the page tools. After clicking on “Expire”, a form opens in a fly-out layer.

If the page has already been expired, the expiration date is shown. In this case, a user can remove the expiration from the page by clicking on Unexpire the page.

If no expiration date is set, users can set an expiration date and enter a short comment. In addition, the user can create a reminder for the page. After saving the form, the page is reloaded and updated information is displayed.

Overview of expired wiki pages

Users can see all of the pages set to expire, along with expiry information for those pages on Special:Expiry page. This page can be accessed from the Expiry flyout described above, by clicking on Expiry manager at the bottom of the flyout. All expiration dates can be deleted or edited from this page.
Configuration

In the Config manager, you can change the following settings:

- **Show watermark for expired pages in PDF**: Shows the watermark for expired pages in PDFs.
- **Show watermark for expired pages in print version**: Shows the watermark for expired pages when a page is printed.
- **Show watermark for expired pages**: Shows a watermark on the page itself.
The extension **FlaggedRevs** is a MediaWiki extension that activates an approval mechanism. New versions of a page are initially marked as drafts and remain so until a user with revision rights checks and approves the page.

### Contents

1 Activating the acceptance feature .................................................................................................................. 304
   1.1 Existing pages ........................................................................................................................................ 306
   1.2 New pages .............................................................................................................................................. 306
2 Accepting a page ............................................................................................................................................ 307
3 Setting read permissions for drafts .............................................................................................................. 308
4 Template changes ........................................................................................................................................... 310
5 Related info .................................................................................................................................................... 311

### Activating the acceptance feature

In BlueSpice, you can create draft versions of a page. Published or accepted versions of a page will be shown on the main page and the draft versions can be accessed by clicking on the status information of a page. This functionality is known as the **Acceptance** feature of your quality management tools. Activating drafts is done on the namespace level. A user with admin permissions checks that **FlaggedRevs** is activated for each namespace that should enable drafts. This is done in *Global actions > Management > Namespace manager.*
The dialog window opens after clicking the edit icon (wrench) in the *Actions* column. Select FlaggedRevs and click *Done*.

Each page in the namespace now displays a banner at the top of the page with the acceptance status (1) and a quick link to publish the page (2).
Existing pages

After activating FlaggedRevs for a namespace, all pages in the namespace are set in draft mode. Users with read permissions will always see the latest accepted version of a page. Since the existing page is considered accepted, all users can see the page content that was visible before FlaggedRevs was activated.

New pages

When a new page is created and first saved, it will automatically be visible to all users. If you do not want to show any information on the page, simply save the new page empty or with a short notification, such as "In progress" and immediately publish it:

Subsequent page edits will be collected in the draft version of the page. If a page is edited and saved multiple times while in draft mode, each edit gets logged in the version history:
The revisions during draft status have a dotted border and are highlighted in orange. In addition, they are marked as *pending review*. These revisions can be compared before the pending changes of the page are accepted.

**Accepting a page**

Users with *review* rights can accept a draft page any time they save a page (*Accept this unreviewed page*):

If the page is not accepted when the file is being saved, it can be accepted independently from the editing process.

A review user can accept the page quickly with the review feature in the title section of the page. The draft message will display an arrow which includes the *accept* function:

Alternatively, the reviewer can go to the Acceptance page in the Quality Management toolbar instead:
In both cases, the reviewer can leave a comment. This comment will then be shown in the version history of the page.

Although the acceptance feature uses the term first draft, there is no further distinction between drafts. A page is therefore either in first draft or in accepted status.

Once the page has been accepted and until it is further being edited, the page now shows the page version as accepted:

---

Setting read permissions for drafts

By default, all users can see the drafts of a page, even readers. In the default BlueSpice installation, users have the role “reader”.

---

Export: 18.10.2020   This document was created with BlueSpice   Page 308 of 374
To hide drafts from readers, the group *user* has to be removed from the configuration. An administrator deletes the group user form "Show unstable pages for the following groups" in *Global actions > Management > Config manager*:

**Warning:** If the group *user* is removed from the *BlueSpiceFlaggedRevs* configuration, users in this group will not be able to see draft versions when they are added as reviewers in a review process.

When the group user is removed, only *sysop* and *reviewer* users can access drafts. If you want other groups, for example *editor*, to see draft versions, you need to add them to the configuration and save it:
The two checkboxes *Automatically set the page to stable...* and *Automatically delete the workflow...* determine what happens at the end of a workflow, if there is an active Review for a page. A page can be set to accepted status by a workflow and the workflow can be deleted after the page is marked as stable.

**Note:** If no user groups are specified in the configuration field, not even reviewers and sysops users will see a visual status indication of a page. They will have access to drafts through the revision history of a page instead.

Anyone with edit permissions will receive a notification that there are pending page changes for the page when they access the page in edit mode:

Template changes

If a page uses templates and there is a change to the template page itself, it will also create a draft for this page. This will show up as a 0 Drafts () notice in your quality management toolbar under Acceptance. To update the page, simply click **review now** to see the changes and accept the change:
Related info

- [Reference:FlaggedRevs](#)
- [Quality management tools](#)

## Page assignments

The extension **PageAssignments** allows users with assignment rights to assign other users to a page.

### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 What are page assignments?</td>
<td>311</td>
</tr>
<tr>
<td>1.1 Characteristics</td>
<td>311</td>
</tr>
<tr>
<td>2 Assigning a page</td>
<td>312</td>
</tr>
<tr>
<td>3 Assignment management</td>
<td>312</td>
</tr>
<tr>
<td>4 My assignments</td>
<td>313</td>
</tr>
<tr>
<td>5 Related info</td>
<td>313</td>
</tr>
</tbody>
</table>

### What are page assignments?

Page assignments are a quick way of giving one or more users informal responsibility and ownership of a page. They are very similar to a watchlist. A user can add a page to their watchlist themselves, but users also create page assignments for each other.

Page assignments do not change the behavior of the page or grant special rights on a page. For example, the page does not get locked for editing when it is assigned to another user. It is rather a simple mechanism to have users “take a look” at a page. If the feature *Read confirmation* is activated for a namespace, assigned users have to confirm with a checkbox on the page that they have read the page.

### Characteristics

- Assigned users receive **notifications** when their page assignment is changed. (This can be deactivated in the user preferences.)
- Assigned users are **listed under the assignments** for the page in the Quality management menu of the page.
- The page is listed on the **Assignment management** page, which is accessed from *Global actions > Management* (Special:ManagePageAssignments)
- The **page is listed** on the Assignments manager page of the assigned user, which is easy to access from the user profile menu.
- **Namespace-specific:** if a namespace has *Read confirmation* activated, the page shows a read confirmation in the alert area of the page.

Assigning a page

To assign pages to other users, you need the appropriate rights. These are assigned via the roles *reviewer* and *maintenanceadmin*. Although users with *read* permissions can be assigned to a page, they cannot make changes to the page.

**To assign a user or a group to a page:**

1. **Click** on *Page assignments* in the *Quality management* toolbar.
2. **Type** a user or group name in the assignments text box. You will get automatic suggestions based on your entry.
3. **Click** the *Add* button.
4. **Add** more users or groups (optional).

---

**Assignment management**

Users with assignment rights can see a list of all pages that have assignments. This page (*Special: ManagePageAssignments*) can be loaded from the navigation menu under *Global actions >Management > Assignment management*
My assignments

Every user can view the pages they are assigned to by clicking on "Assignments" in their personal menu (by clicking on their image in the upper right corner).

Related info

- Reference page
The importance of content quality

For many companies, the quality of the information they produce and share is of great importance. At the same time, they want to capture all the knowledge of their employees without creating any unnecessary barriers.

In BlueSpice, it is very easy to do both. Anyone can contribute information right away and specialists can then review and approve the content. This ensures that the quality of the content meets the standards of the company.

For quality assurance purposes, each content page has the following built-in tools:

- Page information
- Page assignments
- Reminder (BlueSpice pro)
- Expiry (BlueSpice pro)
- Review (BlueSpice pro)
- Acceptance (BlueSpice pro - if FlaggedRevs is activated for the namespace)

To access these features, you open the QM tools (with the checkbox icon) in the Page tools area.
Page information

The page information gives you some very interesting statistics about the page. Based on this information, you can decide what quality management measures are necessary to improve the page.

The information that is listed on this page is:

- time of last edit and last editor
- number of views
- templates used on this page
- similar pages
- categories
- readers of this page
- authors of this page

Page assignments

Page assignments are a quick way of giving one or more users informal responsibility and ownership of a page. They are very similar to a watchlist. A user can add a page to their watchlist themselves, but users also create page assignments for each other.

Page assignments do not change the behavior of the page or grant special rights on a page. For example, the page does not get locked for editing when it is assigned to another user. It is rather a simple mechanism to have users "take a look" at a page. If the feature Read confirmation is activated for a namespace, assigned users have to confirm with a checkbox on the page that they have read the page.

Characteristics

- Assigned users receive notifications when their page assignment is changed. (This can be deactivated in the user preferences.)
- Assigned users are listed under the assignments for the page in the Quality management menu of the page.
- The page is listed on the Assignment management page, which is accessed from Global actions > Management (Special:ManagePageAssignments)
- The page is listed on the Assignments manager page of the assigned user, which is easy to access from the user profile menu.
- Namespace-specific: if a namespace has Read confirmation activated, the page shows a read confirmation in the alert area of the page.

More about page assignments

Reminder

A user can create a reminder for a page by selecting a reminder date and by adding an optional comment. Reminders can also be created for other users and are a quick and informal way of setting due dates for page-related tasks.
Characteristics

- The user with the reminder receives a notification. (This can be deactivated in the user preferences.)
- Users with reminders are listed on the reminders for the page in the QM tools.
- The page is listed on the Reminders special page under "Global actions" (Special:Reminder).
- The page is listed on the user's Reminders page, which is easy to access from the user profile menu.

Expiry

If a page contains content with a known lifecycle, the page can be set to expire on a particular date. On the expiration date, a watermark "Outdated" is added to the page if the corresponding option is set in the ConfigManager. The watermark is visible to logged-in users. In addition, a reminder can be set so that the user will receive a notification when the page expires. The expiration can be deleted from the page at any time.

Characteristics

- The page displays a watermark from the expiration date on. (Depending on the global configuration.)
- The page is listed on the Expiry special page under "Global actions" (Special:Expiry)

Review

When a more formal review process is necessary, users can create a review workflow. The review workflow has an end date and is the only quality management tool that can lock the page for editing during the review phase. Each user casts a vote whether the page is acceptable or not.

The page is listed on the special page "Review" under "Global actions" (Special:Review) and on the reviewers' personal Review page.

Characteristics of the review feature

- One active review process per page
- Sequential or parallel review
- Acceptance or rejection of steps
- Page is locked for editing (Exception: depending on the configuration, reviewers can get edit rights)
- Automatic restart
- Entries in the version history

Acceptance

If the pages in a namespace should have a published and a draft version, the setting FlaggedRevs needs to be activated for that namespace. This activates the Acceptance feature of the quality management tools.

All changes to a page are collected in a draft version until any user with review rights accepts the page. The pages in this namespace are in draft mode until a user with the right to publish content accepts the page.

There is a global option in the ConfigManager to define which user groups are allowed to read unpublished content. By default, all logged-in users can view drafts.
Characteristics of the acceptance feature

- Revisions-based
- "Freezes" embedded media and templates
- Often the result of a review process

Permissions overview

This permissions table shows which roles have the necessary right to perform different quality assurance actions. The name of the right that grants a certain permission is shown in parentheses:

<table>
<thead>
<tr>
<th>QA action</th>
<th>user (read)</th>
<th>editor</th>
<th>reviewer</th>
<th>admin</th>
<th>maintenance-admin</th>
<th>bot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can create and manage page assignments for any user</td>
<td>(pageassignments)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can be assigned to a page</td>
<td>(pageassigneable)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can create and manage reminders for any user (remindereditall)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can create and manage their own reminders (read)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can set and manage page expiration dates (expirearticle)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can create and manage review workflows <em>(workflowedit)</em></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Can be assigned to a review workflow <em>(read)</em></th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Can view the review workflow on the page <em>(workflowview)</em></th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
</tr>
<tr>
<td>x</td>
</tr>
<tr>
<td>x</td>
</tr>
<tr>
<td>x</td>
</tr>
<tr>
<td>x</td>
</tr>
<tr>
<td>x</td>
</tr>
<tr>
<td>x</td>
</tr>
<tr>
<td>Can view the complete list of reviews (workflowlist)</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Can approve a page (review)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Own changes are automatically approved changes (autoreview)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rollbacks are automatically approved (autoreviewrestore)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>
Related info

- Working with drafts (Flagged revisions)
- The review workflow

Read confirmation

The extension **ReadConfirmation** allows to request read confirmations from users. If a user is assigned to a page, a mandatory read confirmation can be added to the page.

### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Enabling read confirmations</td>
<td>321</td>
</tr>
<tr>
<td>2 Display</td>
<td>322</td>
</tr>
<tr>
<td>3 Administration of read confirmations</td>
<td>323</td>
</tr>
<tr>
<td>4 Related info</td>
<td>323</td>
</tr>
</tbody>
</table>

Enabling read confirmations

An administrator must enable read confirmations for the namespace the page belongs to. This can be set using the **Namespace manager**: 
Display

When read confirmations are active on a namespace, assigned users see a confirmation prompt. After checking the checkbox *Yes, I have completely read this article* and clicking *Confirm*, the page will be marked as read by that user.
Administration of read confirmations

Wiki admins can see an overview of all read confirmations by navigating to Global actions > Management > Assignment management. Read confirmation information is shown in the column Read on. A page can have multiple states:

- **Read confirmation not enabled**: BlueSpiceReadConfirmation is not enabled for the namespace to which the page belongs.
- **Not read**: BlueSpiceReadConfirmation is enabled, but the assigned users have not yet read the page.
- **Actions**: In the columns for actions, there are two items related to read confirmations.
  - Read confirmation log: Link to the read confirmation log for the page.
  - Request read confirmation: Users get a reminder for their read confirmation.

### Related info

- **Reference**: BlueSpiceReadConfirmation

### Manual: Redirects
What is a redirect?

A redirect is a technique to automatically forward users from one page to another. If you redirect a page that has content, the user will not see the content of the redirected page, but only the content of the target page.

When to use a redirect

Pages are usually redirected in the following cases:

- abbreviations
- synonyms
- duplicate content
- spelling variants
- plural/singular
- renaming/moving a page

How to redirect a page

With visual editing

1. Go to Page settings:
2. In the dialog window, activate the checkbox "Redirect this page to" and enter the name of the target page.

3. Click "Apply changes"

**With source editing**

At the beginning of the page, insert the redirect instruction and save the page:

```
#REDIRECT [[pagename of target page]]
```

There is no need to delete the content of the page. The content is simply no longer visible to readers as long as the redirect is included on the page. If you remove the code for redirecting the page, the original content will be loaded again.

**Managing page redirects**

All redirected pages on the wiki are listed on the special page Special:ListRedirects. In addition, there are pages for broken redirects as well as double redirects in the maintenance reports on the Special pages.

You can navigate to them from *Global actions > Special pages*.

To maintain the quality of your wiki, you should review these pages on a regular basis and fix any broken and double redirects.

If you navigate to a redirected page, it shows the redirect. A rounded arrow points to the target file:
Resolving double redirects

The page `Special:DoubleRedirects` lists all pages that are redirected from an already redirected page:

Let's look at the page `Edit existing articles` in the BlueSpice helpdesk. This page is redirected to a page `Create pages` that is again redirected to `Manual: Create pages`. The double redirect was caused by moving the page `Create pages` to the namespace `Manual`.

To resolve the double redirect, we open the page `Edit existing articles` in source view:

The page is not only redirected to the page `Create pages` but also contains a bookshelf tag. Therefore, we first check if the page is still part of the book. If it is, we need to decide if the book should include this page or the actual final target page of the redirect instead.
We now have some options to fix the redirect:

- Redirect to the final target page
- Redirect to a completely different page
- Delete the page

Since the helpdesk actually has an updated page about editing, we redirect to the page Manual:Edit pages:

```
#REDIRECT [[Manual:Edit pages]]
<!--
__NOTOC__<bsibookshelf src="Book:User manual 3.1 - incomplete draft" />
```

Sometimes, it might make more sense to simply delete the page. Before deleting an article, always check what other pages link to the page by reviewing the info under Special:WhatLinksHere/Redirects.

Related topics

- Rename and move pages
- Delete an article
- Creating subpages
- https://www.mediawiki.org/wiki/Help:Redirects

Manual:Review workflow

If you have a page that has to be reviewed by others before it should be published, you can use the review workflow of the page. The review can be started for pages with or without the revisions feature. If the revisions feature is turned on for the namespace in which the page is located, the page will be in draft mode and locked for editing until the review end date has been reached.

During the review phase, assigned reviewers will "vote" on the page and either accept or reject the page. If the extension BlueSpiceReviewExended is installed, the workflow can run sequentially or parallel for the reviewers and the reviewers can be allowed to edit the page. A reviewer also has the option to delegate a review task to a different user.
Use case: A basic review workflow

Anna and Phil are responsible for all content of the IT department of their company. They have many responsibilities and are not always able to create their IT wiki pages. They task Laila, the company’s intern, to write the draft for the new holiday policy. They tell Laila that she can include images on the page to make the page more eye-catching. Laila is happy about this task and gets to work right away. Anna reminds Laila to keep Phil in the loop and to have any images on the page reviewed by someone in marketing.

The review workflow consists of the following steps:

1. **Laila (author):** After finishing the changes to a page, Laila starts the review cycle for that page. Laila decides that Phil needs to proofread the page first, then Malik in Marketing will approve the images. Finally, Anna gives the okay to publish the page. Since Anna is very busy, Laila has set the workflow to run for 14 days. She sets the workflow so that all reviewers have to review the page in sequential order.

2. **Phil (first reviewer):** Phil proofreads the page and adds the correct categories to the page (IT, Policy). He then closes his review task by accepting the page.

3. **Malik (second reviewer):** Malik adds some professional graphics to the page and accepts the page.

4. **Anna (third reviewer):** Anna doesn't have time to review the document, since it is not one of her priorities. She delegates the final vote to Phil.
During the review period, the page has the following characteristics:

- It is **locked for editing** for the entire duration of the review period. Exception: The extension *BlueSpiceReviewExtended* allows the option to have the reviewers edit the page during the review period. In our example, the reviewers can make changes.
- It displays an alert message: "Page is currently being reviewed."
- The Review menu item in the QM tools shows "Review in progress".
- When a reviewer opens the QM tools, he is alerted by a "Vote!" notice on the Review menu item.
- For each reviewer who has completed their review, their action is shown under "recent workflow steps" on the review page.
- It is listed on the special page *Special:Review*.

### Technical requirements

The following extensions and configurations are part of the review functionality:

- **Extension: BlueSpiceReview**
- **Extension: BlueSpiceReviewExtended**
- **Config manager > Extension > BlueSpiceReview / BlueSpiceReviewExtended**

### Setting reminders

The extension **Reminder** allows users to keep track of pages by creating reminders for a particular date.

| Contents |
|-----------------|----------------|
| 1 Setting a reminder | 329 |
| 2 Manage reminders | 330 |
| 3 My reminders | 331 |
| 4 Related info | 332 |

### Setting a reminder

Reminders are set in the quality management tab of the page tools. The date can be set as a recurring event. It is a good idea to add some text in the comments page so that the list of all reminders on the wiki provides some context for each reminder. If other users have also set a reminder for the page, they are shown on the reminder flyout as well.
From the bottom of the page, users can load the pages *Manage reminders* and *My reminders*.

**Manage reminders**

Available only for wiki admins, the page *Special:Reminder* shows a list of all reminders for all pages and all users. Wiki admins can delete reminders or edit the due date and other details.
Reminder manager for wiki admins

My reminders

The page `Special:Reminder/USER_NAME` shows the reminders for the currently logged-in user. It has the same functionality as "Manage reminders", just in the scope of the current user.
WikiExplorer

The extension **WikiExplorer** allows to quickly filter and sort all Wiki pages based on your own filter criteria. WikiExplorer combines the functionality of many maintenance pages. By combining different filters, you can quickly find matching pages.

### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Accessing WikiExplorer</td>
<td>332</td>
</tr>
<tr>
<td>2 Choosing the sorting criteria</td>
<td>332</td>
</tr>
<tr>
<td>3 Sorting sequence</td>
<td>333</td>
</tr>
<tr>
<td>4 Using filters</td>
<td>333</td>
</tr>
<tr>
<td>5 Related info</td>
<td>334</td>
</tr>
</tbody>
</table>

### Accessing WikiExplorer

To access Wiki Explorer, go to *Global actions* and select *WikiExplorer*. This opens the special page *Special: WikiExplorer*.

### Choosing the sorting criteria

Sorting criteria and visible columns can be changed by clicking on the arrow icon in the header of any list column.
Sorting sequence

Clicking on the header of any column (not on the arrow) sorts the table based on the values of that column. Changing the sorting order (ascending, descending) can be switched by clicking on the header multiple times.

Using filters

For some content, there are specially adapted filters available which can be used to sort the list. Filters can be accessed by clicking on the "arrow" icon in the column that should be filtered.

The following columns support filtering:

<table>
<thead>
<tr>
<th>Content</th>
<th>Possible filters</th>
<th>Sortable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title (Page name)</td>
<td>starts with, ends with, contains, contains not, equals, equals not</td>
<td>Yes</td>
</tr>
<tr>
<td>Namespace</td>
<td>starts with, ends with, contains, contains not, equals, equals not</td>
<td>Yes</td>
</tr>
<tr>
<td>Accesses</td>
<td>less than, greater than, equals</td>
<td>Yes</td>
</tr>
<tr>
<td>Creation date</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Is redirect</td>
<td>None</td>
<td>Yes</td>
</tr>
<tr>
<td>Content</td>
<td>Possible filters</td>
<td>Sortable</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Last comment</td>
<td>None</td>
<td>Yes</td>
</tr>
<tr>
<td>Last edit date</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Size</td>
<td>less than, greater than, equals</td>
<td>Yes</td>
</tr>
<tr>
<td>Last editor</td>
<td>None</td>
<td>Yes</td>
</tr>
<tr>
<td>Categories</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Linked files</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Linked pages</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Links to this page</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Assigned editors</td>
<td>None</td>
<td>Yes</td>
</tr>
<tr>
<td>Released</td>
<td>yes, no</td>
<td>Yes</td>
</tr>
<tr>
<td>Release date</td>
<td>less than, greater than, equals</td>
<td>Yes</td>
</tr>
<tr>
<td>New version waits for release</td>
<td>None</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Related info**

- Reference: BlueSpiceWikiExplorer
Wiki maintenance made easy

Hopefully, your wiki content grows quickly and your users are busy adding and editing content. The faster your wiki grows, the more it becomes necessary to ensure that both your wiki content and its organization meet the requirements of your wiki audience. After all, the hard work everyone has put into the wiki so far should be reflected adequately. Your users don't want to waste any time when looking for information about a particular topic.

Luckily, the search engine is powerful enough to find the best matches to a user's search term. So even if you are falling a little behind with your wiki maintenance, users should still find their way around the wiki. But you can do a lot to make the user experience even better.

If you are tasked with maintaining the usability and content quality of your wiki, there are several types of tools to help you with this task.

Permissions

Any user with edit rights can view the special pages that are relevant for wiki maintenance. An exception is the special page Quality management overview. This page lists all pages that are in draft or accepted status and requires reviewer rights. This page only has entries if the FlaggedRevs feature is activated for at least one namespace and the user has access to that namespace.
Content monitoring

The quality management tools make the life of a wiki maintainer much easier. All wiki users can take advantage of the built-in features such as the watchlist, reminders, page assignments and the review workflow, for example. This helps users to take ownership of the wiki content right from the beginning. This works well on a page-by-page level.

As users link, move and delete pages, it becomes necessary, however, to monitor these changes. Over time, some pages might become neglected and add to the outdated content on your wiki.

To keep your content fresh, you should regularly take advantage of the maintenance pages of the wiki. The majority of these pages are part of MediaWiki and documented on MediaWiki.org. Use the searchbox on their website to find out more. Some maintenance pages are exclusive to BlueSpice, such as WikiExplorer, Assignment management and Quality management overview.

Accessing the maintenance pages

To view the most important maintenance pages, switch to the Global actions navigation. This navigation view contains the two menus Global actions and Management. Both menus contain useful links to the most common special pages. Click on Special pages to access the complete list of maintenance and reports pages:
Extended file list

The BlueSpiceExtendedFilelist extension provides a special page to interact with the wiki file repo. It features a friendly user interface that allows sorting and filtering by a variety of fields.

Working with the extended file list

The link Extended File list in the Global actions tab of the navigation loads the page Special:ExtendedFilelist.

Extended file list

In addition to a sortable and filterable overview of all files uploaded to the wiki, new files can be uploaded directly from the user interface.

Possible actions

The following functionality is available for this page:

- **Filter the list:** In the Filter input field, type in a search term to find matching files.
- **Clearing the filter:** Click on the X-icon to clear the filter field.
- **Upload new files:** Click the upload icon next to the filter field to add files to the wiki (multi-upload is possible). Alternatively, you can click on the magnifying glass in the filter field.
Filter by namespace: Select a namespace from the drop-down menu to show files from a particular namespace.

Browse results: Navigate through the different pages of the file list.

Change the results per page: Set how many files are shown per page.

Sort the file list: Click on any column header to change the sort order (ascending / descending). Alternatively, hover over any column header and click on the arrow to open the sort menu.

Show/hide columns: Hover over any header and click on the arrow to open the column filter. Select the columns you want to display.

Filter a column: Hover over any header and click on the arrow to open the column filter. Hover over Filter and type in a filter term.

Viewing the file: Click on the thumbnail image to open the file.

Viewing the file description page: Click on the file name to open the file description page.

Related info

- Reference:BlueSpiceExtendedFilelist

Manual: Special pages

Special pages are an important tool for wiki maintainers to track changes on the wiki and to view important information about all wiki pages. These pages have no wikitext, are not editable and are created by the software itself.

Finding special pages

To access a list of all special pages, click on Special pages in the Global actions menu or navigate directly to the page Special:SpecialPages. Some common special pages are also linked directly from the Global actions menu. All special pages are located in their own namespace Special: and are not editable directly as other pages. It is not possible to make a redirect to a special page, or to create content pages beginning with the Special: prefix.

Examples of special pages

There are many special pages available. Take some time to click through them and see which ones are useful to you. This list also contains all Special pages that are provided by BlueSpice. If you plan on using some special pages frequently and they are not already listed in the navigation, you can create links to them in your personal navigation.
Maintenance reports

- **Broken redirects**: This special page lists redirects to non-existent pages.
- **Dead-end pages**: pages which do not link to other pages in the wiki are listed here.
- **Orphaned pages**: pages listed here are not linked from or transcluded into other pages of the wiki.
- **Protected pages**: Here you can browse through namespaces for finding protected pages. For a more detailed search you can specify permission and restriction level and the size of the pages searched for.
- **Protected titles**: Single namespaces can be scanned for protected titles.
- **Uncategorized pages**: Lists all pages which are in no category.

List of pages

- **All pages**: Here all pages of the wiki are listed. You may narrow your search by choosing a namespace to search within or you decide upon a letter(combination) where your search shall start. Pagenames which start with a letter(combination) alphabetically before the chosen one will not be listed.
- **Categories**: All categories are listed which contain pages or media. Unused categories are not listed.
- **List of redirects**: Lists pages which have been redirected and the pages they have been redirected to.

Users and Rights

- **Active users list**: Shows the users that have had some kind of activity in the last 30 days.
- **Block user**: Shows a form in which users can be blocked. There are several options about expiry, reason and the blockage.

Recent changes and logs

- **Logs**: Shows all logs of the wiki. Alternatively, you can decide on a special log to be shown. Within a log you can also search for user and/or title and narrow the time span within which is searched.
- **Recent changes**: Lists changes which have occurred recently. You can decide how many changes shall be shown up to the last 30 days. You can also search within a namespace or exclude a namespace from search.
- **Related changes**: This is a list of changes made recently to pages linked from a specified page (or to members of a specified category). Pages on your watchlist are bold. Again you can search within a namespace or exclude a namespace from search. Or you can look for a page name or its linked pages.
Help categories

Data and tools

- **HalloWiki - Statistics**: Enables you to create a diagram about number of users, editings, number of articles, editings per user or search requests within a defined time span.

- **Popular pages**: Lists the pages which are most often viewed.

- **System messages**: Lists system messages which are available in the MediaWiki namespace.

Redirecting special pages

- **Random page**: Takes you to a page of the wiki which is chosen randomly.

- **Random redirect**: Takes you randomly to a redirected page of the wiki.

- **Search**: Allows you to search within chosen namespaces.

High use pages

- **Most linked-to categories**: Shows the categories which have most member-pages (displaying the number of members in brackets).

- **Most linked-to pages**: Lists pages that are most often linked to (displaying the number of links in brackets).

Page tools

- **Export pages**: Text and editing history of a particular page can be exported to another wiki via this form.

- **Import pages**: External pages can be imported as XML data here.

- **View deleted pages**: Pages that have been deleted can be found here.

- **What links here**: Enter page name (and choose a namespace) to get all internal pages that link to the page.

Data and tools


- **Replace text**: Global find and replace option for the wiki allows to replace the text on multiple pages at the same time.

Special pages filter

**FilterSpecialPages** enables easy filtering of the list of special pages.
Usage

The functionality provided by this extension can be found on `Special:SpecialPages`.

It adds a search box at the top of the page. Typing in this field provides search-as-you-type functionality, and will refine the list of special pages to match the search term.

Filter field for special pages

Clicking *Enter* when there is only one page in the search results opens the target page.

Clicking the *Esc* button highlights the text in the search field so it can be replaced easily.

FilterSpecialPages is an extension for MediaWiki. BlueSpice is not required. FilterSpecialPages can be used with the Vector skin, too.

Related info

- Reference:BlueSpiceFilterSpecialPages

Watchlist
With the watchlist, you can monitor all wiki pages that are important to you. In your preferences, you can customize when and how to be notified about different types of changes related to the pages on your watchlist. Your watchlist is only visible to you. Administrators can see a report of which pages are not on any watchlist.

### Contents

1 Watching and unwatching pages ................................................................. 342
   1.1 Automatic additions ............................................................................. 342
2 Settings ......................................................................................................... 343
3 Watchlist quick view .................................................................................... 343
4 Classic watchlist ........................................................................................... 344
5 Notifications ................................................................................................ 345
6 Sidebar widget ............................................................................................. 346
7 The watchlist tag .......................................................................................... 346
8 Related info .................................................................................................... 346

### Watching and unwatching pages

In the title section of a page, you can add the page to your watchlist. Click **Watch** to add the page to the watchlist. The link description switches to Unwatch. Click **Unwatch** to remove the list from your watchlist.

### Automatic additions

In addition to manually marking a page watched, there are several ways a page can be added automatically. For example, whenever you create or edit a page, that page can be added to the watchlist. You can change the options for this in the Watchlist settings in your **Preferences**.

**Important!** If you have deactivated the setting *Add pages and files I edit to my watchlist* in the settings, the check box *Watch this page* in the save dialog is not automatically activated. If you do not manually activate this checkbox when saving a page, a page that was on your watch list will be removed from the watch list when you save. Conversely, each page is automatically added to your watch list if this check box is selected by default. When saving, always check whether the edited page should (still) be on your watchlist.
Settings

Go to your user menu. Click Preferences and select the tab Watchlist to access the following settings:

- **Edit watchlist**: Links to the maintenance pages for the watchlist.
- **Display options**: Default settings for showing pages in your watchlist that have recently changed.
  - You can set 3-90 days of page changes.
  - You can set 250-1000 watchlist results.
- **Advanced options**: Settings for automatically adding pages to the watchlist or hiding page changes from the watchlist.
- **Watchlist token**: The token can be used to create a public RSS feed to your watchlist. Anyone who knows this token can access the feed. The syntax for the feed URL is: https://[YourWikiDomain]/w/api.php?action=feedwatchlist&wlowner=[USERNAME]&wltoken=[TOKEN]

**Watchlist quick view**

You can open a quick view of your watchlist from the user profile menu.
This opens an overlay with a filterable and sortable view of your watchlist directly on the current page. The watchlist indicates what pages on your pages have changes that are unread by you. Clicking on the icon for unread changes leads to the version comparison page so that you can quickly review the changes you haven't seen yet.

**Watchlist overlay**

**Classic watchlist**

From this overlay display, you can switch to the classic view of the watchlist. This loads the page `Special:Watchlist`:

- **View relevant changes**: This is the default watchlist page. It displays the filter menu with the legend.
- **View and edit watchlist**: Here you can delete entries from your watchlist.
- **Edit raw watchlist**: Loads an editable list of the page names on your watchlist.
- **Clear the watchlist**: Loads a page that clears your watchlist in the next step. Clicking this link will not clear the watchlist yet.
Note: Since many social entities are created automatically by the system, changes to pages in the namespace SocialEntity are filtered out by default. You can remove the filter to view changes to pages in this namespace.

Notifications

You can get notifications about all changes on that page.

To receive notifications, go to your Preferences and open the Notifications tab. You can select to get notifications about the following changes:

- **Actions on pages in watchlist:** A page was edited or deleted.
- **Entity actions on watched pages:** A discussion topic or an attachment was added, edited, or deleted.
Sidebar widget

The watchlist is, by default, is included in the user sidebar. It can be removed by deleting the entry *WATCHLIST.

The watchlist tag

You can include the watchlist in the page content by adding the tag `<bs:watchlist />`.

Example:

```
<bs:watchlist count="4" maxtitlelength="20" order="time" />
```

Output:

Related info

- Reference:BlueSpiceWatchList

About social content

**BlueSpiceSocial** is a set of extensions that add social features around a wiki page. It allows users to quickly communicate on the wiki and to express their opinion on pages.

User profile
Every user has a profile on the wiki. It is displayed on the user page (User:Username). Users can access their user profiles by clicking on My profile in the user menu which is located in the header toolbar.

The user profile shows the user's basic information (depending on the wiki setup) and the user's profile image. Below the user info, the user's wiki activities are listed: Comments the user made, actions on pages, and in general the user's activity on the wiki. It also allows other users to leave comments on the user's profile page.

**Timeline**

Timeline is a special page that provides an overview of all social conversations on the wiki.

By default, it is listed on the Main navigation. You can also access the page directly at Special:Timeline. On this page, users can sort and filter existing social entries or create new entries.

**Creating new entries**

To create a new entry, click on the "Plus" icon to add a new timeline entry:

- **Blog entry**: Blog is used for topics to be shared with other users on the wiki
- **Microblog**: Like a blog entry, but without titles. It should be used for a short entry, e.g., a quick announcement.
- **Discussion topic**: Adds a discussion entry to a particular wiki page.

**Interacting with social entities**

Every entry in the timeline is called a social entity. Depending on the type of social entity, the following interaction options exist:

- **Comments**: Number of comments related to the entity. Clicking on Comments opens all current comments and allows users to add a comment (if user has the necessary permissions).
- **Recommend**: Number of users that recommended the entity. Users can add a recommendation by clicking on Recommend.
- **Linked articles**: Number of articles linked to this entity Clicking on Linked articles shows the list of linked articles.
- **Watch/Unwatched**: Shows if the user is currently watching the entity (the receives notifications when the entity is changed). Clicking on Watch or Unwatch changes the state of watching.
Resolved/Unresolved: The status of the entity. Some entities, like discussions on a question can have a status attached to them, so that other users know if the question is answered.

Editing and deleting entities

Users can edit and delete their own entities (created by them) by clicking on the "3 dots" icon in the top right corner of the entity.

Blog

Blog is a special page showing an overview of all blog entities available on the wiki. By default, it is listed on the Main navigation. You can also access the page directly at Special:Blog. Users can sort and filter the list entries by clicking on the icons above the list.

Learn how to include the blog on any wiki page.

Page attachments

For every content page on the wiki, BlueSpiceSocial integrates an attachments section. This section shows the files that are related to the particular page. Users can add or remove files to and from this section by clicking on the "..." icon at the bottom of the section. Clicking on this icon links to Special:Attachments /Page_name, which allows managing the files attached to a particular page.
Users can attach files that are already uploaded to the wiki by clicking on the "Plus" button and selecting a file. Or, users can upload new files to be attached by dropping files into the marked area or by clicking the same area to select the files to upload.

This page also shows the history of file attachments for the page.

Page attachments can be disabled in the Page by adding the MagicWord __NOSTASH__ to the page in source editing mode.

### Page discussions

Like page attachments, BlueSpiceSocial integrates a discussion section at the bottom of every wiki page. This section allows users to create comments directly on a wiki page without having to switch to the discussions page. If it is the first entry in a discussion, the discussion page is automatically created at this time.

The discussion section can be disabled in the Page by adding the MagicWord __NODISCUSSION__ to the page in source editing mode.

### Related info

- Blog
- Discussions and Attachments
- Discussion topics
- Social comments
- User Profile
- Reference:BlueSpiceSocial
Attachments

The extension SocialWikiPage allows users to attach a file directly to a wiki page.

**Contents**

1 Attaching a file ................................................................. 350
2 Deleting an attachment .................................................. 351
3 Grouped attachments ....................................................... 352
4 Styling .............................................................................. 352
5 Related info ....................................................................... 353

**Attaching a file**

To create the first attachment at the bottom of a wiki page, open the attachments area by clicking on the "plus" button.

If the attachments area already exists, click the "more"-button to switch to the attachments page.
On the attachments page you can add a new attachment:

1. **Add existing file**: Click the plus button to add a file that has already been uploaded to the wiki.

2. **Upload a new attachment**: Click the upload area or drag the file into the upload field to upload a new attachment to the wiki.

**Deleting an attachment**

To delete an attachment, go to the attachments page and click on the Delete button in the actions menu of the attachment. Deleting an attachment on a page does not delete the file itself from the wiki.
Grouped attachments

Clicking the Edit button in the actions menu of an attachment allows you to group more attachments with it. When you group attachments, they are:

- displayed together on the page
- deleted together from the page
- considered one entity for commenting, recommending, linking, and watching (as social entity)

Styling

By default, the icons for the attachments are shown in grey with a small label and a large icon. By updating the file MediaWiki:Common.css, the styles for the attachments can be adjusted as needed. This requires administrator rights.

Add the following styles:

```css
/* Anhänge */
.bs-social-entity-attachment-wrapper {background: transparent;}
.bs-social-entity-content-attachments .bs-social-entity-attachment-file a span::before { line-height: inherit; font-size: 80px; color: #695f5c;}
.bs-social-entity-content-attachments .bs-social-entityattachment-unknown a span::before { content: "\f016"; color: #695f5c;}
.bs-social-entity-content-attachments .bs-social-entityattachment-pdf a span::before { content: "\f1c1"; color: #e12025;}
.bs-social-entity-content-attachments .bs-social-entityattachment-excel a span::before { content: "\f1c3"; color: #1d8f50;}
.bs-social-entity-content-attachments .bs-social-entityattachment-pptx a span::before { content: "\f1c4"; color: #d04727;}
.bs-social-entity-content-attachments .bs-social-entityattachment-word a span::before { content: "\f1c2"; color: #1565c0;}

.bs-social-entity-attachment-wrapper p { border: 5px solid #766d6b;}
.bs-social-entity-content-attachments div a img, .bs-social-entity-content-attachments div span img { height: 80px; width: 75px; margin-top: 16px; margin-bottom: 18px; border-radius: 5px;}

.bs-social-entity-content-attachments div a p, .bs-social-entity-content-attachments div span p { height: 4em;}
```

You will get:

![Custom css styles for attachments](attachment.png)
The extension BlueSpiceSocialBlog is part of BlueSpiceSocial, the communication module of BlueSpice. In addition to the type blog, there are other types of so-called social entities, such as comment, discussion topic, attachment, or microblog.

### About the blog

Basically, a blog is a list of comments, questions, or feedback from different users. The blog is often sorted chronologically downwards, in the sense of a public journal. A lively communication can arise when the contributions are further commented, recommended, linked with related articles or placed on a personal watchlist.
The blog function is ready for use on the special page Special:Blog. This page is linked directly from the main navigation in every new wiki installation. So you can start using the blog right away.

It is also possible to include the blog functionality on any wiki page. Social contributions of many types can be consolidated and displayed chronologically in a timeline and filtered and sorted as needed.

Adding the blog to a page

If you want to include a view of your blog on another page of your wiki, for example your homepage, you need to insert the necessary codeblock in the source code of your page.

To include a blog view:

1. Go to the page where you want to insert the blog or create a new page.
2. Open the page in Source editing mode.

3. Copy the following code block to the section in your page where you want to show the blog.

```html
<bs:timeline>
  {
    "showentitylistmenu": true,
    "preloadtitles": {
      "blog": "Vorlage:Blog"
    },
    "preloadedentities": [{
      "type": "blog"
    }],
    "headlinemessagekey": "Community-Blog",
    "showheadline": true,
    "usemorescroll": false,
    "morelink": "Special:Blog",
    "limit": 5,
    "sort": [{
      "property": "timestampcreated",
      "direction": "DESC"
    }],
    "lockedfilternames": [
      "type"
    ],
    "filter": [{
      "type": "list",
      "property": "type",
```

```html
```
After saving the page, you will see a list of existing blog entries based on the filter and sorting criteria you provided.

Blog parameters

Output format

The following table shows the blog elements and the necessary parameters to create the output:

<table>
<thead>
<tr>
<th>Element</th>
<th>Parameters</th>
<th>Parameter and element description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 -</td>
<td>headlinemessagekey</td>
<td>Header text</td>
</tr>
<tr>
<td>header</td>
<td>showheadline</td>
<td>Show the header text</td>
</tr>
<tr>
<td></td>
<td>showentitylistmenu</td>
<td>Show or hide the blog menu</td>
</tr>
<tr>
<td></td>
<td>showentityspawner</td>
<td>Show the menu item for creating a blog entry</td>
</tr>
<tr>
<td>Element</td>
<td>Parameters</td>
<td>Parameter and element description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>availablesorterfields</td>
<td>Determines which data fields are included as sorting options in the sort menu. Example: allow sorting only by date created or by the user who created a blog entry:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;availablesorterfields&quot;: [&quot;timestampcreated&quot;,&quot;ownerid&quot;]</td>
<td></td>
</tr>
<tr>
<td>lockedoptionnames</td>
<td>Determines which settings for sorting the user cannot change.</td>
<td></td>
</tr>
<tr>
<td>availablefilterfields</td>
<td>Determines which data fields are included as filter options in the filter menu. Example: allow filtering based on Creation date and Linked pages:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;availablefilterfields&quot;: [&quot;timestampcreated&quot;,&quot;tags&quot;]</td>
<td></td>
</tr>
<tr>
<td>lockedfilternames</td>
<td>Determines which settings for filtering the user cannot change. Example: a user cannot change the filter values for Linked pages. The text field is greyed out:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;lockedfilternames&quot;: [&quot;tags&quot;]</td>
<td></td>
</tr>
<tr>
<td>persistsettings</td>
<td>Initial settings and custom sort and filter settings are included in the page URL. The user can create a link to the page with the same filter and sort settings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;persistsettings&quot;: true</td>
<td></td>
</tr>
</tbody>
</table>
### Parameters and element description

<table>
<thead>
<tr>
<th>Element</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 - new blog entry</td>
<td>preloadentities</td>
<td>Shows the text field for creating a new blog entry. If it is not set, the text field is not available. To show the text field:</td>
</tr>
</tbody>
</table>

> "preloadedentities": [{"type":"blog"}]

| 4 - existing blog entry  | outputtypes | It defines the display format of the blog entry. Standard types are: List, Short, Default, Page. (see examples) |

Each blog entry is a "social entity".

| limit | Defines how many social entities are loaded initially. |

| 4a - avatar | - | Shows the avatar of the user who created the blog entry or comment. It is only displayed in all output types except List. |

| 4b - title bar | - | In the output type List, the username is not displayed in the title bar. |

| 4c - blog entry content | - | Shows the text body of a blog entry. The output type Default collapses the blog entry content after the first paragraph with a "More" link. |

| 4d - social tags | - | Blog entries always include the social tags Comments, Recommend, Linked Page, Watch/Unwatch. |

| 4e - user menu | - | Users can edit or delete their own blog entries or comments at any time. The edit menu is visible for their own entries: |

| 5 - new comment | - | Text field for creating a new comment. |

| 6 - existing | | Comments include the social tag Recommend. |
Element | Parameters | Parameter and element description
---|---|---
comment | - | Each comment is a "social entity".
morelink | | Link target of the "more" button. For blogs, it makes sense to link to the page Special:Blog.
useendlessscroll | | More blog entries are automatically loaded after the user scrolls to the end.
showentitylistmore | | Shows a "more" button below the blog which loads more blog entries on click. $useendlessscroll$ is set to false.

**Sorting**

Most commonly, a blog shows the latest blog entries first. However, there are many different options for sorting the list of blog entries.

**Syntax**

```json
[
    "property": "timestamptouched",
    "direction": "DESC"
]
```

**Properties**

There are some common properties of a blog entry that are useful for sorting:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>timestampcreated</td>
<td>creation date</td>
</tr>
<tr>
<td>timestamptouched</td>
<td>last edit date</td>
</tr>
<tr>
<td>commentcount</td>
<td>number of comments</td>
</tr>
<tr>
<td>ratingcount</td>
<td>number of ratings</td>
</tr>
<tr>
<td>ownerid</td>
<td>username of the creator of a blog entry</td>
</tr>
<tr>
<td>ownerrealname</td>
<td>real name of the user</td>
</tr>
</tbody>
</table>

**Direction**

Blog entries can be sorted in descending and ascending order. Descending is the default order.
### Filtering

Without setting the filter parameter, there will be no output on the page.

To show the blog entries of your wiki, include the following codeblock like shown in the code example above:

```json
"filter": [ {
  "type": "list",
  "property": "type",
  "value": [ "blog" ],
  "comparison": "ct"
}]
```

This filter includes all social entities which match the type `blog`. Since we only want to show social entities of type `blog`, we only include `blog` entries in our filter. If you want to create a social timeline rather than a blog view, you can also add other types of social entities. The following example shows a timeline view that includes blog entries, discussion entries from wiki pages, and user profile information:

```json
"filter": [ {
  "type": "list",
  "property": "type",
  "value": [ "blog", "topic", "profile" ],
  "comparison": "ct"
}]
```

### Output type examples

The output type for a blog is added using the `outputtypes` parameter. Don't forget to include a comma before and after this parameter (unless this is the last parameter in your code):

```json
"outputtypes": { "blog": "Default" }
```

### Default

The output type `Default` shows the content of a blog entry truncated after the first paragraph. To view the full text, users can click on the `More` link.
Short

The output type *Short* does not show the content of the blog entry. To view the content, a user has to click on the title of a blog entry. This loads the actual page for the selected blog entity.

Page

The output type *Page* shows all blog elements, including the comments, in an expanded view.
List

The output type *List* only shows the title and the timestamp.

- Suggestion for improving search results **Created one hour and 56 minutes ago Testuser**
- Greg Rundlett über BlueSpice **Created 2 months ago**

Configuration

In the **Config manager**, you can change the following settings:

- **Use teaser text for blog entries in the timeline**: When you create a blog entry, you can create a teaser text for it by clicking the cogwheel symbol in the blog entry form. If this setting is active, the teaser text will be shown on the page **Special:Timeline** instead of the first part of the content.
Related info

- **Micro-Blog**
- **Discussions and Attachments**
- **Discussion topics**
- **Social comments**
- **User Profile**

**Linked pages**

- **Reference:BlueSpiceSocial**

**Link pages to discussions**

A **SocialEntity**, such as a discussion topic, is automatically linked to the wiki page (article) on which it was created. Users can update these linked pages as needed.
Linked pages

You can link a discussion topic to wiki pages at any time. To do this, simply enter the desired page names in the input field for linked pages and click Post.

![Linking a SocialEntity with a page.](image)

Embedding discussions in linked pages

If you have manually linked discussion topics or other SocialEntities to a specific wiki page, you can display them directly on the linked page.

To do this, set the desired filter on the page Special:Timeline.

![Filtering based on linked pages](image)

(1) **Type**: enter all types of social entities that you want to include in your filter.

(2) **Linked pages**: enter the name of the linked wiki page.
Note:
If you are not sure which social entities you want to filter by, you can first select all types and then gradually delete them from the type field until you see the desired filter result. To do this, click the Add all switch-button.

You can then see the filter settings in the page URL of the browser.

Filter settings in the browser URL

You include this filter in the timeline tag. You can then integrate the timeline tag on the linked page (in our example, the page Knowledge Base).

Including the timeline tag on a page
A detailed description of how to integrate the timeline tag can be found on the help page Working with blogs.

The discussions now appear on the linked page, even though they were not created there.

Related info

- Micro-Blog
- Discussions and Attachments
- Discussion topics
- Social comments
- User Profile
- Reference:BlueSpiceSocial
Microblog

Microblogs work exactly like regular blogs. Unlike blogs, however, they do not have a separate title field. Users simply provide a quick message in a single text field.

Microblog syntax

To include a microblog on a page, copy the following tag. An explanation of the individual parameters is available on the help page for blogs:

```{}
{{#tag:bs:timeline|
  "showentitylistmenu": false,
  "preloadedentities": [{
    "type": "microblog"
  }],
  "headlinemessagekey": "Letzte Kurznachrichten",
  "showheadline": false,
  "limit": 3,
  "sort": [{
    "property": "timestampcreated",
    "direction": "DESC"
  }],
  "lockedfilternames": [
    "type"
  ],
  "outputtypes": {
    "microblog": "Default"
  },
  "filter": [{
    "type": "list",
    "property": "type",
    "value": [ "microblog" ],
    "comparison": "ct"
  }, {
    "type": "boolean",
    "property": "archived",
    "value": false,
    "comparison": "eq"
  }]
}}
```

This produces a microblog that looks like this:
Related info

- Blog
- Discussions and Attachments
- Discussion topics
- Social comments
- User Profile
- Reference: BlueSpiceSocial
Ratings and recommendations

The extension BlueSpiceRating allows users to rate a page with up to five stars or to recommend the page.

### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rating or recommending a page</td>
<td>368</td>
</tr>
<tr>
<td>Special pages</td>
<td>368</td>
</tr>
<tr>
<td>Disabling rating on a page</td>
<td>369</td>
</tr>
<tr>
<td>Disabling rating in a namespace</td>
<td>369</td>
</tr>
<tr>
<td>Related info</td>
<td>369</td>
</tr>
</tbody>
</table>

## Rating or recommending a page

A user simply selects the amount of stars for a rating. The number of stars are then highlighted in yellow during the selection process. A mouse-click confirms the rating.

Only one rating per user is counted. New votes only change the average evaluation, but not the number of ratings.

Users can change their rating at any time by choosing less or more stars. The average evaluation, as well as the number of ratings is shown next to the page title:

To recommend a page, a user clicks on the link "Recommend". To retract the recommendation, the user clicks on the link again.

## Special pages

The special page Special:Rating lists all pages that have been rated.

The special page Special:Recommendations lists all pages that have been recommended.
Disabling rating on a page

You can also exclude pages from the rating system. You can do this with a so-called “Behaviour Switch”. Insert the switch at the bottom of the page in source view: __NORATING__

Disabling rating in a namespace

Administrators can turn on the rating feature for individual namespaces. To enable or disable ratings, go to Global actions > Namespace manager and edit the namespaces:

![Namespace manager](image)

Related info

- Reference:BlueSpiceRating

Track page actions
Each time a page is created or edited in the wiki, this action is automatically documented as a separate page in the *SocialEntity* namespace. Its purpose is to track all actions on a wiki page and communicate it in various change lists for users to comment on the changes.

### Characteristics of SocialEntity pages

(1) **Numeric page names**: The page names in this namespace are generated as numbers.

(2) **Watchlist**: These pages are automatically placed on the watchlist of the editor. By default, a notification is sent when a comment is created on this page or when another change is made on this SocialEntity page. These notifications can be turned off in the Preferences on the Notifications tab *(Comments on watched entities).*
(3) **Comments**: Other users have the option to comment on the original action. For example, if a user edited a page, another user could comment that the page now looks much better. Adding a comment to the SocialEntity page is sometimes better than adding a discussion topic directly on the edited page to avoid cluttering up the wiki page with casual social comments.

(4) **Page link**: The SocialEntity page has a link that leads to its associated content page.

### Special pages that list actions on wiki pages

#### User profile

The user profile pages lists the actions of the current user.

#### Contributions

The page `Special:Contributions/<username>` shows the SocialEntity pages for actions of the user `<username>`.

The SocialEntity entries start with parentheses describing the type of change, e.g. *(Article edit)*. Hovering over the link shows the numeric page name in the namespace `SocialEntity`.

<table>
<thead>
<tr>
<th>Time</th>
<th>Author</th>
<th>Action Type</th>
<th>Page Title</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>14:21, 26 April 2020</td>
<td>Testuser</td>
<td>Article edit</td>
<td>Testing BlueSpice Features</td>
<td>(current)</td>
</tr>
<tr>
<td>14:14, 26 April 2020</td>
<td>Testuser</td>
<td>Article edit</td>
<td>Sandbox</td>
<td>(current)</td>
</tr>
<tr>
<td>14:14, 26 April 2020</td>
<td>Testuser</td>
<td>Article edit</td>
<td>Sandbox</td>
<td>rollback1</td>
</tr>
</tbody>
</table>

**SocialEntities on the Contributions page**

- **These pages can be filtered out by setting the filter to:**
  - Namespace:SocialEntity
  - Invert selection

After clicking **Search**, the page returns the contributions of the user without social entities.
Recent changes

The page Special:RecentChanges (classic view) by default filters out SocialEntity pages. The filter can be deactivated on the page.

Special page "Activities"

The page Special:Activities shows a list of all page actions in the wiki. The filter can be adjusted as needed. Using the timeline tag, the (custom) filtered list can be embedded in any wiki page.

Related info

- Blog
- Discussions and Attachments
- Discussion topics
- Social comments
- User Profile
User profile

BlueSpiceSocialProfile provides the SocialEntity of type profile. Furthermore, the user page is converted into a complete user profile.

User profile info

The first part of the profile page contains elements related to the user's profile info.

(1) **Watchlist**: The profile page is by default on the user's watchlist to send notifications about any changes to the page.

(2) **Actions menu**: In the edit menu, users can edit their profile description (5) below their profile picture, update their user image and enter their profile data (3).

(3) **Profile data**: Users can enter their profile details, such as department and phone number.

(4) **User image**: The user image can be uploaded from the actions menu. For users without a user image, an avatar image is displayed instead.

(5) **Description**: The edit link in the Actions menu allows to edit the page content itself. This content is displayed directly below the profile box.
Social timeline

Below the user profile information, a timeline of the user contributions is shown in the form of social entities. A filter allows all users to change what types of actions are displayed in the list.

Related info

- Blog
- Discussions and Attachments
- Discussion topics
- Microblog
- Social comments
- Reference:BlueSpiceSocial